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© Barco, Inc.  August 3, 2006

All rights reserved.  No part of this document may be copied, reproduced or translated. It 
shall not otherwise be recorded, transmitted or stored in a retrieval system without the prior 
written consent of Barco.

kçíáÅÉ
Barco provides this manual “as is” without warranty of any kind, either expressed or 
implied, including but not limited to the implied warranties or merchantability and fitness for 
a particular purpose. Barco may make improvements and/or changes to the product(s) and/
or the program(s) described in this publication at any time without notice.

This publication could contain technical inaccuracies or typographical errors. Changes are 
periodically made to the information in this publication; these changes are incorporated in 
new editions of this publication.

cÉÇÉê~ä=`çããìåáÅ~íáçåë=`çããáëëáçå=Ec``F=pí~íÉãÉåí
This equipment has been tested and found to comply with the limits for a class A digital 
device, pursuant to Part 15 of the FCC rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction manual, may cause 
harmful interference to radio communications. Operation of this equipment in a residential 
area may cause harmful interference, in which case the user will be responsible for 
correcting any interference.

dì~ê~åíÉÉ=~åÇ=`çãéÉåë~íáçå
Barco provides a guarantee relating to perfect manufacturing as part of the legally 
stipulated terms of guarantee. On receipt, the purchaser must immediately inspect all 
delivered goods for damage incurred during transport, as well as for material and 
manufacturing faults Barco must be informed immediately in writing of any complaints.

The period of guarantee begins on the date of transfer of risks, in the case of special 
systems and software on the date of commissioning, at latest 30 days after the transfer of 
risks. In the event of justified notice of compliant, Barco can repair the fault or provide a 
replacement at its own discretion within an appropriate period. If this measure proves to be 
impossible or unsuccessful, the purchaser can demand a reduction in the purchase price or 
cancellation of the contract. All other claims, in particular those relating to compensation for 
direct or indirect damage, and also damage attributed to the operation of software as well 
as to other services provided by Barco, being a component of the system or independent 
service, will be deemed invalid provided the damage is not proven to be attributed to the 
absence of properties guaranteed in writing or due to the intent or gross negligence or part 
of Barco.

If the purchaser or a third party carries out modifications or repairs on goods delivered by 
Barco, or if the goods are handled incorrectly, in particular if the systems are commissioned 
operated incorrectly or if, after the transfer of risks, the goods are subject to influences not
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agreed upon in the contract, all guarantee claims of the purchaser will be rendered invalid. 
Not included in the guarantee coverage are system failures which are attributed to 
programs or special electronic circuitry provided by the purchaser, e.g. interfaces. Normal 
wear as well as normal maintenance are not subject to the guarantee provided by Barco 
either.

The environmental conditions as well as the servicing and maintenance regulations 
specified in this manual must be complied with by the customer.

qê~ÇÉã~êâë
Brand and product names mentioned in this manual may be trademarks, registered 
trademarks or copyrights of their respective holders.  All brand and product names 
mentioned in this manual serve as comments or examples and are not to be understood as 
advertising for the products or their manufactures.

`çãé~åó=^ÇÇêÉëë
Barco Media and Entertainment
11101 Trade Center Drive
Rancho Cordova, California  95670
USA

• Phone: (916) 859-2500 
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Barco N.V. 
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léÉê~íçêë=p~ÑÉíó=pìãã~êó
The general safety information in this summary is for operating personnel.

aç=kçí=oÉãçîÉ=`çîÉêë=çê=m~åÉäë
There are no user-serviceable parts within the unit.  Removal of the top cover will expose 
dangerous voltages. To avoid personal injury, do not remove the top cover.  Do not operate 
the unit without the cover installed.  

mçïÉê=pçìêÅÉ
This product is intended to operate from a power source that will not apply more than 230 
volts rms between the supply conductors or between both supply conductor and ground.  A 
protective ground connection by way of grounding conductor in the power cord is essential 
for safe operation.

dêçìåÇáåÖ=íÜÉ=mêçÇìÅí
This product is grounded through the grounding conductor of the power cord.  To avoid 
electrical shock, plug the power cord into a properly wired receptacle before connecting to 
the product input or output terminals.  A protective-ground connection by way of the 
grounding conductor in the power cord is essential for safe operation.

rëÉ=íÜÉ=mêçéÉê=mçïÉê=`çêÇ
Use only the power cord and connector specified for your product. Use only a power cord 
that is in good condition.  Refer cord and connector changes to qualified service personnel.

rëÉ=íÜÉ=mêçéÉê=cìëÉ
To avoid fire hazard, use only the fuse having identical type, voltage rating, and current 
rating characteristics.  Refer fuse replacement to qualified service personnel.  

aç=kçí=léÉê~íÉ=áå=bñéäçëáîÉ=^íãçëéÜÉêÉë
To avoid explosion, do not operate this product in an explosive atmosphere.
4 ScreenPRO-II Controller  •  User’s Guide



qÉêãë=få=qÜáë=j~åì~ä=~åÇ=bèìáéãÉåí=j~êâáåÖ=

t^okfkd
Highlights an operating procedure, practice, condition, statement, etc., which, if not strictly 
observed, could result in injury to or death of personnel.

`^rqflk
The exclamation point within an equilateral triangle is intended to alert the user to the 
presence of important operating and maintenance (servicing) instructions in the literature 
accompanying the appliance.

^sboqfppbjbkq>
Le point d´exclamation dans un triangle equilatéral signale à alerter l´utilisateur qu´il y a 
des instructions d´operation et d´entretien tres importantes dans la litérature qui 
accompagne l´appareil.

slopf`eq
Ein Ausrufungszeichen innerhalb eines gleichwinkeligen Dreiecks dient dazu, den 
Benutzer auf wichtige Bedienungs-und Wartungsanweisungen in der Dem Great 
beiliegenden Literatur aufmerksam zu machen.

Note Highlights an essential operating procedure, condition or 
statement.
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`Ü~åÖÉ=eáëíçêó
The table below lists the changes to the ScreenPRO-II Controller User’s Guide. 

Table 0-1. Change History

Rev Date ECO # Description Approved By

A 8/3/06 1666 ScreenPRO-II Controller User’s Guide R. Pellicano
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NK==fåíêçÇìÅíáçå

This chapter is designed to introduce you to the ScreenPRO-II Controller User’s Guide.  
Areas to be covered are: 

• Chapter Structure

• How to Use This Guide

• Conventions

• Terms and Definitions

• System Overview

• Application Questions

Note Once you have reviewed all of the sections in this chapter, 
please continue with Chapter 2, “Hardware Orientation” on 
page 31.
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NK==fåíêçÇìÅíáçå
Chapter Structure
`Ü~éíÉê=píêìÅíìêÉ
The following chapters provide instructions for all aspects of ScreenPRO-II Controller 
operations: 

• Chapter 1, “Introduction” provides a system overview, a list of features, and 
discusses easy ways to use this guide.

• Chapter 2, “Hardware Orientation” on page 31 explains the ScreenPRO-II 
Controller’s front and rear panels in detail. 

• Chapter 3, “Hardware Installation” on page 53 provides comprehensive system 
installation instructions.    

• Chapter 4, “Menu Orientation” on page 85 explains the system’s configuration, 
setup and adjustment menus, and provides basic menu “navigation” procedures. 

• Chapter 5, “System Setup” on page 183 outlines procedures for setting up and 
configuring the ScreenPRO-II Controller.

• Chapter 6, “Operations” on page 215 provides system operating instructions. 

• Appendix A, “Specifications” on page 255 lists the ScreenPRO-II Controller’s 
input, output, video, mechanical and power specifications, and includes connector 
pinouts. 

• Appendix B, “Contact Information” on page 267 lists important RMA, warranty, 
contact and technical support details.  

• Appendix C, “Upgrading Software” on page 269 provides a detailed procedure 
for upgrading ScreenPRO-II Controller software.  
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How to Use This Guide
eçï=íç=rëÉ=qÜáë=dìáÇÉ
Following are important tips for streamlining your use of this User’s Guide in its electronic 
“PDF” form.

k~îáÖ~íáåÖ
Use Acrobat Reader’s “bookmarks” to navigate to the desired location.  All chapter files 
have the same bookmark structure for instant navigation to any section.   Please note:

• Extensive hyperlinks are provided within the chapters.

• Use Acrobat’s “Go to Previous View” and “Return to Next View” buttons to trace 
your complete navigational path.  

• Use the “Previous Page” and “Next Page” buttons to go to the previous or next 
page within a file. 

• Use Acrobat’s extensive search capabilities, such as the “Find” tool and “Search 
Index” tool to perform comprehensive searches as required.  

q~ÄäÉ=çÑ=`çåíÉåíë=~åÇ=fåÇÉñ
Use the Table of Contents bookmarks to navigate a desired topic.  Click any item to 
instantly jump to that section of the guide.  You can also use the Index to jump to specific 
topics within a chapter.  Each page number in the Index is a hyperlink.

dÉåÉê~ä=léÉê~íáçåë
To ensure trouble-free operation, please follow all procedures as listed below:  

• For detailed installation instructions, refer to Chapter 3, “Hardware Installation” 
on page 53.

• For system setup instructions, refer to Chapter 5, “System Setup” on page 183.

• For operating instructions, refer to Chapter 6, “Operations” on page 215.

Should you have any questions regarding the installation or operation of the MatrixPRO 
ScreenPRO-II Controller, please consult with the factory.  Refer to Appendix C, 
“Upgrading Software” on page 269 for contact information.  
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`çåîÉåíáçåë=
The following conventions are used throughout this guide: 

• The symbol  denotes an operations procedure. 

• The symbol  denotes an example.

• Entries written in bold-face letters denote physical buttons or rear chassis 
connectors.  

Press Split to ... 

• When two buttons together are required for an operation or function, the plus (+) 
sign is used between the buttons.  This procedure requires that you hold down the 
first button, then press the second.   

Example:  Press Learn + 2 to store the ScreenPRO-II Controller 
setup in preset register 2. 

• Button labels on the Touch Screen menus are shown in bold uppercase letters 
between braces.

Press {BORDER} to …

• When a sequence of menu selections is required to complete a given procedure, 
the ">" symbol is used to divide each successive menu picks.  

To access the Genlock Menu, press {HOME} > {OUTPUT} > 
{GLCK}.
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qÉêãë=~åÇ=aÉÑáåáíáçåë
The following terms and definitions are used throughout this guide: 

• A “Background” is an unscaled source, typically originating from a computer.  A 
background source appears at the system’s lowest priority — visually in back of all 
other sources. 

• The abbreviation “BG” is also used throughout this guide for Background.

• The term “Controller” is synonymous with ScreenPRO-II Controller.

• A “Key” is an electronic (and visual) process whereby one image is electronically 
superimposed over another source or background.  Keys are typically used for 
titles, logos and banners.

• A “Layer” is an image display element (such as a PIP, Key or Background) that 
has an associated visual priority — either in front (or in back) of another layer.  

• A “LOGO” is a full screen image that is selected from one of three still frames that 
you can capture with each individual ScreenPRO-II unit.  A maximum of 12 still 
frames can therefore be controlled from the ScreenPRO-II Controller.    

• A “Mixer” is the electronic circuitry that enables you to transition (and scale) PIPs 
and Keys over a background. 

• “M/E” (Mix/Effects) is synonymous with “mixer.”  Each individual ScreenPRO-II 
has one internal M/E that can layer either two PIPs, two keys, or one of each.

• “Operator” refers to the person who uses the system. 

• “PIP” refers to Picture-in-Picture, an on-screen setup in which one picture 
(typically of reduced size) is positioned over another background image — or 
another PIP.  PIPs can be reduced, enlarged, bordered, shadowed, and mixed on 
and off Program.  PIPs can overlap each other, depending on their visual priority.  

• “Screen” and “Menu” both refer to the Touch Screen menus.

• “System” refers to the ScreenPRO-II Controller and its associated individual 
ScreenPRO-II units. 

• A “Scaler” is the electronic circuitry that enables you to reduce or enlarge source 
images, thus creating PIPs and Keys that can be positioned (and transitioned).
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System Overview
póëíÉã=lîÉêîáÉï
The following topics are discussed in this section:

• ScreenPRO-II Controller

• A Word About Layers

• System Combinations

• Effect Combinations

pÅêÉÉåmolJff=`çåíêçääÉê 
The ScreenPRO-II Controller is a versatile interface that enables users to control up to four 
individual ScreenPRO-II units and peripheral equipment (such as BlendPRO-II, MatrixPRO 
routers and ImagePRO).  The ScreenPRO-II Controller offers the complete functionality of 
the ScreenPRO-II front panel, plus many features that are not available on the local panel.

Features include:

• Enhanced hardware and software features:

~ Control of multiple ScreenPRO-II units as “destinations,” including both 
single and widescreen configurations.  Refer to the “System 
Combinations” section on page 22 for sample configurations.

~ Support for widescreen applications using two or more ScreenPRO-II 
units in conjunction with BlendPRO-II. 

~ In “internal” routing mode, support for 16 analog inputs and 2 HD-SDI/
SD-SDI inputs.  In “external” routing mode, support for 16 inputs, in any 
combination of analog and digital.

~ Optional Tally board provides eight programmable tallies, which can be 
assigned to any input source.  The board also provides a PS-2 
connector, and when a customer-supplied keyboard is connected, users 
can enter system values and names. 

~ 3.8” LCD Touch Screen with eight soft menu buttons and two rotary 
encoders for menu navigation.

~ 3-Axis Joystick for quick sizing and positioning of PIPs and Keys.

~ Color-coded buttons and layouts match color scheme of Encore and 
ScreenPRO-II product family.

~ Dimmable, flexible light stick (script light) with XLR connector. 

~ Internal convection-cooled power supply (no fan needed).

~ The programmable Controller Lockout feature allows operators to lock 
the Controller, thus disabling all button presses.  The lockout code is 
user-programmable.  

~ The Controller’s Flash Memory Card Slot enables users to backup and 
restore system configuration parameters.  The Flash Memory card itself 
is customer supplied. 

~ The “Join” feature allows both layers to be locked together, 
proportionally.  Manipulations to one layer are automatically performed 
on the other layer, including size, position, moves, PIPs and Keys.
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• Router control:

~ Support for internal routers (within individual ScreenPRO-II units).

~ Support for external analog and digital routers, such as MatrixPRO and 
other third-party router manufacturers.

• Enhanced transition capability:

~ Automatic transitions via dedicated AUTO TRANS button.

~ Manual transitions via T-Bar.

• Preset control:

~ Control of up to 36 user presets in a dedicated “Preset” section (six 
pages of six preset each).

~ NEXT and PREV (Previous) buttons for convenient preset recall.

^=tçêÇ=^Äçìí=i~óÉêë
Just like the individual ScreenPRO-II units, the ScreenPRO-II Controller is a five layer 
system, as illustrated below:

Figure 1-1.  ScreenPRO-II Controller Layers 

A layer is defined as an image display element (such as a background, PIP, or Key) with an 
associated visual priority.  The ScreenPRO-II mixer itself has two layers, A and B.  For 
complete flexibility, each layer can be assigned to either PIP or Key functionality. 

Background

Mixer Layer A

Mixer Layer B

DSK

LOGO

Note Regardless of the number of individual ScreenPRO-II 
destinations under control, you are still working with individual 
five layer systems — whether or not the destinations are 
individual screens or blended widescreens. 
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A typical ScreenPRO-II Controller application is illustrated below.

Figure 1-2.  Layer Illustration — Background, Mixer and DSK

Please note the following important points:

• The full screen LOGO is the highest priority layer.  The LOGO visually appears 
“over” all other images, including backgrounds, PIPs, keys and the DSK.

• The Downstream Key (DSK) is the second highest priority layer.  It visually 
appears over all PIPs, keys and backgrounds — but it is “under” the LOGO.  

• The high resolution Background layer has the lowest priority.  This layer visually 
appears “behind” all other PIPs, keys, and the DSK.  The controller can transition 
between two background sources — both of which must be provided at native 
projector resolution.  

• A PIP layer appears “over” backgrounds and “under” the DSK and LOGO.  Effects 
include mixes, wipes, linear moves, resizing, adjustable aspect ratio, borders, 
drop shadows and soft edges. 

• A Key layer also appears “over” backgrounds and “under” the DSK and LOGO.  
Key effects include luminance keys, split keys (key alpha and fill), reverse key 
(key on background), and color key (graphics).  

• Within the mixer, layer B has priority over layer A, but you can change that priority 
with the Swap Z-Order button.  

• Up to eight analog inputs and up to two SD/HD SDI inputs can be scaled to 
produce PIPs or Keys.

póëíÉã=`çãÄáå~íáçåë
The ScreenPRO-II Controller can be configured in a variety of different ways, using both 
single screen and widescreen destinations.  You can use up to four ScreenPRO-II units and 
up to four Aux destinations.  The only limitation is one widescreen destination per 
ScreenPRO-II Controller, comprised of up to four ScreenPRO-II units and a BlendPRO-II.  

Several sample configurations are listed below, in simplified block diagram format:  

• Dual Destination System

• Quadruple Destination System

• Dual Destination plus Widescreen Destination System

• Dual Destination, Dual Aux System

Wilderness

Background

PIP

Key

DSK

Nature
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The figure below illustrates a dual-destination system comprised of the ScreenPRO-II 
Controller, two individual ScreenPRO-II units and two single-screen projectors 
(destinations).  Within this system, Ethernet is used for communications between 
components, and all ScreenPRO-II inputs are received via routers or direct connections.

Figure 1-3.  ScreenPRO-II Controller system with two destinations 

Ethernet 

ScreenPRO-IIScreenPRO-II Controller

Inputs 
(from routers and direct sources)

Destination
#1

Destination
#2

Hub / Switch
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The figure below illustrates a quadruple-destination system comprised of the ScreenPRO-II 
Controller, four individual ScreenPRO-II units and four single-screen projectors. 

Figure 1-4.  ScreenPRO-II Controller system with four destinations 

Ethernet 

ScreenPRO-IIScreenPRO-II Controller

Inputs 
(from routers and direct sources)

Destination
#1

Destination
#2

Destination
#3

Destination
#4

Hub / Switch
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The figure below illustrates a system that includes two single screen destinations and one 
widescreen destination.  Note the use of BlendPRO-II on the outputs of the two 
ScreenPRO-II units designated as “widescreen.” 

Figure 1-5.  ScreenPRO-II Controller system with one widescreen destination 

The BlendPRO-II accepts up to four inputs, thus, widescreen systems can be configured 
with dual (as shown above), triple or quadruple screen blends.  

Ethernet 

ScreenPRO-IIScreenPRO-II Controller

Inputs 
(from routers and direct sources)

Destination
#3

Destination
#1

Widescreen

BlendPRO-II

Single Screen Single Screen

Destination
#2

Hub / Switch

Important For all Widescreen configurations using BlendPRO-II, ensure 
that you review the “BlendPRO-II Widescreen Lock 
Connections” section on page 77 in Chapter 3.
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The figure below illustrates a system that includes two individual ScreenPRO-II units, two 
single-screen projectors and two “Aux” destinations:

• The “standard” Aux destination is a single monitor that takes its input from one 
router output (in a single format).

• The “PresentationPRO” Aux destination takes its input(s) from multiple routers 
and sources, in multiple formats.  When connected to a single monitor or 
projector, a scaled signal is provided in one format.

Figure 1-6.  ScreenPRO-II Controller system with two Aux destinations 

Ethernet 

ScreenPRO-IIScreenPRO-II Controller

Inputs 
(from routers and direct sources)

Destination
#1

Destination
#2

Input sources
(single format)

PresentationPRO-II

MatrixPRO SDI Router

Input sources
(multiple formats)

Aux
Destination #1

Aux
Destination #2

(Scaled)

Hub / Switch
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bÑÑÉÅí=`çãÄáå~íáçåë
This section illustrates the many (but not all) combinations of image effects that you can 
create using the ScreenPRO-II Controller.  Please note:

• In the following illustrations, the specific layers used in creating each effect are 
labeled (e.g., PIP A, PIP B).  

• The symbol ↔ denotes a PIP or a key that can transition.  For example, PIP A ↔ 
B indicates that you can dissolve between sources within the PIP.

Similar to individual ScreenPRO-II units, the ScreenPRO-II Controller enables you to 
control two backgrounds, two scalable layers in the mixer plus an unscaled DSK and a full 
screen, unscaled LOGO.  The LOGO, DSK and backgrounds are always unscaled.    

jáñÉê=bÑÑÉÅí=N
This effect includes a non-transitioning background (either A or B), one transitioning PIP 
and the DSK.

Figure 1-7.  Effect 1 Diagram

jáñÉê=bÑÑÉÅí=O
This transition is similar to effect 1, but because the DSK is not in use, the background can 
transition from source A to B, and the PIP can transition between layers A and B.

Figure 1-8.  Effect 2 Diagram

Important If the DSK is in use, the background cannot transition 
between A and B.  This occurs because BG/DSK Input B is 
shared between the DSK and BG B. 

Background

PIP
A ↔ B

DSK

Background A ↔ B

PIP
A ↔ B
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jáñÉê=bÑÑÉÅí=P
In this effect, because the DSK is in use, the background cannot transition — you can only 
use background A.  Here, you can independently fade (or cut) one scaled PIP and one 
scaled key, with complete size and position flexibility.  

Figure 1-9.  Effect 3 Diagram

jáñÉê=bÑÑÉÅí=Q
This transition is similar to effect 3, but because the DSK is not in use, the background can 
transition between sources A and B.  You can also independently fade, cut, size and 
position both the PIP and the key.

Figure 1-10.  Effect 4 Diagram

jáñÉê=bÑÑÉÅí=R
In this effect, because the DSK is in use, the background cannot transition — you can only 
use background A.  Here, you can independently fade two scaled PIPs up and down — 
with or without the DSK on screen.  

Figure 1-11.  Effect 5 Diagram

Background A

PIP
A

DSK
Key B

Background A ↔ B

PIP
A Key B

Background A

PIP
A

PIP
B

DSK
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This transition is similar to effect 5, but because the DSK is not in use, the background can 
transition.  You can also independently fade the two PIPs.

Figure 1-12.  Effect 6 Diagram

Background A ↔ B

PIP
A

PIP
B
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^ééäáÅ~íáçå=nìÉëíáçåë
At Barco, we take pride in offering unique solutions to demanding technical problems.  If 
you have application questions, require further information or would like to discuss your 
application requirements in more detail, please call (916) 859-2500.  Our Customer 
Support Engineers will be happy to provide you with the support you need.  Refer to 
Appendix B, “Contact Information” on page 267 for contact details.
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få=qÜáë=`Ü~éíÉê
This chapter provides detailed information about the ScreenPRO-II Controller’s hardware.  
The following topics are discussed:

• ScreenPRO-II Controller Rear Panel

• ScreenPRO-II Controller Front Panel

• Use of Color

• Front Panel Sections

Note For complete details on BlendPRO-II’s hardware, refer to the 
“BlendPRO-II User’s Guide.”

Note Once you have reviewed all of the sections in this chapter, 
please continue with Chapter 3, “Hardware Installation” on 
page 53.
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ScreenPRO-II Controller Rear Panel
pÅêÉÉåmolJff=`çåíêçääÉê=oÉ~ê=m~åÉä
The figure below illustrates the ScreenPRO-II Controller rear panel:

Figure 2-1.  ScreenPRO-II Controller Rear Panel 

Following are descriptions of each rear panel connector and section.  

1) Keyboard Port

On the optional Tally board, one standard PS-2 connector is provided for the 
Keyboard Port.  When a customer-supplied keyboard is connected, users can 
enter system values and names.  

2) Tally Connector

On the optional Tally board, one 25-pin D connector is provided for issuing tally 
“relay closure” commands to external devices such as cameras.  Eight tally 
circuits are provided.  In Appendix A, refer to the “Tally Connector” section on 
page 262 for pinout details.

3) Memory Card Slot

One Memory Card Slot is provided for a customer supplied Flash Memory Card, 
which enables users to externally store and recall system configurations — one 
configuration per card.  The minimum size card that the system accepts is 512 
MB.  The card also enables users to transfer configurations between Controllers 
as required.  In Chapter 6, refer to the “Using Backup and Restore” section on 
page 253 for instructions. 

EXT COMM

ETHERNETCONSOLE

TALLY

MEMORY CARD

CAUTION:  FOR CONTINUED PROTECTION
AGAINST RISK OF FIRE, REPLACE ONLY
WITH SAME TYPE AND RATING OF FUSE

T250V 2A FUSE

KEYBOARD

4

51 6 8

3

2 77

1) Keyboard Port 4) Ext Comm Port 7) Adjustable Feet

2) Tally Connector 5) Console Port 8) AC Connector and Fuse

3) Memory Card Slot 6) Ethernet Port
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4) Ext Comm Port

One 9-pin D Ext Comm connector is provided for RS-232 communications with a 
serial device, such as a router.  The port is configured as follows:

~ DCE, 115K baud, 8 data bits, 1 stop bit, no parity bits  

In Appendix A, refer to the “Serial Connector” section on page 261 for pinouts.

5) Console Port

One 9-pin D connector is provided for RS-232 “command line” communications 
with the ScreenPRO-II Controller, and for downloading code in the field.  The port 
is configured as follows:

~ DCE, 115K baud, 8 data bits, 1 stop bit, no parity bits

The serial port can be connected to a standard PC serial port with a straight 
through DB-9 to DB-9 cable.  In Appendix A, refer to the “Serial Connector” 
section on page 261 for pinout details.

6) Ethernet Port

One RJ-45 connector is provided for 10/100BaseT Ethernet communications with 
the ScreenPRO-II Controller.  When (optionally) connecting the Controller to 
peripheral devices (such as BlendPRO-II), a standard Ethernet hub or switch on 
an isolated network is recommended.  

The Ethernet port is 10/100 Mbit auto sensing capable, and is configured to run as 
a DHCP server.  A variety of Barco Folsom protocols for communication, control, 
and code loading are implemented.  The Ethernet connector is compatible with:

~ Standard RJ-45 Ethernet cables

~ Neutrik EtherCon® series cables

In Appendix A, see the “Ethernet Connector” section on page 260 for pinouts.

7) Adjustable Feet

The two rear feet of the ScreenPRO-II Controller are adjustable, enabling you to 
raise the rear of the Controller for increased Touch Screen visibility.  

Figure 2-2.  Controller Side View, showing adjustable feet retracted and extended

8) AC Connector and Fuse

One AC Connector with integral Fuse is provided to connect the ScreenPRO-II 
Controller to your facility’s AC power source.  Please note:

~ The integral switch turns the chassis on and off.

~ The fuse rating is T250V, 2A.  For continued protection against risk of 
fire, replace only with a fuse of the same type and rating.
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pÅêÉÉåmolJff=`çåíêçääÉê=cêçåí=m~åÉä
The figure below illustrates the ScreenPRO-II Controller front panel:

Figure 2-1.  ScreenPRO-II Controller Front Panel 

Following are descriptions of each front panel feature: 

1) Touch Screen Menu Section

The Touch Screen Menu Section is used for system configuration, setup and 
operational adjustments — such as PIPs and Keys.  Refer to the “Touch Screen 
Menu Section” heading on page 38 for details.

2) Presets Section

The Preset Section enables you to store and recall Controller setups.  Each 
button represents a single “look” of the projected image.  Thirty-six presets are 
available.  Refer to the “Presets Section” heading on page 39 for details. 
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1) Touch Screen Menu Section 5) Light Adjustment Knob 9) Layer Control Section

2) Presets Section 6) XLR Connector 10) Transition Section

3) Destination/Aux Bus 7) Source Selection Bus

4) Joystick Section 8) Layer Functions Section
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3) Destination/Aux Bus

The Destination/Aux Bus enables you to route the Controller’s output to one or 
more destinations, such as projectors and Aux (auxiliary) monitors.  Four 
“Projector” and four “Aux” destinations are available.  Refer to the “Destination/
Aux Bus” section on page 40 for details.

4) Joystick Section 

The Joystick Section includes a 3-axis joystick that enables you to adjust PIPs, 
Keys and additional system parameters.  The section also includes dedicated 
buttons that change the Joystick’s assigned function.  Refer to the “Joystick 
Section” heading on page 42 for details.

5) Light Adjustment Knob

The Light Adjustment Knob enables you to control the brightness of the low-
voltage “script” light.  

6) XLR Connector

One XLR Connector is provided for the low-voltage “script” light.  

7) Source Selection Bus

The Source Selection Bus allows you to choose the sources that are routed into 
PIPs and keys.  Buttons are provided for up to 16 analog sources and up to two 
HD-SDI/SD-SDI sources.  Refer to the “Source Selection Bus” section on 
page 44 for details.

8) Layer Functions Section

When a layer is active (and blinking) in the Layer Control Section, all buttons in 
the Layer Functions Section apply to that layer, enabling you to change its mode 
and manipulate the source.  Refer to the “Layer Functions Section” heading on 
page 46 for details.

9) Layer Control Section

The Layer Control Section is the operational heart of the ScreenPRO-II 
Controller, enabling you to assign sources to PIPs and keys.  Here, you control 
the overall “look” on Preview and Program.  Refer to the “Layer Control Section” 
heading on page 48 for details.

10) Transition Section

The Transition Section includes the T-Bar for manually mixing sources on and 
off Program, plus dedicated buttons for cutting, mixing and wiping.  Refer to the 
“Transition Section” heading on page 50 for details.
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rëÉ=çÑ=`çäçê
Color plays an important “visual” role with the ScreenPRO-II Controller’s front panel 
buttons:

White buttons are used  for sources.

Yellow buttons are functions and modes that apply to the active (blinking) layer.  Functions 
include assigning PIPs and keys to the active layer, setting up moves, freezing the active 
layer and swapping layer priority.   

Orange buttons are used to control pages of presets, and for special MOVE and MOVE 
SETUP functions. 

Red buttons are designated “important.”  They are used in dual-button sequences such as 
SHIFT, Learn and Delete, and with important transition functions such as CUT and AUTO 
TRANS.     

Green buttons indicate unscaled sources, such as backgrounds and the DSK. 

Blue buttons indicate scaled sources.

1

PIP

Page

Learn

DSK

LAYER
A
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This section provides detailed descriptions and illustrations of each front panel section.  
The following topics are discussed:

• Touch Screen Menu Section

• Presets Section

• Destination/Aux Bus

• Joystick Section

• Source Selection Bus

• Layer Functions Section

• Layer Control Section

• Transition Section
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qçìÅÜ=pÅêÉÉå=jÉåì=pÉÅíáçå
The figure below illustrates the Touch Screen Menu Section.  A sample menu is shown 
for reference.  

Figure 2-2.  Touch Screen Menu Section

Following are descriptions of each area:

1) Softkeys

Eight un-labeled softkeys are provided — four to the left of the Touch Screen and 
four below.  Softkey labels (when present) appear on the Touch Screen itself.  
Press the adjacent softkey to access the menu or activate the indicated function.

2) Touch Screen

On the Touch Screen, all menus and functions can be accessed in a variety of 
different ways:

~ Touch the desired button on the Touch Screen itself (for example, the 
{BORDR} or {SHDOW} buttons) to access the menu as indicated.

~ Press a Softkey that is directly adjacent to a button label.

~ Use the top NAV knob to move the highlight to the desired line, then use 
the ADJ rotary knob to adjust the value. 

~ Touch a particular line to move the highlight to that line, then use the 
ADJ rotary knob to adjust the value.     
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H Position -34
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OPERATION:

JOY Z TO SIZE, X Y TO POSITION

2 31

1) Softkeys 2) Touch Screen 3) Rotary Knobs

Important When adjusting parameters, there is no Enter button.  If you 
adjust a value with the knobs or the softkeys, that function, 
parameter or value is immediately active in Preview.
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3) Rotary Knobs

Two Rotary Knobs are provided to the right of the Touch Screen.  Each knob 
controls or adjusts the function that is labeled on the Touch Screen itself, 
immediately adjacent to the knob.  Please note:

~ The Top Knob is generally assigned to navigating menu fields.  For 
example, turning the knob moves a highlight up and down a list of 
parameters, allowing you to adjust the highlighted function.  This knob 
also adjusts adjacent parameters.

~ The Bottom Knob is generally assigned to adjusting the highlighted 
parameter, as labeled on the Touch Screen.  

mêÉëÉíë=pÉÅíáçå
The figure below illustrates the Presets Section:

Figure 2-3.  Presets Section

A Preset is a register in which you can store and recall entire Controller setups.  One 
preset represents a single “look” of the Controller — including the current state of all 
mixers, layers, sources, and the DSK.  The Controller provides buttons for 36 Presets (6 
pages of 6 presets each).

Following are descriptions of each button’s function.  

Preset Buttons — press to recall a Preset to the Preview bus.  If resources are available, 
the “look” stored with that preset will be recalled.  If the button does not light, system 
resources are not currently available to process the request.  

When lit, the Red LED above each button indicates the currently selected page.  

If LED 3 and button 6 are lit, the 6th Preset on page 3 is active.    

In Chapter 6, refer to the “A Word About Resources” section on page 243 for additional 
important information.

Learn — hold down Learn, then press the desired Preset button to store the overall look of 
the Controller into that register. 

To store a Controller setup in Preset register 2, press Learn + 2.

Delete — hold down Delete, then press the desired Preset button to delete that register 
from memory.

To delete Preset 5 from memory, press Delete + 5.

11 2 3 4 5 6 Learn Delete Next Previous Page

Page

PRESETS

4

Learn

Delete
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Next — press to recall the next valid Preset in sequential order.  Please note:

• If Preset 2 is lit, pressing Next recalls Preset 3.

• If Preset 6 is active on page 2, pressing Next advances to Preset 1 on page 3.

• If a Preset is undefined, it will be skipped when Next is pressed. 

Previous — this function is currently not implemented.

Page — hold down Page, then press the desired Preset button to switch to that page of 
Presets.  The Red LED above the button lights to indicate the selected page.

To switch to page 5, press Page + 5.  

In Chapter 6, refer to the “Working with Presets” section on page 243 for complete 
instructions on all Preset modes.

aÉëíáå~íáçåL^ìñ=_ìë
The figure below illustrates the Destination/Aux Bus:

Figure 2-4.  Destination/Aux Bus

Each numbered button on the Destination Bus represents a location to which you can 
route some form of controller (or router) output.  The transitions that you perform will affect 
the selected destinations only, leaving the unselected destinations as they were.  The 
ScreenPRO-II Controller provides eight destinations — four standard (e.g., projectors) and 
four Aux (auxiliary).   

Next

Previous

Page

Note The Page button is also used (in conjunction with the ALL 
button) to lock and unlock the Controller.  In Chapter 6, refer 
to the “Locking and Unlocking the Controller” section on 
page 252 for details.

1 2 3 4
DEST
AUX

DESTINATIONS / AUX

ALL

Important Operationally, remember that the Destination/Aux Bus is 
one bus — it is not two separate and independent buses. 

• Any source selection will apply to all enabled buses. 

• Any transition will apply to all enabled buses.
40 ScreenPRO-II Controller  •  User’s Guide



2.  Hardware Orientation
Front Panel Sections
Examples of destinations are listed below:

• Single Screen Destination — this is a “single projector” destination that takes its 
input from a ScreenPRO-II.    

• Wide Screen Destination — this is a “multiple projector” destination that takes its 
inputs from two, three or four ScreenPRO-IIs, as routed through a BlendPRO-II.

• Aux Destination —  this is a single monitor that takes its input from one router 
output (in a single format).  When you select an Aux destination and a source on 
the Controller, you are talking directly to a specific router output via RS-232 or 
Ethernet communications — and making a source-to-destination connection.

• ImagePRO Aux Destination — this is a standalone ImagePRO that takes its 
input(s) from multiple routers, in multiple formats.  When connected to a single 
monitor or projector, a scaled output signal is provided — in one format.  Whereas 
an Aux Destination requires a single input format, an ImagePRO Aux Destination 
accepts inputs in multiple formats.

• PresentationPRO-II Aux Destination — similar to an ImagePRO Aux 
destination, this is a standalone PresentationPRO-II that takes its input(s) from 
standalone sources or routers, in multiple formats.  When connected to a single 
monitor or projector, a scaled signal is provided in one format.  

In Chapter 5, refer to the “Standard Destination Setup” section on page 192 for details on 
all destination setup procedures.  

Following are descriptions of each button’s function.

Destination/Aux Buttons — press to toggle the numbered destination on or off.  Any 
combination of destinations can be selected.  The transitions that you perform will affect 
only the selected destination(s).  Please note:

• The four destination buttons work in conjunction with the DEST/AUX button.  See 
the description of the DEST/AUX button (immediately below) for details.  

• Press a numbered destination button by itself to enable that destination and 
toggle all other destinations off.  In this mode, the buttons are mutually exclusive.

• Press two or more destination buttons simultaneously to enable a “group” of 
destinations.  In this mode, the selected group is mutually exclusive with any other 
active destinations:

Destinations 1, 2 and 3 are lit.  If you press destinations 1 and 2 
simultaneously (to enable them), destination 3 turns off.

• Use the All button to turn all destinations on or off.  See the description of the All 
button (below) for details.

DEST/AUX — press to switch the bus between standard (projector) destinations and Aux 
(auxiliary) destinations, such as monitors.  

• When DEST/AUX is off, you are selecting standard (projector) destinations.

• When DEST/AUX is lit, you are selecting Aux (auxiliary) destinations.

1

DEST
AUX
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All — the All button works in conjunction with the currently selected bus (as chosen with 
the DEST/AUX button):

• Press All once to turn all “defined” destinations on.

• Double-punch the All button to turn all “defined” destinations off.  

In Chapter 6, refer to the “Working with Destinations” section on page 222 for complete 
instructions on all destination modes.

gçóëíáÅâ=pÉÅíáçå
The figure below illustrates the Joystick Section.

Figure 2-5.  Joystick Section

When a PIP or Key is selected in the Layer Control Section, the controls in the Joystick 
section are automatically assigned to manipulate that feature on Preview.  When none of 
the six function buttons are lit, the 3-axis Joystick has the following functions:

• X-Axis Control — Move the Joystick left and right to move the PIP (or Key) left 
and right respectively. 

• Y-Axis Control — Move the Joystick up and down to move the PIP (or Key) up 
and down on Preview. 

• Z-Axis Control — Twist the Joystick’s top knob clockwise and counterclockwise 
to increase or decrease the PIP (or Key) size. 

All

Note The All button is also used (in conjunction with the Page 
button) to lock and unlock the Controller.  In Chapter 6, refer 
to the “Locking and Unlocking the Controller” section on 
page 252 for details.

Source Crop

Top
Left

Bottom
Right

Reset Fine
Adjust

Adjustment Panel

Note The Z-Axis Control can also be used to increase or 
decrease the value of a highlighted parameter, such as a 
matte color, key clip and gain, border size and much more. 
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Descriptions of each button in the Joystick Section are listed below.

Source — press to assign the Joystick to sizing and positioning the source image within 
the PIP or Key boundaries.  Please note:

• In Source mode, the PIP or Key’s placement on screen remains static, while the 
image is adjusted within.  

• If a PIP is selected, the Input Source Adjustment Menu appears when Source 
is enabled.  

• If a Key is selected, the Key Source Adjustment Menu appears when Source is 
enabled.  

To return to normal PIP adjustment, turn the button off.  In Chapter 4, refer to the “Source 
Adjustment Menus” section on page 165 for additional details.  

Crop — press to re-assign the Joystick to cropping the boundaries of the PIP or Key.  
When enabled, the Top Left and Bottom Right buttons are also enabled, and the Crop 
Adjustment Menu appears.  To return to normal PIP adjustment, toggle the button off.  In 
Chapter 4, refer to the “Crop Menu” section on page 164 for additional details.  

Reset — the Reset button is a momentary function.  Press to reset the current effect (e.g., 
PIP, Key, crop, etc.) to a nominal default value.  Think of this function as being “context 
sensitive” — as it resets only the current effect, without affecting other modifications.   

Top Left — when the Crop button is lit, press to crop the PIP or Key’s top and left edges:

• Move the Joystick left and right to crop the left edge.

• Move the Joystick up and down to crop the top edge.  

 In Chapter 4, refer to the “Crop Menu” section on page 164 for additional details.

Bottom Right — when the Crop button is lit, press to crop the PIP or Key’s bottom and 
right edges:

• Move the Joystick left and right to crop the right edge.

• Move the Joystick up and down to crop the bottom edge.   

In Chapter 4, refer to the “Crop Menu” section on page 164 for additional details.

Fine Adjust — the Fine Adjust button is a latching function.  In any PIP or Key adjustment 
mode, press to increase the precision of the Joystick’s adjustment range.   

In Chapter 6, refer to the “Modifying Layers On Program” section on page 234 for 
additional details on Joystick usage.

Source

Crop

Reset

Top
Left

Bottom
Right

Fine
Adjust
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The figure below illustrates the Source Selection Bus. 

Figure 2-6.  Source Selection Bus

On the Source Selection Bus, each numbered button represents an input that you can 
assign to a PIP or Key, or route to an Aux destination.  Each input is either a direct 
connection to a ScreenPRO-II or a router input.  Please note:

• If you have configured a ScreenPRO-II to use internal routing (on the 
Destination Setup Menu), both the white buttons (analog sources) and the 
yellow buttons (HD-SDI/SD-SDI sources) are active.  You can assign a maximum 
of 16 analog and 2 HD-SDI/SD-SDI sources.

• If you have configured a ScreenPRO-II to use external routing (on the 
Destination Setup Menu), only the white buttons are active.  You can assign a 
maximum of 16 sources, comprised of any mix of analog and digital.  

Following are descriptions of each button’s function in the Source Selection Bus. 

Source Buttons — press to assign the source (analog or digital) to the blinking “mixer” 
button in the Layer Control Section.  The following rules apply:

• When the source button is lit and blinking, the source is on Preview, the 
associated layer is active for modification, and the associated layer’s raster box 
blinks on Preview.  

• When the source button is lit solid, the source is on Preview — but its associated 
layer is not active for modification.

• Multiple source buttons can be lit simultaneously, but only one source button can 
be blinking — with its associated layer active for modification and the associated 
raster box blinking on Preview.

• When the Red LED above a source button is lit solid, the source is on Program — 
and its associated destination is enabled.  

Program

SOURCE SELECTION

1
9

2
10

3
11

4
12

5
13

6
14

7
15

8
16

SHIFT SDI
1

SDI
2

Important In this mode, with external routing enabled, the two yellow 
SDI buttons are disabled.

1
9

SDI
1

Important The Red LEDs only appear if the route’s associated 
destination button is enabled.  For example, if Source 1 on 
Destination 1 is on Program, the Red LED above Source 1 
will turn off if Destination 1 is cleared. 
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• When the Red LED above a source button is blinking:

~ The mixer is set to Mix Mode (the Split button is not lit).  

~ The blinking Red LED indicates the layer that is on Program.

~ The alternate layer is enabled for modification on Preview, and its 
associated raster box blinks.  

The Red LED above source 1 is blinking, and the Red LED above Layer A is 
blinking.  This indicates that the mixer is set to Mix Mode, source 1 is on 
program in Layer A, and Layer B is active for modification on Preview.  

• Multiple Red LEDs can be lit simultaneously, but only one Red LED can be 
blinking — indicating a “Mix Mode” association between a source and a layer. 

• Source buttons cannot be selected if they have not been assigned during the 
source setup procedure.  The button will not light.

• Source buttons are also used to route inputs to selected Aux destinations.  In 
Chapter 6, refer to the “Working with Destinations” section on page 222 for 
details.   

Shift — the Shift button is a toggle:  press once to light, press again to turn off.  When lit, 
press the desired source button to access the second row of numbered sources (9 - 16).  

Note When the Controller is locked, source buttons are used to 
enter the 4-digit password.  In Chapter 6, refer to the 
“Locking and Unlocking the Controller” section on 
page 252 for details.

Shift
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The figure below illustrates the Layer Functions Section.  

Figure 2-7.  Layer Functions Section

The buttons in the Layer Functions Section enable you to change or modify the selected 
(blinking) layer in the Layer Control Section. 

PIP — press to change the selected layer (in the Layer Control Section) and its 
associated source to a PIP.  The PIP Adjustment Menu appears on the Touch Screen.  In 
Chapter 4, refer to the “PIP Adjustment Menu” section on page 148 for details.

Key — press to change the selected layer (in the Layer Control Section) and its 
associated source to a Key.  The Key Adjustment Menu appears.  In Chapter 4, refer to 
the “Key Menu” section on page 155 for details.

Full Screen — press to take the active PIP or Key to full screen.  In each case, the 
source’s height is used as the parameter that defines the full screen size.

If a source’s original dimension is 1280 x 1024, pressing Full Screen 
expands (or reduces) the PIP or Key to fill the output screen vertically.  If 
borders are ON, they will be taken into account so that they are visible.

In Chapter 6, refer to the “Using Full Screen” section on page 235 for instructions.

Clone — for widescreen configurations only, press to make an exact copy of a layer onto 
the opposite screen.  All parameters of the PIP or Key are cloned, including the source’s 
shadow, key effects, border and size.  Once cloned, you can select between a “mirror” or 
an “offset” clone.

If Layer A is a PIP on screen 1, press Clone to make an exact copy of the 
PIP on screen 2.  When you adjust the PIP, both the original and the “cloned” 
copy are adjusted simultaneously.

In Chapter 6, refer to the “Using Clone” section on page 235 for instructions.

Swap Z-order — press to change the visual priority (on Preview) of the two mixer layers.   
The PIPs or Keys remain at their current locations — only the priority changes.

If the PIP on Layer B is visually on top of the PIP on Layer A, press 
Swap Z-Order to place Layer A’s PIP on top.  

In Chapter 6, refer to the “Using Swap Z-Order” section on page 236 for instructions.

PIP KEY Full
Screen Clone Swap

Z-Order
Move
Setup Move Mix

Source Swap Toggle Freeze

LAYER FUNCTIONS

PIP

KEY

Full
Screen

Clone

Swap
Z-order
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Move Setup — two functions are provided:

• Press Move Setup to set up a “move” for a PIP or Key, enabling you to choose 
the move’s start and end points.   

• Double-punch the Move Setup button to un-define (or clear) the “move setup” for 
the selected layer.

In Chapter 6, refer to the “Using Move” section on page 238 for complete instructions.

Move — press to pend a “move” for a PIP or Key, enabling you to fly the PIP or Key from 
one location to another on the next auto transition.  

In Chapter 6, refer to the “Using Move” section on page 238 for complete instructions.

Mix Source — in “Mix Mode” (with the Split button off) press Mix Source to co-locate both 
PIPs in the mixer.  Layers A and B will be exactly the same size — in exactly the same 
position.  Mix Source and Swap modes are mutually exclusive.  In Chapter 6, refer to the 
“Understanding Split and Mix Modes” section on page 228 for instructions.

Swap — in “Mix Mode” (with the Split button off) press Swap to allow both PIPs in the 
mixer to be located independently.  Layers A and B can be positioned and sized anywhere 
as desired.  Mix Source and Swap modes are mutually exclusive.  In Chapter 6, refer to 
the “Understanding Split and Mix Modes” section on page 228 for instructions.

Toggle — press to toggle sources back and forth with each transition.  Once a source 
transitions off Program within a PIP, it “flip-flops” to Preview.  Toggle is used with both the 
Mix Source and Swap modes, and also functions with background transitions.  In 
Chapter 6, refer to the “Understanding Split and Mix Modes” section on page 228 for 
details. 

Freeze — enables you to freeze a layer on both Program and Preview.

In Chapter 6, refer to the “Using Freeze” section on page 236 for instructions.

Move
Setup

Move

Mix
Source

Swap

Toggle

Freeze
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The figure below illustrates the Layer Control Section.    

Figure 2-8.  Layer Control Section

The buttons in the Layer Control Section enable you to select (on Preview) the sources 
that will transition to or from Program — including backgrounds, layers, the DSK and the 
full screen LOGO.  

When you select a blue “layer” button, you are electronically selecting a scaler that you 
want to assign as a PIP or key, or modify in some manner.  In this way, you control the 
overall look on Preview before you transition that look to Program.  

Please note the following important points:

• Two background sources, two layers (in the mixer), one DSK and one full screen 
LOGO are provided — identical to the layers on an individual ScreenPRO-II.

• The buttons are arranged left-to-right in order of visual priority — from the 
backgrounds (at the lowest priority) to the LOGO (at the highest visual priority).

• Any combination of backgrounds, layers, DSK and LOGO can be selected on 
Preview for transition to or from Program.  

Following are descriptions of each button’s function.

Background Buttons — press to select an unscaled background on Preview for transition 
to or from Program.  The button lights when selected.  Please note:

• If the Red LED is lit, the background is on Program.  

• If BG A is on Program and BG A is selected in Preview, there will be no change of 
backgrounds on the next transition.  

Program

BG
A

BG
B

DSK LOGO

Clear
Layer

Split

LAYER
A

LAYER
B

Note In both single and widescreen modes, the only restriction is 
that BG B and the DSK are mutually exclusive.  This occurs 
because the BG/DSK Input B is shared between the DSK 
and BG B on all individual ScreenPRO-II units.

Important Each ScreenPRO-II unit uses a “lookahead” Preview monitor 
that fully represents how the Program output will appear next.  
By selecting combinations of PIPs, keys, backgrounds and 
the DSK, you are composing a Preview image that will appear 
on Program — after the next transition.  A “lit” button does not 
necessarily mean that the source will transition on or off — it 
simply means that it is part of the “look” on Preview. 

BG
A
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• If BG A is on Program and BG B is selected in Preview, BG A will dissolve, cut or 
wipe to BG B on the next transition.

• Toggle mode affects background transitions.  In Chapter 6, refer to the 
“Background Transitions” section on page 227 for complete instructions.  

Layer Buttons — press to select a layer on Preview for transition to or from Program.

• When lit and blinking:

~ The layer is active for manipulation.

~ A source can be assigned to the layer from the Source Selection Bus.

~ The layer can be assigned as a PIP or Key using the buttons in the 
Layer Functions Section.

• When lit solid, the layer is on Preview, but it is not active for manipulation.  It is, 
however, ready to be transitioned to or from Program.

• When the Red LED above the button is lit, the layer is on Program. 

• To clear a layer from Preview (so that it will transition off Program), press Clear 
Layer.  This turns off the layer button.  If the Red LED above the layer button is lit, 
on the next transition the layer will transition off Program. 

DSK — press to select the unscaled DSK on Preview for transition to or from Program.  
The button lights when selected.  Please note:

• When the Red LED above the button is lit, the DSK is on Program.

• The DSK and BG B are mutually exclusive.

LOGO — press to select the unscaled, full screen LOGO on Preview for transition to or 
from Program.  The button lights when selected.  Please note:

• When the Red LED above the button is lit, the LOGO is on Program.

• The LOGO is the system’s highest priority layer.  The LOGO “source” is selected 
from one of the individual ScreenPRO-II’s three internal frame stores.  

• The LOGO layer is often used as a “black preview” function.  If Black is selected 
as the “type” on the Logo Input Setup Menu, you can fade to black at any time by 
selecting LOGO on preview.  In Chapter 4, refer to the “LOGO Menu” section on 
page 182 for details. 

• The logo is not a live input, and does not have an associated key signal.  

Clear Layer — press Clear Layer to remove the currently selected (blinking) layer from 
Preview — in preparation for transitioning it off Program.  In Chapter 6, refer to the 
“Clearing Layers from Program” section on page 234 for instructions.

Layer
A

DSK

LOGO

Important All layers are maintained underneath the LOGO.  For 
example, if you have two PIPs and a DSK on Program when 
you transition to the LOGO, when you fade the LOGO off — 
the previous “look” is still there.

Clear
Layer
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Split — press to select whether or not the mixer’s two layers work independently (in Split 
Mode), in tandem (Mix Mode), or in “Join” mode.

• Mix Mode — the Split Layer button is off.  In this mode, the two layers are 
ganged together, offering a variety of additional transitions including the toggle, 
mix source and swap functions.  

• Split Mode — the Split Layer button is on.  In this mode, each layer works 
independently.  You have the freedom to size, position, manipulate and transition 
each one independently of the other.

• Join Mode — the Split Layer button is on.  The currently blinking layer button is 
considered the “master.”  Press and hold the Split Layer button, then press the 
other (non-blinking) layer button to “join” the two layers together.  Both layer 
buttons blink, and in this mode, both are now joined together.  

~ Any manipulation that you perform to the “master” layer is also 
performed to the joined layer.  Both can be sized, positioned, moved and 
manipulated as if they are one.

~ To un-join the two layers, press and hold the Split Layer button, then 
press either Layer button. 

In Chapter 6, refer to the “Working with Layers” section on page 226 for details.

qê~åëáíáçå=pÉÅíáçå
The figure below illustrates the Transition Section.

Figure 2-9.  Transition Section

Descriptions of each button and control are provided below:

WIPE — press to select a wipe as the current transition type for the selected destination.  
The button lights when enabled, and the wipe is initiated by pressing AUTO TRANS.  The 
wipe patterns, edge types and transition rates are selected using the Effects Menu.    

MIX — press to select a mix (dissolve) as the current transition type for the selected 
destination.  The button lights when enabled, and the mix is initiated by pressing AUTO 
TRANS.  Auto transition rates are defined using the Effects Menu.  

Split

WIPE MIX

TRANSITIONS

CUT
AUTO

TRANS

WIPE

MIX
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CUT — press to instantly cut the images from Preview to Program. 

Auto Trans — press to transition automatically from Preview to Program at a pre-defined 
rate, using the selected transition type (MIX or WIPE).  Auto transition rates are defined 
using the Effects Menu. 

 

T-Bar — enables you to perform smooth, manual transitions.  Each time the T-Bar is 
moved from limit to limit, the setup on Preview transitions to Program using the selected 
transition type (MIX or WIPE).  

For additional information on transitions and the Effects Menu:

• In Chapter 4, refer to the “Effects Menu” section on page 146 for menu details.  

• In Chapter 6, refer to the “Working with Transitions” section on page 241 for 
operational procedures.  

CUT

AUTO
TRANS

Note Because the Controller’s Effects Menu is destination-based, 
WIPE and MIX effects can be assigned per destination.  

For example, with destinations 1 and 3 lit, select WIPE.  Next, 
with destination 2 lit, select MIX.  Next, select all three 
destinations and press AUTO TRANS to perform a wipe on 
destinations 1 and 3, and a dissolve on destination 2. 
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This chapter provides comprehensive installation instructions for the ScreenPRO-II 
Controller system’s hardware.  The following topics are discussed:

• Safety Precautions

• Unpacking and Inspection

• Site Preparation

• Controller Installation

• Cable, Adapter and Accessory Information

• Connection Charts

• System Installation

• BlendPRO-II Widescreen Lock Connections

• Overview of Edge-Blending Technology

Note Once you have reviewed all of the sections in this chapter, 
please continue with Chapter 4, “Menu Orientation” on 
page 85.
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For all ScreenPRO-II Controller installation procedures, please observe the following 
important safety and handling rules to avoid damage to yourself and the equipment:

• To protect users from electric shock, ensure that the chassis connects to earth via 
the ground wire provided in the AC power Cord.

• The AC Socket-outlet should be installed near the equipment and be easily 
accessible.

råé~ÅâáåÖ=~åÇ=fåëéÉÅíáçå=
Before opening the ScreenPRO-II Controller shipping box, inspect it for damage.  If you 
find any damage, notify the shipping carrier immediately for all claims adjustments.  As you 
open the box, compare its contents against the packing slip.  If you find any shortages, 
contact your sales representative. 

Once you have removed all the components from their packaging and checked that all the 
listed components are present, visually inspect the system to ensure there was no damage 
during shipping.  If there is damage, notify the shipping carrier immediately for all claims 
adjustments.

páíÉ=mêÉé~ê~íáçå=
The environment in which you install your ScreenPRO-II Controller should be clean, 
properly lit, free from static, and have adequate power, ventilation, and space for all 
components. 

`çåíêçääÉê=fåëí~ää~íáçå
The ScreenPRO-II Controller is designed to be used in a “tabletop” configuration, without 
rack mounting.  

Because the Controller is part of a larger system, which can involve a variety of 
components including ScreenPRO-II, BlendPRO-II, MatrixPRO routers, ImagePRO, 
PresentationPRO-II and one or more projectors, please refer to the “System Installation” 
section on page 73 for comprehensive installation instructions.
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3.  Hardware Installation
Cable, Adapter and Accessory Information
`~ÄäÉI=^Ç~éíÉê=~åÇ=^ÅÅÉëëçêó=fåÑçêã~íáçå
The table below provides information regarding cables and adapters:

Table 3-1. ScreenPRO-II Controller System Cables, Adapters and Accessories

Item Description Note

Accessories

Gooseneck Lamp Connects to the XLR connector on the Controller panel 1 Lamp Supplied

Power Connections

AC Power Cord AC Power, 7 foot, 10A 1 Cord Supplied

Note In Chapter 3, “Hardware Installation” of the ScreenPRO-II 
User’s Guide, refer to the “Cable and Adapter Information” 
section for details on the components supplied with individual 
ScreenPRO-II units.
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`çååÉÅíáçå=`Ü~êíë=
The following topics are discussed in this section:

• Connection Chart Overview

• Sample Connection Charts — External Routing

• Sample Connection Charts — Internal Routing

• Blank Connection Charts

`çååÉÅíáçå=`Ü~êí=lîÉêîáÉï
A series of Connection Charts are provided on the following pages to assist with your 
ScreenPRO-II input and output connections.  Please note the following points:

• Each ScreenPRO-II provides:

~ 8 x analog inputs, scaled.  These can be used to connect RGB, 
composite, S-Video (Y/C) and component video.

~ 2 x HD-SDI/SD-SDI inputs, scaled (on the HD model).

~ 2 x DVI inputs, unscaled (BG/DSK).

• You can connect sources directly to inputs (internal routing), or you can connect 
router outputs to inputs (external routing).  This assignment is performed on the 
Destination Setup Menu.  Note that the use of routers offers less restrictions with 
regard to assigning sources to layers.  

~ If you have configured a ScreenPRO-II to use internal routing, both the 
white buttons (analog sources) and the yellow buttons (HD-SDI/SD-SDI 
sources) are active on the Source Selection Bus.  You can assign a 
maximum of 16 analog and 2 HD-SDI/SD-SDI sources.

~ If you have configured a ScreenPRO-II to use external routing, only the 
white source buttons on the Source Selection Bus are active.  You can 
assign a maximum of 16 sources, using any mix of analog and digital.  

• On each ScreenPRO-II, two DVI connectors are provided for Background and 
DSK Inputs.  Both connectors are digital only, and do not include analog pins.  
Please note:

~ To use two background sources, connect one source to connector A and 
one to connector B.

~ To use one background and one DSK source, connect the background to 
connector A and the DSK source to connector B.

Chart instructions:

• Analog Router I/O Chart

If you are using external routing, complete the Analog I/O router chart for your 
analog input and output connections.  The chart can also be used to specify router 
outputs that connect to Aux destinations.

Important In this mode, with external routing enabled, the two yellow 
SDI buttons are disabled.
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• Digital Router I/O Chart

If you are using external routing, complete the digital I/O router chart for your 
digital input and output connections.  The chart can also be used to specify router 
outputs that connect to Aux destinations.

• Analog Input Chart — Direct or DA Connections 

If you are using internal routing, complete the analog input chart for direct or DA 
analog connections to each ScreenPRO-II and other target analog destinations.  
Be sure to check ( ) whether or not the analog input is a direct connection, or 
from a DA output.

• Digital Input Chart — Direct or DA Connections 

If you are using internal routing, complete the digital input chart for direct or DA 
digital connections to each ScreenPRO-II and other target analog destinations.  
Be sure to check ( ) whether or not the digital input is a direct connection, or from 
a DA output.

• DVI Connection Chart

For all system configurations, complete the DVI Connection Chart to map your 
Background and DSK DVI connections.  Be sure to check ( ) whether or not the 
DVI source originates from a multi-head graphics card, or a DA (or splitter).

• Standard Destination Chart

For all system configurations, complete the Standard Destination Chart.  The 
ScreenPRO-II Controller enables you to configure up to four standard 
destinations.  Note that the chart is also used to map the usage of BlendPRO-II in 
widescreen configurations.

• Auxiliary Destination Chart

For all system configurations, complete the Auxiliary Destination Chart.  The 
ScreenPRO-II Controller enables you to configure up to four auxiliary 
destinations.  

Before you complete the actual charts, please review the sample charts as provided in the 
following two sections:

• “Sample Connection Charts — External Routing”, page 58.

• “Sample Connection Charts — Internal Routing”, page 62.
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p~ãéäÉ=`çååÉÅíáçå=`Ü~êíë=Ô=bñíÉêå~ä=oçìíáåÖ
Following are sample connection charts for a ScreenPRO-II Controller system configured 
for external routing.  The system is comprised of the following components:

• 2 x ScreenPRO-II

• 1 x widescreen destination (using two projectors)

• 1 x BlendPRO-II 

• 2 x Aux destinations (PresentationPRO-II, ImagePRO)

• 1 x Analog router, 8x8

• 1 x SDI router, 8x8

The figure below provides a simplified diagram of the system:

Figure 3-1.  Sample System with External Routing

The following sample charts are provided:

• External Routing — Sample Analog Router I/O Chart

• External Routing — Sample Digital Router I/O Chart

• Widescreen — Sample DVI Connection Chart

• Widescreen — Sample Standard Destination Chart

• Widescreen — Sample Auxiliary Destination Chart

Ethernet Distribution 
(Local Network Only)

MatrixPRO HD-SDI Router

MatrixPRO RGBHV Router

ScreenPRO-II Controller

ScreenPRO-II #1

BlendPRO-II

Widescreen Destination

ScreenPRO-II #2

PC
(Background)

DVI

PC 
(DSK)
DVI

PresentationPRO-II (Aux Destination 1)

ImagePRO (Aux Destination 2)

Preview Left Preview Right

Program Left Program Right

Note Abbreviated charts are used in the following sections.
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bñíÉêå~ä=oçìíáåÖ=Ô=p~ãéäÉ=^å~äçÖ=oçìíÉê=fLl=`Ü~êí
With a ScreenPRO-II configured to use external routing (on the Destination Setup Menu), 
use the following chart to map Analog Router input and output connections:  

bñíÉêå~ä=oçìíáåÖ=Ô=p~ãéäÉ=aáÖáí~ä=oçìíÉê=fLl=`Ü~êí
With a ScreenPRO-II configured to use external routing, use the following chart to map SDI 
Router input and output connections:

Table 3-2. Sample Analog Router I/O Chart

Router #1 — Analog

Source Name Controller Input #
Router 

← Input | Output → Connects to:

DVD A 7 1 ScreenPRO-II #1, Input 1 Analog

DVD B 8 2 ScreenPRO-II #1, Input 2 Analog

LOGO 9 3 ScreenPRO-II #2, Input 1 Analog

PowerPoint 10 4 ScreenPRO-II #2, Input 2 Analog

PowerPoint Backup 11 5 PrePRO-II, Input 1 Analog

Demo A 12 6 ImagePRO, Analog Input

Demo B 13 7

Betacam 6 8

Table 3-3. Sample Digital Router I/O Chart

Router #2 — SDI

Source Name Controller Input #
Router 

← Input | Output → Connects to:

Camera 1 1 1 ScreenPRO-II #1, Input 1 SDI

Camera 2 2 2 ScreenPRO-II #1, Input 2 SDI

Camera 3 3 3 ScreenPRO-II #2, Input 1 SDI

Digital Betacam 4 4 ScreenPRO-II #2, Input 2 SDI

Server 5 5 PrePRO-II, Input 1 SDI

6 ImagePRO, SDI Input

7

8
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táÇÉëÅêÉÉå==Ô=p~ãéäÉ=asf=`çååÉÅíáçå=`Ü~êí
Each ScreenPRO-II has two DVI inputs for the Background and DSK (BG/DSK in A and 
BG/DSK in B).  Widescreen backgrounds will typically originate from a multi-head graphics 
card, while single screen backgrounds are typically distributed from one computer through 
a DA or signal splitter.  Use the following chart to map your Background and DSK DVI 
connections:

táÇÉëÅêÉÉå=Ô=p~ãéäÉ=pí~åÇ~êÇ=aÉëíáå~íáçå=`Ü~êí
The ScreenPRO-II Controller enables you to configure up to four standard destinations.  
Use the following chart to map the distribution of each destination, the usage of 
BlendPRO-II if required, and the routing of your additional program and preview outputs:

Table 3-4. Sample DVI Connection Chart

Background DVI Routing

Source
Multi-Head 

Graphics Card Out
DA 

(or Splitter) Connects to: Note

Computer 1 1 ScreenPRO-II #1, BG/DSK In A Widescreen BG

2 ScreenPRO-II #2, BG/DSK In A Widescreen BG

3

4

Computer 2 1 ScreenPRO-II #1, BG/DSK In B Single screen DSK

2 ScreenPRO-II #2, BG/DSK In B Single screen DSK

3

4

Table 3-5. Sample Standard Destination Connection Chart

Standard Destinations

Output Dest Screen BlendPRO-II Channel Notes

ScreenPRO-II #1 Pgm DVI 1 Widescreen left 1 R12+

ScreenPRO-II #1 Pgm Analog 1 VGA 1

ScreenPRO-II #1 Pgm Analog 2

ScreenPRO-II #1 Pvw VGA 2

ScreenPRO-II #2 Pgm DVI 2 Widescreen right 2 R12+

ScreenPRO-II #2 Pgm Analog 1 VGA 3

ScreenPRO-II #2 Pgm Analog 2

ScreenPRO-II #2 Pvw VGA 4
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táÇÉëÅêÉÉå=Ô=p~ãéäÉ=^ìñáäá~êó=aÉëíáå~íáçå=`Ü~êí
The ScreenPRO-II Controller enables you to configure up to four auxiliary destinations.  
Use the following chart to map the distribution of each auxiliary destination:

Table 3-6. Sample Aux Destination Connection Chart

Aux Destinations

Dest Device Inputs from Screen / Device Notes

1 PresentationPRO-II Analog Router Out #5 Downstage monitor LC47

Digital Router Out #5

2 ImagePRO Analog Router Out #6 Record VTR Digital Betacam

Digital Router Out #6

Important For all Widescreen configurations using BlendPRO-II, ensure 
that you review the “BlendPRO-II Widescreen Lock 
Connections” section on page 77.
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p~ãéäÉ=`çååÉÅíáçå=`Ü~êíë=Ô=fåíÉêå~ä=oçìíáåÖ
Following are sample connection charts for a ScreenPRO-II Controller system configured 
for internal routing.  The system is comprised of the following components:

• 2 x ScreenPRO-II

• 2 x single screen destinations

• 2 x Aux destinations (PresentationPRO-II, ImagePRO)

The figure below provides a simplified diagram of the system:

Figure 3-2.  Sample System with Internal Routing

The following sample charts are provided:

• Internal Routing — Sample Analog Input Chart

• Internal Routing — Sample Digital Input Chart

• Single Screens — Sample DVI Connection Chart

• Single Screens — Sample Standard Destination Chart

• Single Screens — Sample Auxiliary Destination Chart

Ethernet Distribution 
(Local Network Only)

ScreenPRO-II Controller

ScreenPRO-II #1

Single Screen Destinations

ScreenPRO-II #2

PC
(Background)

DVI

PC 
(DSK)
DVI

PresentationPRO-II (Aux Destination 1)

ImagePRO (Aux Destination 2)

Preview Left Preview Right

Camera

DVD or VTR

MAC

Analog DA

PC

Digital DA

Server or D-VTR

Program Left Program Right

Note Abbreviated charts are used in the following sections.
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fåíÉêå~ä=oçìíáåÖ=Ô=p~ãéäÉ=^å~äçÖ=fåéìí=`Ü~êí
With a ScreenPRO-II configured to use internal routing (on the Destination Setup Menu), 
use the following chart to map Analog Inputs to each ScreenPRO-II and other target 
analog destinations.  Note that the use of DAs is recommended to provide identical inputs 
to each ScreenPRO-II (or target device).  

fåíÉêå~ä=oçìíáåÖ=Ô=p~ãéäÉ=aáÖáí~ä=fåéìí=`Ü~êí
With a ScreenPRO-II configured to use internal routing, use the following chart to map 
Digital Inputs to each ScreenPRO-II and other target digital destinations.  The use of DAs 
is recommended to provide identical inputs to each ScreenPRO-II (or target device). 

Table 3-7. Sample Analog Input Chart — Direct or DA Connections

Analog Inputs

Source Name Direct DA DA Output Target Input

Camera 1 PresentationPRO-II, Analog Input

2 ImagePRO, Analog Input

3 ScreenPRO-II #1, Input 1 Analog

4 ScreenPRO-II #2, Input 1 Analog

DVD 1 PresentationPRO-II, Analog Input

2 ImagePRO, Analog Input

3 ScreenPRO-II #1, Input 2 Analog

4 ScreenPRO-II #2, Input 2 Analog

MAC 1

2

3 ScreenPRO-II #1, Input 3 Analog

4 ScreenPRO-II #2, Input 3 Analog

PC 1

2

3 ScreenPRO-II #1, Input 4 Analog

4 ScreenPRO-II #2, Input 4 Analog

Table 3-8. Sample Digital Input Chart — Direct or DA Connections

Digital Inputs

Source Name Direct DA DA Output ScreenPRO-II Input

Server 1 ScreenPRO-II #1, Input 1 Digital

2 ScreenPRO-II #2, Input 1 Digital

3

4
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páåÖäÉ=pÅêÉÉåë=Ô=p~ãéäÉ=asf=`çååÉÅíáçå=`Ü~êí
Each ScreenPRO-II has two DVI inputs for the Background and DSK (BG/DSK in A and 
BG/DSK in B).  Single screen backgrounds are typically distributed from one computer 
through a DA or signal splitter.  Use the following chart to map your Background and DSK 
DVI connections:

páåÖäÉ=pÅêÉÉåë=Ô=p~ãéäÉ=pí~åÇ~êÇ=aÉëíáå~íáçå=`Ü~êí
The ScreenPRO-II Controller enables you to configure up to four standard destinations.  
Use the following chart to map the distribution of each destination and the routing of your 
additional program and preview outputs:

Table 3-9. Sample DVI Connection Chart

Background DVI Routing

Source
Multi-Head 

Graphics Card Out
DA 

(or Splitter) Connects to: Note

Computer 1 1 ScreenPRO-II #1, BG/DSK In A Single screen BG

2 ScreenPRO-II #2, BG/DSK In A Single screen BG

3

4

Computer 2 1 ScreenPRO-II #1, BG/DSK In B Single screen DSK

2 ScreenPRO-II #2, BG/DSK In B Single screen DSK

3

4

Table 3-10. Sample Standard Destination Connection Chart

Standard Destinations

Output Dest Screen BlendPRO-II Channel Notes

ScreenPRO-II #1 Pgm DVI 1 Stage left n/a R12+

ScreenPRO-II #1 Pgm Analog 1 VGA 1

ScreenPRO-II #1 Pgm Analog 2

ScreenPRO-II #1 Pvw VGA 2

ScreenPRO-II #2 Pgm DVI 2 Stage right n/a R12+

ScreenPRO-II #2 Pgm Analog 1 VGA 3

ScreenPRO-II #2 Pgm Analog 2

ScreenPRO-II #2 Pvw VGA 4
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páåÖäÉ=pÅêÉÉåë=Ô=p~ãéäÉ=^ìñáäá~êó=aÉëíáå~íáçå=`Ü~êí
The ScreenPRO-II Controller enables you to configure up to four auxiliary destinations.  
Use the following chart to map the distribution of each auxiliary destination:

Table 3-11. Sample Aux Destination Connection Chart

Aux Destinations

Dest Device Inputs from Screen / Device Notes

1 PresentationPRO-II Analog DA #1, Out #1 Downstage monitor LC47

Analog DA #2, Out #1

2 ImagePRO Analog DA #2, Out #2 Record VTR Digital Betacam

Analog DA #2, Out #2
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_ä~åâ=`çååÉÅíáçå=`Ü~êíë=
The following blank connection charts are provided:

• External Routing — Analog Router I/O Chart 

• External Routing — Digital Router I/O Chart

• Internal Routing — Analog Input Chart

• Internal Routing — Digital Input Chart

• DVI Connection Chart

• Standard Destination Chart

• Auxiliary Destination Chart

bñíÉêå~ä=oçìíáåÖ=Ô=^å~äçÖ=oçìíÉê=fLl=`Ü~êí
If you are using external routing, complete the following Analog Router I/O Chart to map 
your analog input and output connections.  The chart can also be used to specify analog 
router outputs that connect to Aux destinations.  Refer to the “External Routing — Sample 
Analog Router I/O Chart” section on page 59 for a sample chart.  

Table 3-12. Analog Router I/O Chart

Router #1 — Analog

Source Name Controller Input #
Router 

← Input | Output → Connects to:

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16
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bñíÉêå~ä=oçìíáåÖ=Ô=aáÖáí~ä=oçìíÉê=fLl=`Ü~êí
If you are using external routing, complete the following Digital Router I/O Chart to map 
your digital input and output connections.  The chart can also be used to specify digital 
router outputs that connect to Aux destinations.  Refer to the “External Routing — Sample 
Digital Router I/O Chart” section on page 59 for a sample chart.  

Table 3-13. Digital Router I/O Chart

Router #2 — Digital

Source Name Controller Input #
Router 

← Input | Output → Connects to:

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16
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fåíÉêå~ä=oçìíáåÖ=Ô=^å~äçÖ=fåéìí=`Ü~êí
If you are using internal routing, complete the following Analog Input Chart to map your 
analog input connections, either direct or via DA.  The chart can also be used to specify 
other analog destinations such as Aux device inputs.  Please copy the chart as required for 
additional inputs.  Refer to the “Internal Routing — Sample Analog Input Chart” section 
on page 63 for a sample chart.  

Table 3-14. Analog Input Chart — Direct or DA Connections

Analog Inputs

Source Name Direct DA DA Output Target Input

1

2

3

4

1

2

3

4

1

2

3

4

1

2

3

4

1

2

3

4

1

2

3

4

1

2

3

4

1

2

3

4
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fåíÉêå~ä=oçìíáåÖ=Ô=aáÖáí~ä=fåéìí=`Ü~êí
If you are using internal routing, complete the following Digital Input Chart to map your 
digital input connections, either direct or via DA.  The chart can also be used to specify 
other digital destinations such as Aux device inputs.  Please copy the chart as required for 
additional inputs.  Refer to the “Internal Routing — Sample Digital Input Chart” section 
on page 63 for a sample chart 

Table 3-15. Digital Input Chart — Direct or DA Connections

Digital Inputs

Source Name Direct DA DA Output ScreenPRO-II Input

1

2

3

4

1

2

3

4

1

2

3

4

1

2

3

4

1

2

3

4

1

2

3

4

1

2

3

4

1

2

3

4
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asf=`çååÉÅíáçå=`Ü~êí
Each ScreenPRO-II has two DVI inputs for the Background and DSK (BG/DSK in A and 
BG/DSK in B).  Widescreen backgrounds will typically originate from a multi-head graphics 
card, while single screen backgrounds are typically distributed from one computer through 
a DA or signal splitter.  Use the following chart to map your Background and DSK DVI 
connections.  Refer to the “Widescreen — Sample DVI Connection Chart” section on 
page 60 for a sample chart.    

Table 3-16. Sample DVI Connection Chart

Background DVI Routing

Source
Multi-Head 

Graphics Card Out
DA 

(or Splitter) Connects to: Note

Computer 1 1

2

3

4

Computer 2 1

2

3

4

Computer 3 1

2

3

4

Computer 4 1

2

3

4
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pí~åÇ~êÇ=aÉëíáå~íáçå=`Ü~êí
The ScreenPRO-II Controller enables you to configure up to four standard destinations.  
Use the following chart to map the distribution of each destination, the usage of 
BlendPRO-II if required, and the routing of your additional program and preview outputs.  
Refer to the “Widescreen — Sample Standard Destination Chart” section on page 60 for 
a sample chart.  

Table 3-17. Standard Destination Connection Chart

Standard Destinations

Output Dest Screen BlendPRO-II Channel Notes

ScreenPRO-II #1 Pgm DVI

ScreenPRO-II #1 Pgm Analog 1

ScreenPRO-II #1 Pgm Analog 2

ScreenPRO-II #1 Pvw

ScreenPRO-II #2 Pgm DVI

ScreenPRO-II #2 Pgm Analog 1

ScreenPRO-II #2 Pgm Analog 2

ScreenPRO-II #2 Pvw

ScreenPRO-II #3 Pgm DVI

ScreenPRO-II #3 Pgm Analog 1

ScreenPRO-II #3 Pgm Analog 2

ScreenPRO-II #3 Pvw

ScreenPRO-II #2 Pgm DVI

ScreenPRO-II #2 Pgm Analog 1

ScreenPRO-II #2 Pgm Analog 2

ScreenPRO-II #2 Pvw
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^ìñáäá~êó=aÉëíáå~íáçå=`Ü~êí
The ScreenPRO-II Controller enables you to configure up to four auxiliary destinations.  
Use the following chart to map the distribution of each auxiliary destination:

Table 3-18. Aux Destination Connection Chart

Aux Destinations

Dest Device Inputs from Screen / Device Notes

1

2

3

4
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póëíÉã=fåëí~ää~íáçå
This section provides instructions for installing your ScreenPRO-II Controller system.  If 
required, use the two previous sample system diagrams for reference: 

• Refer to “Figure 3-1” on page 58 for an illustration of a Sample System with 
External Routing.

• Refer to “Figure 3-2” on page 62 for an illustration of a Sample System with 
Internal Routing.

You will need one (or more) of the items listed below:  

Use the following steps to install ScreenPRO-II Controller:

1. Follow the unpacking procedures as listed in the “Unpacking and Inspection” 
section on page 54. 

2. As required, refer to the “Physical and Electrical Specifications” section on 
page 258 in Appendix A for electrical and mechanical details.

3. As required, refer to the “ScreenPRO-II Controller Rear Panel” section on 
page 32 in Chapter 2 for the locations of all connectors.

4. If you are rack mounting peripheral equipment such as the BlendPRO-II and 
MatrixPRO routers, follow the rack mount procedures as outlined in each 
individual User’s Guide.

Table 3-19. Equipment List, ScreenPRO-II Controller System

Qty. Item Note

1 ScreenPRO-II Controller chassis Required

1-4 ScreenPRO-II Required, quantity based on production and screen requirements  

1-4 Video projector Required, quantity based on single or widescreen requirements

1-4 Analog monitor(s) Preview, quantity based on single or widescreen requirements

1-4 Analog or digital monitor(s) Program, quantity based on single or widescreen requirements

1 Ethernet hub or switch Customer supplied

TBD Ethernet cables Customer supplied 

TBD Video cables Customer supplied (Genlock, Genlock Loop, Widescreen Lock)

1 Analog router Required for systems configured for external routing

1 Digital router Required for systems configured for external routing

1 BlendPRO-II Required for systems configured for widescreen blends

TBD Discreet analog sources Required for systems configured for internal routing

TBD Discreet digital sources Required for systems configured for internal routing

TBD PC(s), Mac(s) Required for BG and DSK DVI sources, and discreet RGB sources

TBD DA(s) Required for signal distribution, when internal routing utilized
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5. As required, ensure that your system interconnection charts are handy.  Refer to 
the “Connection Charts” section on page 56 for details on completing the charts.

6. Ethernet Connections — a completely “local” network connection is 
recommended, without IP connections to the outside world. 

a. Using an Ethernet cable, connect the ScreenPRO-II Controller’s 
Ethernet port to a Hub or Switch.

b. Connect all ScreenPRO-II units to the Ethernet Hub or Switch.

c. If your system uses BlendPRO-II, connect the BlendPRO-II chassis to 
the Ethernet Hub or Switch.

d. Connect all routers (such as MatrixPRO) to the Ethernet Hub or Switch.  

7. Serial Connections — the ScreenPRO-II Controller’s serial port is configured as 
DCE, 115K baud, 8 data bits, 1 stop bit, no parity bits.

e. For a single serial controlled router, use an RS-232 cable to connect the 
router to the ScreenPRO-II Controller’s EXT COMM port.  

f. To connect two (or more) serial routers, a third-party Ethernet-to-Serial 
converter box is required, such as the Lantronix model UDS200 Device 
Server  (http://www.lantronix.com/pdf/UDS200_PB.pdf).  Each 
Lantronix UDS200 can control two serial routers.

• Using RS-232 cables, connect each router to the UDS200.
• Set up a static IP address on the Lantronix device itself.  The 

recommended range is 192.168.0.200 - 192.168.0.239 — such 
as not to conflict with other devices.  Refer to the Lantronix 
UDS200 User’s Guide for instructions.

• Using an Ethernet cable, connect the UDS200 to the same LAN 
that includes the ScreenPRO-II Controller.  

8. Source Connections

a. If you are using external routing:
• Ensure that all sources are properly connected to your analog 

and digital routers.
• Connect analog router outputs to analog inputs 1 and 2 on each 

ScreenPRO-II.  These are the default analog router inputs. 
• Connect digital router outputs to SDI inputs 1 and 2 on each 

ScreenPRO-II.   

b. If you are using internal routing:
• As required, connect discreet analog source outputs to the 

desired analog inputs on each ScreenPRO-II.   
• As required, connect discreet digital source outputs to the 

desired digital inputs on each ScreenPRO-II.   
• If analog DAs are utilized (recommended), connect analog 

source outputs to DA inputs, and DA outputs to the desired 
analog inputs on each ScreenPRO-II.  

Note The ScreenPRO-II Controller supports Lantronix models 
UDS100 and UDS200.  In Chapter 4, refer to the “Lantronix 
Setup Menu” section on page 131 for addition information 
about Lantronix setup.    
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• If digital DAs are utilized (recommended), connect digital source 
outputs to DA inputs, and DA outputs to the desired digital 
inputs on each ScreenPRO-II.  

c. For widescreen backgrounds and DSK sources, connect your 
computers’ DVI outputs (typically from multi-head graphics cards) to the 
BG/DSK in A and BG/DSK in B inputs on each ScreenPRO-II.  

d. For single screen backgrounds and DSK sources, connect your 
computers’ DVI outputs (typically from DAs or splitters) to the BG/DSK in 
A and BG/DSK in B inputs on each ScreenPRO-II.  

9. Output Connections 

a. One Analog Preview Output is provided on each ScreenPRO-II.  
Connect this output to the input of each analog Preview Monitor, as 
required per your configuration.  

b. Three Program Outputs are provided on each ScreenPRO-II: one 
digital and two analog.  For each chassis (for single screen applications), 
use these outputs to connect your Program Monitor(s) and your 
projector(s).  For example:

Connect the Digital Program Output to the input of your projector.

Connect Analog Program Output 1 to the input of your main 
program monitor.

Connect Analog Program Output 2 to an auxiliary or spare 
program monitor. 

10. BlendPRO-II Input/Output Connections — for widescreen applications, 
BlendPRO-II requires the following connections:

a. Connect the Digital Program Output on each ScreenPRO-II to the 
desired DVI Input (1 - 4) on BlendPRO-II. 

b. Per your system configuration, connect DVI Outputs (1 - 4) on 
BlendPRO-II to the DVI inputs on your projectors, or connect Analog 
Outputs (1 - 4) on BlendPRO-II to the analog inputs on your projectors.

11. Genlock Connections

For single screen applications, genlock connections are optional:

a. If you will be using synchronous camera sources in your production, use 
a BNC cable to connect a PAL or NTSC black burst (or a composite 
sync) signal to the Genlock In connector on each ScreenPRO-II.

b. If desired, you can loop reference video from one ScreenPRO-II chassis 
to another by connecting a BNC cable from the Genlock Loop 
connector to the next ScreenPRO-II’s Genlock In connector (or to other 
video devices in the chain).  

c. If a particular ScreenPRO-II is the last device in a reference video chain, 
do not make any connections to the Genlock Loop connector.  Refer to 
the “ScreenPRO-II Genlock Termination” section on page 76 for 
details.  

Important For wide screen applications that use BlendPRO-II, specific 
“Widescreen Lock” connections are mandatory.  Refer to the 
“BlendPRO-II Widescreen Lock Connections” section on 
page 77 for instructions.
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12. Power Connection

a. Connect an AC power cord to the AC Power Connector on the rear of 
each ScreenPRO-II chassis, and then to AC outlets. 

b. Connect an AC power cord to the AC Power Connector on the rear of 
the ScreenPRO-II Controller chassis, and then to an AC outlet. 

c. Per your system configuration, connect AC Power cords to MatrixPRO 
routers and BlendPRO-II, and then to AC outlets.

d. Connect AC Power cords (or AC adapters) to all peripheral equipment, 
such as Ethernet Hubs and monitors.  

Please note:

~ Connect each unit only to a properly rated supply circuit. 

~ Reliable grounding of rack-mounted equipment should be maintained.

13. Tally Connection — If you are using the optional Tally board, connect tally “relay 
closure” lines from the ScreenPRO-II Controller’s Tally connector to the desired 
external devices (such as cameras).  Eight tally circuits are provided.  In 
Appendix A, refer to the “Tally Connector” section on page 262 for pinout details

14. Power On — turn on power to all units.

15. System ID — required for use with the ScreenPRO-II Controller.  On each 
ScreenPRO-II chassis: 

a. Access the Remote Control Menu by pressing {REMOTE CONTROL} 
on the Home Menu.  This menu enables you to set the ID of the 
ScreenPRO-II chassis.

b. Set the ScreenPRO-II chassis ID to a unique value that is not used by 
another chassis.  The system will not function if duplicate IDs are in use.   

16. Display Calibration — calibrate the ScreenPRO-II Controller’s Touch Screen 
display using the Display Settings Menu.  From the Home Menu, press 
{DISPLAY} > {LCD CAL}, and following the prompts to calibrate the display.

If you are using BlendPRO-II, please review the “Overview of Edge-Blending 
Technology” section on page 79.   

pÅêÉÉåmolJff=dÉåäçÅâ=qÉêãáå~íáçå
On the rear of each ScreenPRO-II chassis, one recessed Termination Switch is provided 
for genlock termination (adjacent to the Genlock Loop connector).  

• Terminated — when the switch is pushed in, the connection is terminated (75 
Ohms).

• Un-terminated — when the switch is out, the connection is un-terminated.

If a particular ScreenPRO-II chassis is the last device in a reference video chain, ensure 
that the Termination Switch is pushed in.  If a particular ScreenPRO-II chassis is in the 
middle of a reference chain, ensure that the Termination Switch is out. 

Note The ScreenPRO-II Controller will detect duplicate IDs and 
prompt the user to correct the problem.  Only the first device 
will connect to the console.  Other devices with conflicting IDs 
will be refused a connection.
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The figure below illustrates the required Widescreen Lock and Genlock connections for 
any ScreenPRO-II Controller system that uses BlendPRO-II.  Use this figure for reference 
during the signal installation process.  If required, refer to the “BlendPRO-II User’s Guide” 
and the “ScreenPRO-II User’s Guide” for details on specific rear panel connectors.

Figure 3-3.  Required Widescreen Lock Connections  (sample)

For all widescreen systems that utilize BlendPRO-II, use the following steps to connect 
“Widescreen Lock” and “Genlock” signals.

1. External Genlock connections to BlendPRO-II are optional.  

a. If desired (particularly if you will be using synchronous cameras), use a 
BNC cable to connect a PAL or NTSC black burst (or a composite sync) 
signal to the GENLOCK IN connector on BlendPRO-II.

b. Do not connect an external Genlock signal to any ScreenPRO-II unit in 
your system.

2. Widescreen Lock connections are mandatory:

a. Connect a BNC cable from BlendPRO-II’s WIDESCREEN LOCK output 
to the GENLOCK IN connector on the ScreenPRO-II unit with the lowest 
numbered ID.  
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b. Connect the first ScreenPRO-II’s GENLOCK LOOP connector to the 
GENLOCK IN connector on the ScreenPRO-II unit with the next highest 
numbered ID.

c. (If your system includes three ScreenPRO-IIs) — Connect the second 
ScreenPRO-II’s GENLOCK LOOP connector to the GENLOCK IN 
connector on the ScreenPRO-II with the next highest numbered ID.

d. (If your system includes four ScreenPRO-IIs) — Connect the third 
ScreenPRO-II’s GENLOCK LOOP connector to the GENLOCK IN 
connector on the ScreenPRO-II unit with the highest numbered ID.

e. Set the Termination Switch for all ScreenPRO-IIs in your system:
• For all ScreenPRO-IIs except the last one in the chain, ensure 

that the ScreenPRO-II is un-terminated (HI-Z).  Refer to the 
“ScreenPRO-II Genlock Termination” section on page 76 for 
details.

• On the last unit in the chain (only), ensure that the 
ScreenPRO-II is terminated (75-OHM).
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The following topics are discussed in this section:

• Introduction to Edge Blending

• Content Creation

• Video Processing

• Projector Setup and System Adjustments

• Left Justified Configurations

• Center Justified Configurations

fåíêçÇìÅíáçå=íç=bÇÖÉ=_äÉåÇáåÖ
Edge-blending technology is becoming increasingly popular for supporting very large high-
resolution displays. The technology is very flexible and supports a wide range of screen 
configurations.  A typical three projector system is illustrated below.  

As shown, multiple projectors are used to project on a common surface in order to create 
one high-resolution image.  The creation of a seamless image requires careful attention to 
detail.  High quality results depend upon a system-level approach that integrates content 
creation, video processing, projector setup and system adjustments as described below. 

Figure 3-4.  Typical three projector system

`çåíÉåí=`êÉ~íáçå=
When projecting an image across a large screen, it is important to maintain sufficient 
resolution to obtain a crisp, clear image from the perspective of the viewer.  Generally, high-
resolution source material is used to maintain content that is pleasing to the eye.  There are 
two methods that are commonly used to generate wide-screen source material, each of 
these methods is explained below.  

• Use of a Single High Definition Image 

High Definition source material has a resolution of 1920 pixels x 1080 lines. 
Images of this type can be reformatted to drive multiple screens.  The reformatting 

Projector #3
Output

Projector #1
Output

Projector #2
Output

Adjustable
Image Overlap
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is usually performed by a seamless switching system such as the Encore Video 
Processor, or BlendPRO-II.  

Reformatting allows the resultant images to provide seamless switching, 
integration of picture-in-picture (PIP) video and keying features.  Note that the 
input image can be effectively spread to cover multiple screens, however, the 
inherent resolution of the output image remains that of the source material, 
1920x1080 pixels.

Figure 3-5.  HD Source Material Formatting

• Use Of Multi-Head Graphics Boards 

Standard multi-head graphics boards can be used to directly generate image data 
to drive multiple screens. In this case, the computer generates one very high-
resolution image and the image is output by multiple graphics heads.  The 
inherent resolution of the output image is limited only by the processing power of 
the multi-head graphics board. Image resolutions with up to 10,000 pixels of 
horizontal resolution can be achieved with current technology.
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The purpose of the edge-blending process is to provide a smooth transition for the eye over 
the blending region.  To provide a smooth transition, identical image data from two (or 
more) different projectors must be superimposed, and the output from each projector must 
be edge feathered to provide seamless optical mixing of the two source images.  

There are two video processing functions that are required specifically to support wide-
screen edge blended displays:  Image Overlap and Edge Feathering.

• Image Overlap

Source images consist of a single HD image that has been split into multiple 
channels, or a series of images from a multi-head graphics card.  In either case, 
the source images must be re-formatted to provide image overlap to support the 
edge-blending process. The Image Overlap processing is illustrated below. The 
width of the blending region determines the amount of required image overlap and 
this must be programmable to support different applications.  

Figure 3-6.  Image Overlap and Data Doubling
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• Edge Feathering

The overlapping image data in the blend region must be edge-feathered to 
support a seamless optical blend. The transfer function must be programmable to 
support blend regions of different widths and adjust to different video 
characteristics. A typical blend function is illustrated below.

Figure 3-7.  Typical Blend Function

mêçàÉÅíçê=pÉíìé=~åÇ=póëíÉã=^ÇàìëíãÉåíë
Accurate projector setup is essential for creating seamless images.  Please note the 
following important guidelines:

• The projectors must be precisely aligned to overlap the adjacent blending regions.

• The brightness, contrast and color balance of the projectors must be adjusted to 
provide a uniform appearance across the entire screen.  

• Custom test patterns and an alignment procedure are used to simplify this 
process and provide an optimal result. 

• Mixing and matching projectors is not recommended as it makes the adjustment 
process much more difficult.

Blend Region

Image Intensity
for Image 1

Image Intensity
for Image 2
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Left justification means that the first pixels of the projected image begin immediately at the 
left, and that unused source material is removed from the far right of the image.  A two-
projector sample is illustrated below.

Figure 3-8.  Left Justification

`ÉåíÉê=gìëíáÑáÉÇ=`çåÑáÖìê~íáçåë
Center justification means that the projected image is properly centered within the available 
number of pixels, and that unused source material is removed from the far left and far right 
of the image.  A two-projector sample is illustrated below.

Figure 3-9.  Center Justification

This completes the hardware installation chapter.  Please continue with Chapter 4, “Menu 
Orientation.” 
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få=qÜáë=`Ü~éíÉê
This chapter describes all ScreenPRO-II Controller menus, including how they are 
accessed, the functions that are available, and descriptions of each menu tree (in block 
diagram format).  

The following topics are discussed:

• Global Rules

• Home Menu

• Input Menu

• Output Menu

• System Menu

• Miscellaneous Menu

• Frame Grab Menu

• Effects Menu

• Status Menu

• PIP Adjustment Menu

• Key Menu

• Clone Setup Menu

• Crop Menu

• Source Adjustment Menus

• Background Input Setup Menu

• DSK Menus

• LOGO Menu 

Note In this chapter, softkey labels on the menus are shown in bold 
upper and lowercase letters between brackets.

Press {BORDR} to …

Note Once you have reviewed all of the sections in this chapter, 
please continue with Chapter 5, “System Setup” on 
page 183.
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The following global rules apply to all menus:

• Brackets — parameters and values displayed between brackets (e.g., [525]) 
cannot be changed.

• ID “All” — For widescreen destinations, when the value “All” is shown for the ID 
parameter, it represents the lowest numbered ID in the destination, as configured 
(typically, number 1).  

• Exclamation Points — For widescreen destinations, if an exclamation point ( ! ) 
appears after a value (e.g., Contrast 100!), one (or more) of the destinations is 
not set to 100.  

• “All” Adjustments — For widescreen destinations, if a parameter is adjusted on 
a menu displaying an “All” ID condition, all values for all ScreenPRO-II’s in the 
destination will snap to the new value.  To adjust an individual ScreenPRO-II’s 
values within the widescreen configuration, highlight the ID line, use the ADJ knob 
to select a specific destination, and then adjust a parameter in the normal manner.

• Press {HOME} to return to the Home Menu.  

• Press {BACK} to return to the menu from which you accessed the current menu.  

Note The {HOME} and {BACK} buttons will not be explained again 
in this chapter.
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The figure below illustrates the Home Menu:

Figure 4-1.  Home Menu

The Home Menu is the system’s top level menu.  To access a menu, press the desired 
button on the Touch Screen.  You can also return to the Home Menu by pressing the 
{HOME} softkey at the top left of the Touch Screen (on most menus).  

The following menus can be accessed from the Home Menu: 

• Press INPUT to access the Input Menu.  Refer to the “Input Menu” section on 
page 88 for details.

• Press OUTPUT to access the Output Menu.  Refer to the “Output Menu” section 
on page 100 for details.

• Press SYSTEM to access the System Menu.  Refer to the “System Menu” 
section on page 108 for details.

• Press MISC to access the Miscellaneous Menu.  Refer to the “Miscellaneous 
Menu” section on page 133 for details.

• Press FRAME GRAB to access the Frame Grab Menu.  Refer to the “Frame 
Grab Menu” section on page 142 for details.

• Press EFFECTS to access the Effects Menu.  Refer to the “Effects Menu” 
section on page 146 for details.

• Press STATUS to access the Status Menu.  Refer to the “Status Menu” section 
on page 147 for details.

• Press SAVE to save the system configuration in non-volatile memory.
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The following topics are discussed in this section:

• Input Menu Tree

• Input Menu Description

• Input Menu Functions

• Input Sub Menus

fåéìí=jÉåì=qêÉÉ
The figure below illustrates the Input Menu Tree:

Figure 4-2.  Input Menu Tree

All functions and sub menus are discussed in the following sections. 
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The figure below illustrates the Input Menu:

Figure 4-3.  Input Menu  (sample)

The Input Menu is used to adjust all parameters relating to dedicated and routed inputs, 
including the physical sources connected to individual ScreenPRO-II units.  The menu 
enables you to set all configuration options for the selected input.  

To access the menu:

• Press a blue layer button in the Layer Control Section (the button blinks).

• Select an input on the Source Selection Bus (the button blinks).

• Press INPUT on the Home Menu.  

The currently selected input appears in the menu’s upper right corner.  The menu tracks the 
selected input, thus, if you switch inputs on the Source Selection Bus, the menu is 
immediately re-assigned to the new input.  
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Note The menu cannot be accessed without a selected layer.  An 
error message will be shown.

Important From a conceptual standpoint, there are no “direct” 
connections to a ScreenPRO-II scaler.  All connections, 
whether they are from a single source or an external router, 
connect to the internal router matrix of each ScreenPRO-II.
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The following Input Menu functions are provided:

• Destination — indicates the destination on which you are currently working (as 
selected on the Destination Bus).    

• ID — indicates the ID of the associated ScreenPRO-II.  

~ If “All” is shown in a widescreen configuration, menu values represent 
those of the lowest numbered ID in the destination.  When a parameter is 
adjusted, all values for all ScreenPRO-II’s in the destination will snap to 
the new value. 

~ If an individual ID is shown (e.g., 2), it represents that ScreenPRO-II 
alone, and adjustments will only affect that unit.

• Layer — for widescreen destinations, indicates the layer on which you are 
adjusting the selected input.     

• Input Connector — selects the physical connector to which the input is 
connected on the ScreenPRO-II, either HD-15 or BNC.  

• Format — this line performs two functions:

~ Displays the resolution that is automatically determined by the FORCE 
ACQUIRE function. 

~ Enables you to set the resolution of the incoming source if desired.  Once 
the format is selected manually, press {APPLY FORMAT} to accept the 
selection.  

In Appendix A, refer to the “ScreenPRO-II Input and Output Resolutions” 
section on page 263 for details on all available resolutions.  

Note The ID line only appears when a widescreen destination is 
selected. 

Important In a widescreen configuration, because the electronics on 
individual ScreenPRO-II scalers may not match from unit to 
unit, you may be required to adjust ScreenPRO-II scalers and 
layers individually — by first selecting a specific destination 
ID, followed by a specific layer. 

Note The choice of available formats varies depending on the 
selected connector.  For example, when BNC is selected, 
only Standard Definition and High Definition resolutions 
can be selected.

Note Selecting a format manually automatically defaults the Input 
Type and Color Space.  In some cases, the Input Type 
and Color Space cannot be changed due to the selected 
resolution. 
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• Input Type — sets the type of input connected to the ScreenPRO-II.  Available 
choices change depending on the selected Format, and the choice affects the 
Color Space selection.  Input types include: 

~ RGB

~ YPbPr

~ Composite/S-Vid

~ HD SDI

~ SDI
• Color Space — sets the input’s color space, either SMPTE or RGB.  The system 

automatically sets the Color Space based on the selected Format and/or Input 
Connector and Input Type — but in some cases, color space can be changed.

• Sampling Mode — sets the sampling mode for the selected input.  

~ When 1:1 Sampling is selected, the system provides pixel-for-pixel 
sampling, and generally better image quality.  

~ When Oversample is selected, the system performs multiple samples 
for every pixel, with a resulting “softer” image.

• Contrast — sets the input’s contrast.  Adjustment range: 75% to 125%.

• Brightness — sets the input’s brightness.  Adjustment range: 75% to 125%.

• Gamma — sets the input gamma, enabling you to match the gamma of the 
source.  Adjustment range: 1.0 to 3.0.

• Input Sync Type — sets the type of sync used by the selected source.  Choices 
include:

~ H/V

~ CSync (composite sync)

~ SOG (sync on green)

~ Auto

• Pulldown Compensation — (On/Off)  This function is applicable only for 
standard video (component, s-video, composite) inputs.  The default mode is off.  
The feature should be turned on to process video derived from film material. 

• Sync Slice <mv> — This function selects the sync comparator threshold for 
RGsB (RGB with Sync on Green) or YPbPr analog component video sources.  
The value ranges from 20mV to 280mV and is adjustable in steps of 10mV.  The 
default value is 160mV.  

When the ScreenPRO-II Controller detects Macrovision® copy protection on the 
incoming YPbPr NTSC/PAL video, the Sync Slice value is repositioned to 60mV to 
account for the reduced amplitude sync pulse.

• Sharpness — sets the input’s sharpness.  Adjustment range: -10 (very smooth) to 
10 (very sharp). 

Note The default Sync Slice level has been optimized for virtually 
all sources that will be encountered and should rarely, if ever, 
require adjustment.  However, you can adjust the level to 
improve sync detection and synchronization in cases of 
extremely noisy RGsB or YPbPr video signals.
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• Press {CFG} to display the Input Configuration Menu.  Refer to the “Input 
Configuration Menu” section on page 93 for details.

• Press {AR} to display the Aspect Ratio Menu.  Refer to the “Aspect Ratio Menu” 
section on page 94 for details.

• Press {SAVE} to save the selected input in the designated input file, using all 
current information on the Input Menu.  Using an automatic “copy down” function, 
the saved file will also be transferred to all active destinations.  

• Press {APPLY FORMAT} to apply a manually selected input format.  In 
Appendix A, refer to the “ScreenPRO-II Input and Output Resolutions“section 
on page 263 for details on all available resolutions.

• Press {SIZING} to display the Sizing Menu.  Refer to the “Sizing Menu” section 
on page 95 for details.

• Press {COLOR BALANCE} to display the Color Balance Menu.  Refer to the 
“Color Balance Menu” section on page 98 for details.

• Press {FORCE ACQUIRE} to force the system to perform the optimum image 
setup.  Use this feature as a good starting point for setup.    

fåéìí=pìÄ=jÉåìë
The following sub menus can be accessed from the Input Menu:

• Input Configuration Menu

• Aspect Ratio Menu

• Sizing Menu

• Color Balance Menu

Note Every sub menu under the Input Menu includes a {SAVE} 
button.  This enables you to save the input at any point in the 
adjustment process, regardless of your location within the 
menu tree.  

Note FORCE ACQUIRE only works on the selected input 
connector.  Be sure to select the correct connector type 
before issuing the FORCE ACQUIRE command.
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From the Input Menu, press {CFG} to display the Input Configuration Menu.

Figure 4-4.  Input Configuration Menu  (sample)

Each input has an associated file that stores all input parameters and settings.  Each time 
an input is selected on the Source Selection Bus, its associated file is recalled the instant 
before it appears on Preview. 

The Input Configuration Menu enables you to save or delete the input’s associated file — 
which guarantees that the exact parameters you set are those that are used on air. 

The following functions are provided:

• File Number — sets the file number into which data is stored.  In the current 
version, the file number defaults to the input number and cannot be changed. 

• File Name — sets the alphanumeric file name.  In the current version, the file 
name automatically defaults to the input name and cannot be changed. 

• Delete Applies To — because inputs may be set up differently depending upon 
the destination, this parameter enables you to identify the destination from which 
you want to delete the associated file.  

• Press {SAVE} to save the selected input in the designated input file.  

• Press {DELETE} to delete the selected input file from the designated destination.  

File Name IFILE_001
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INPUT CONFIGURATION SRC_1

SAVE DELETE

File Number 1

Delete Applies To: Dest 1

Note If multiple destinations are selected (for example, when you 
are using two single-screen configurations), pressing {SAVE} 
copies input parameters to both destinations, eliminating the 
need to configure and save each input twice.
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From the Input Menu, press {ASPECT RATIO} to display the Aspect Ratio Menu.

Figure 4-5.  Aspect Ratio Menu  (sample)

The Aspect Ratio Menu enables you to change the input’s aspect ratio to pre-defined 
configurations, or enter a “custom” configuration if desired.  

• Mode — select 16:9, 5:4, 4:3, 3:2, 1:1 or Custom aspect ratios.

• Ratio — when Custom is selected, use the knob to enter a custom aspect ratio.  
The field is hidden when pre-defined ratios are selected.
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From the Input Menu, press {SIZING} to display one of two “context sensitive” Sizing 
Menus — they change depending on the selected Sampling Mode. 

• If 1:1 Sampling is selected, the 1:1 Sizing Menu appears.

• If Oversample is selected, the Oversample Sizing Menu appears.

Each menu and function is described below.  

NWN=páòáåÖ=jÉåì

The figure below illustrates the 1:1 Sizing Menu.  All functions apply to the selected 
source.  

Figure 4-6.  1:1 Sizing Menu   (sample)

With 1:1 Sampling enabled, the following timing parameters allow you to adjust the image 
to properly fit the layer’s blinking raster box.

• ID — indicates the ID of the associated ScreenPRO-II.  

~ If “All” is shown in a widescreen configuration, menu values represent 
those of the lowest numbered ID in the destination.  When a parameter is 
adjusted, all values for all ScreenPRO-II’s in the destination will snap to 
the new value. 

~ If an individual ID is shown (e.g., 2), it represents that ScreenPRO-II 
alone, and adjustments will only affect that unit.

H Active

H Position

V Total

H Total

V Active

V Position

[ 858 ]

720

[ 0 ]

486
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1:1 SIZING SRC_1

ID ALL

123

S
A
V
E

FORCE
ACQUIRE

Clock Phase 0

Layer [ A ]

Note The ID line only appears when a widescreen destination is 
selected. 
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• Layer — for widescreen destinations, indicates the layer on which you are 
adjusting the selected input.     

• Clock Phase — sets the system’s A/D converter, allowing you to select where 
pixels are sampled (ideally, on the pixel’s peak).  Adjustment range: -16 to 15.  For 
optimum visual results when adjusting high-resolution sources, project a burst test 
pattern and adjust the sampling for minimum noise.  Refer to the “Test Pattern 
Menu” section on page 105 for information on test patterns. 

• H Total — for the selected source, sets the total pixel count per line.  

• H Active — sets the width of the active area.

• H Position — sets the start of the active area’s horizontal offset from H sync.

• V Total — fixed value which cannot be adjusted.

• V Active — sets the number of vertical lines in the image.  

• V Position — sets the start of the active area’s vertical offset from V sync.

• Press {SAVE} to save the selected input in the designated input file.  

• Press {FORCE ACQUIRE} to force the ScreenPRO-II Controller to perform the 
optimum image setup.    

Important In a widescreen configuration, because the electronics on 
individual ScreenPRO-II scalers may not match from unit to 
unit, you may be required to adjust ScreenPRO-II scalers and 
layers individually — by first selecting a specific destination 
ID, followed by a specific layer. 

Note This field is not adjustable for digital sources, including digital 
signals on the DVI and BNC input connectors.  This field is 
not adjustable for NTSC and PAL sources, regardless of 
connection type.

Note If you switch to another input and there is no valid input video, 
the settings are not applicable and N/A is displayed.
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The figure below illustrates the Oversample Sizing Menu.  All functions apply to the 
selected source.

Figure 4-7.  Oversample Sizing Menu  (sample)

With Oversample enabled, the following timing parameters allow you to adjust the image 
to properly fit the layer’s blinking raster box.

• ID — indicates the ID of the associated ScreenPRO-II.  

~ If “All” is shown in a widescreen configuration, menu values represent 
those of the lowest numbered ID in the destination.  When a parameter is 
adjusted, all values for all ScreenPRO-II’s in the destination will snap to 
the new value. 

~ If an individual ID is shown (e.g., 2), it represents that ScreenPRO-II 
alone, and adjustments will only affect that unit.

• Layer — for widescreen destinations, indicates the layer on which you are 
adjusting the selected input.     

• Select and adjust Right Edge, Left Edge, Top Edge or Bottom Edge as 
required, to fit the image precisely in the layer’s blinking raster box.

• Press {SAVE} to save the selected input in the designated input file.  
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Right Edge 1320

Note The ID line only appears when a widescreen destination is 
selected. 

Important In a widescreen configuration, because the electronics on 
individual ScreenPRO-II scalers may not match from unit to 
unit, you may be required to adjust ScreenPRO-II scalers and 
layers individually — by first selecting a specific destination 
ID, followed by a specific layer. 
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• Press {FORCE ACQUIRE} to force the system to perform the optimum image 
setup.  After the Force Acquire function is performed, the system remains on the 
Oversample Sizing Menu.  

`çäçê=_~ä~åÅÉ=jÉåì
From the Input Menu, press {COLOR BALANCE} to display the Color Balance Menu.  

Figure 4-8.  Color Balance Menu  (sample — for Composite, S-Video or YPbPr sources)

Figure 4-9.  Color Balance Menu  (sample — for RGB sources)

Note If you switch to another input and there is no valid input video, 
the settings are not applicable and N/A is displayed.
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Grn Brightness < % > 0.0

Grn Contrast < % > 0.0

Blue Brightness < % > 0.0

Blue Contrast < % > 0.0
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The Color Balance Menu changes depending on the selected Input Type.

• ID — indicates the ID of the associated ScreenPRO-II.  

~ If “All” is shown in a widescreen configuration, menu values represent 
those of the lowest numbered ID in the destination.  When a parameter is 
adjusted, all values for all ScreenPRO-II’s in the destination will snap to 
the new value. 

~ If an individual ID is shown (e.g., 2), it represents that ScreenPRO-II 
alone, and adjustments will only affect that unit.

• Layer — for widescreen destinations, indicates the layer on which you are 
adjusting the selected input.     

• When RGB sources are selected, the Color Balance Menu provides individual 
RGB contrast and brightness adjustments.  Adjustment range: -25% to +25%.

~ Adjust Red Contrast and Brightness as required.

~ Adjust Green Contrast and Brightness as required.

~ Adjust Blue Contrast and Brightness as required.

• When Composite, S-Video or YPbPr is selected, adjust Saturation and Hue: 

~ Adjust Saturation as required.  Adjustment range: 75% to 125%.

~ Adjust Hue as required.  Adjustment range (in degrees): -90.0 to 90.0.  

• Press {SAVE} to save the selected input in the designated input file.  

• Press {RESET ALL} to return all parameters to 0 (zero).

Note The ID line only appears when a widescreen destination is 
selected. 

Important In a widescreen configuration, because the electronics on 
individual ScreenPRO-II scalers may not match from unit to 
unit, you may be required to adjust ScreenPRO-II scalers and 
layers individually — by first selecting a specific destination 
ID, followed by a specific layer. 

Note When the Input Type is YPbPr, the Hue field reads N/A 
because Hue does not apply to this type of source.
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The following topics are discussed in this section:

• Output Menu Tree

• Output Menu Description

• Output Menu Functions

• Output Sub Menus

lìíéìí=jÉåì=qêÉÉ
The figure below illustrates the Output Menu Tree:

Figure 4-10.  Output Menu Tree

All functions and sub menus are discussed in the following sections. 
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The figure below illustrates the Output Menu:

Figure 4-11.  Output Menu  (sample)

The Output Menu enables you to configure ScreenPRO-II outputs, wide screen 
parameters and test patterns.  

To access the menu:

• Select a destination on the Destination Bus.

• Press OUTPUT on the Home Menu.

The menu cannot be accessed unless a destination is selected.  The currently selected 
destination is shown in the menu’s upper right corner.  The menu tracks the destination, 
thus, if you switch destinations, the menu is immediately re-assigned.
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The following Output Menu functions are provided:

• Destination — indicates the destination on which you are currently working (as 
selected on the Destination Bus).    

• Format — sets the resolution and frame rate at which you want to drive the 
destination’s projector(s).  To minimize synchronization problems, select a frame 
rate that is consistent with your input sources.

Example:  If you are using 59.94 NTSC video inputs, run the output at the 
same rate in order to reduce jutter artifacts.  

After selecting a format, press {APPLY FORMAT} to accept the selection.  In 
Appendix A, refer to the “ScreenPRO-II Input and Output Resolutions” section 
on page 263 for details on all available resolutions.

• Color Space — displays the output color space per the specifics of the selected 
output resolution and frame rate.

• Press {GLCK} to display the Genlock Menu.  Refer to the “Genlock Menu” 
section on page 103 for details.

• Press {APPLY FORMAT} to accept a selected output format.  In Appendix A, refer 
to the “ScreenPRO-II Input and Output Resolutions” section on page 263 for 
details on all available resolutions.

• Press {SETTINGS} to display the Settings Menu.  Refer to the “Settings Menu” 
section on page 104 for details.

• Press {TEST PATTERN} to display the Test Pattern Menu.  Refer to the “Test 
Pattern Menu” section on page 105 for details.

• Press {WIDE SCREEN} to display the Wide Screen Menu.  Refer to the “Wide 
Screen Settings Menu” section on page 106 for details.  

lìíéìí=pìÄ=jÉåìë
The following sub menus can be accessed from the Output Menu:

• Genlock Menu

• Settings Menu

• Test Pattern Menu

• Wide Screen Settings Menu

Note The selected destination can be configured as a single 
screen or multiple screens (in a wide screen application).  In 
this situation, all changes to the Output Menu affect all 
ScreenPRO-II units in the wide screen definition.

Note This softkey only appears when a wide screen destination is 
selected.  
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From the Output Menu, press {GLCK} to display the Genlock Menu.

Figure 4-12.  Genlock Menu  (sample)

The Genlock Menu changes depending on the type of destination selected — widescreen 
or single screen.  Please note:

• For single screen destinations, the menu tells the ScreenPRO-II Controller 
which type of analog genlock signal is connected to each ScreenPRO-II’s 
Genlock BNC connector, and indicates the current setting of the selected 
ScreenPRO-II’s Termination Switch.

• For widescreen destinations, the menu tells the ScreenPRO-II Controller which 
type of analog genlock signal is connected to BlendPRO-II’s Genlock connector.  
Remember that in this mode, each ScreenPRO-II’s Genlock In connector must 
be connected to BlendPRO-II’s Widescreen Lock output — and not to an 
external Genlock source.  In Chapter 3, refer to the “BlendPRO-II Widescreen 
Lock Connections” section on page 77 for details.   

The following functions are provided:

• Source — (applies to all types of destinations).  This function sets the genlock 
source, either Black Burst, CSync or None.

• Type — (applies to all types of destinations).  Displays the type of genlock:  

~ When Source = None, Type = [Free-Run]

~ When Source = Black Burst, Type = [V Lock]

~ When Source = CSync, Type = [V Lock]

• Termination — (applies to single screen destinations only).  This field indicates 
the current setting of the selected ScreenPRO-II’s Termination Switch.  

Please note:

• If you elect to use external Genlock for single or widescreen configurations, PAL 
or NTSC black burst or composite sync signals are recommended.

• In widescreen mode, you can optionally connect external Genlock to BlendPRO-
II’s Genlock In connector — but not to the individual ScreenPRO-II units.   

Type
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GENLOCK

Source Black Burst

[ V Lock ]

Termination [ 75 Ohm ]

To change termination between

75 Ohm and Hi-Z, press the 

switch on the rear panel

next to the Genlock Loop BNC.
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• In widescreen configurations, BlendPRO-II is the master — whether or not you 
are using an external Genlock signal.

• Genlock is recommended in configurations that utilize video camera sources. 

pÉííáåÖë=jÉåì
From the Output Menu, press {SETTINGS} to display the Settings Menu. 

Figure 4-13.  Settings Menu  (sample)

The Settings Menu enables you to set sync parameters for the monitors and projectors 
connected to the system — for the destination selected on the Output Menu.  

• Output Monitor — selects the device(s) that are affected by the sync settings.  
Choose between:

~ All — adjustments affect all program and preview monitors/projectors.

~ Preview — adjustments affect preview monitors only.

~ SPII Program — adjustments affect only the monitors/projectors 
connected to ScreenPRO-II program outputs.

~ BPII Program — adjustments affect only the monitors/projectors 
connected to BlendPRO-II program outputs.  

• Sync Out — sets the sync value.  Select +H+V, -H-V, +H-V, -H+V or CSync. 

• SOG — selects a specific “sync on green” signal.  Choose between Off, Standard 
or Tri-Level (for certain HD devices).  

• Gamma — sets the output gamma for the selected destination. 

• Raster Box Size — sets the size of the raster box that appears around PIPs and 
Keys.  Range (in pixels):  0 to 8.
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Output Monitor All

-H-V

Gamma 1.0

Raster Box Size 1

Note Individual settings are maintained for each selection in the 
Output Monitor list.
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From the Output Menu, press {TEST PATTERN} to display the Test Pattern Menu.

Figure 4-14.  Test Pattern Menu  (sample)

The Test Pattern Menu enables you to display a variety of test patterns, for system and 
projector alignment — for the destination selected on the Output Menu. 

• Output Monitor — selects the monitor(s) and projector(s) that are affected by the 
test pattern settings.  Choose between:

~ All — adjustments affect all program and preview monitors/projectors.

~ Preview — adjustments affect preview monitors only.

~ SPII Program — adjustments affect only the monitors/projectors 
connected to ScreenPRO-II program outputs.  With this selection, test 
patterns will be data-doubled and edge-feathered.

~ BPII Program — adjustments affect only the monitors/projectors 
connected to BlendPRO-II program outputs.  With this selection, test 
patterns will not be data-doubled and edge-feathered.

• Mode — enables you to turn test patterns on or off.

• Type — sets the test pattern.  Choose between Off, H Ramp, V Ramp, 100% 
Color Bars, 16x16 Grid, 32x32 Grid, Burst, 75% Color Bars, 50% Gray, Gray 
Steps 1, Gray Steps 2, White, Black, Red, Green and Blue.

• Raster Box — displays a raster box defined by the exact outer edges of the 
selected output resolution.  For example, if the output is set to 1024 x 768, the 
raster box will encapsulate that exact format.  Please note:

~ The Burst test pattern is the only pattern that is smaller than the selected 
output resolution.  When the Raster Box is enabled, the Burst pattern 
will appear within its boundaries.  

~ The Raster Box can be enabled when the test pattern is Off.
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• Alignment Test Pattern — for convenience, this function enables you to turn the 
alignment test pattern on or off from this menu (in addition to the Wide Screen 
Settings Menu).  

táÇÉ=pÅêÉÉå=pÉííáåÖë=jÉåì
From the Output Menu, press {WIDE SCREEN} to display the Wide Screen Settings 
Menu. 

Figure 4-15.  Wide Screen Settings Menu  (sample)

The Wide Screen Settings Menu provides the tools required for wide screen setup and 
adjustment.  Note that this menu can only be accessed when the destination selected in the 
Output Menu is designated as wide screen.  Refer to the “Destination Setup Menu” 
section on page 117 for details. 

The following functions are provided on the Wide Screen Settings Menu.

• Total Projectors — indicates the total number of ScreenPRO-II systems that 
have been assigned to the wide screen destination.  This field is for information 
only, as derived from the Destination Setup Menu.

Note This field only appears when a wide screen destination is 
selected.   
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WIDE SCREEN SETTINGS

Total Projectors [ 2 ]

2048

Total V Res [ 768 ]

Background Format Edge-Butted

Marker Mode Off

Overlap Width 0

Alignment Test Pattern Off

Data Doubling Off

Justification Center

Important As an important prerequisite to widescreen setup (and to 
make widescreen setup easy), Barco offers the Configurator 
application to assist with wide screen setup.  The software is 
available via download from the website, or you can contact 
Barco Technical Support for details.  In Appendix B, refer to 
the “Contact Information” section on page 268 for 
information.  
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• Total H Res — sets the total number of horizontal pixels in the overall wide screen 
display.  The formula is:

# screens * horizontal output resolution - 
(overlap width * (# screens - 1))

Example:  If two screens are used, each with an output resolution of 1024 x 
768 and an overlap of 200 pixels, the Total H Res is: 

2 * 1024 - (200 * 1) = 1848

As you adjust the Total H Res, the Overlap Width value tracks and the wide 
screen markers adjust accordingly.  

• Total V Res — displays the vertical resolution of the wide screen configuration.  
This field is fixed. 

• Background Format — selects the method by which your background graphics 
were originally produced:

~ Edge-butted — choose this option if your background graphics were 
produced with no pre-data doubling (e.g., typically from a multi-head 
graphics card).

~ Overlapped — choose this option if your backgrounds were produced 
using pre-data doubling (e.g., such as from a Dataton® system).

• Marker Mode — enables and disables the system’s wide screen markers, to 
show the boundaries of active data.  In Chapter 6, refer to the “Wide Screen 
Markers” section on page 218 for details.

• Overlap Width — sets the overlap (in pixels) between projectors.  As you adjust 
the width, the Total H Res value tracks and the wide screen markers adjust 
accordingly.  

• Alignment Test Pattern — enables or disables the test pattern used for 
performing projector lens shift and registration adjustments.

• Data Doubling — enables or disables data doubling.  Typically, the function is 
only disabled when unscaled background sources are pre-data doubled.  In 
Chapter 3, refer to the “Overview of Edge-Blending Technology” section on 
page 79 for details.

• Justification — sets the desired wide screen justification, either Center or Left.  
Once set, wide screen markers adjust accordingly.  

In the Feathering section: 

• Mode — enables or disables edge feathering.  

• Gamma — sets gamma for the feathered regions.  Adjustment range:  1.0 to 5.0.
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The following topics are discussed in this section:

• System Menu Tree

• System Menu Description

• System Sub Menus

póëíÉã=jÉåì=qêÉÉ
The figure below illustrates the System Menu Tree:

Figure 4-16.  System Menu Tree

All functions and sub menus are discussed in the following sections.   
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The figure below illustrates a sample System Menu:

Figure 4-17.  System Menu  (sample)

To access the menu:

• Press SYSTEM on the Home Menu.

The System Menu provides the following functions:

• Modify Layers On Program — when enabled, you can change PIPs and Keys 
directly on Program, without first setting up your “look” on Preview.  When 
disabled, Preview must be used to set up the next look.  In Chapter 6, refer to the 
“Working with Still Frames” section on page 246 for details.

• Tally Mode — enables or disables the tally function.  When enabled, all eight 
tallies are activated, and can be triggered by pressing a source button.  When 
disabled, all tallies are deactivated (but tally setups remain as configured).   

~ Refer to the “Input Source Patch Menu” section on page 125 for details 
on assigning tallies to sources. 

~ In Chapter 6, refer to the “Working with Tallies” section on page 253 for 
tally operating instructions.

• Press {RESET} to display the System Reset Menu.  Refer to the “System Reset 
Menu” section on page 111 for details. 

• Press {SW VER} to display the Software Version Menu.  Refer to the “Software 
Version Menu” section on page 112 for details.

• Press {DIAG} to display the Diagnostics Setup Menu.  Refer to the 
“Diagnostics Setup Menu” section on page 113 for details.

• Press {DEST SETUP} to display the Destination Setup Menu.  Refer to the 
“Destination Setup Menu” section on page 117 for details.

• Press {NETWORK SETUP} to display the Network Setup Menu.  Refer to the 
“Network Setup Menu” section on page 124 for details.
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• Press {INPUT PATCH} to display the Input Source Patch Menu.  Refer to the 
“Input Source Patch Menu” section on page 125 for details.

• Press {ROUTER SETUP} to display the Router Specification Menu.  Refer to 
the “Router Specification Menu” section on page 127 for details.

póëíÉã=pìÄ=jÉåìë
The following sub menus can be accessed from the System Menu:

• System Reset Menu

• Software Version Menu

• Diagnostics Setup Menu

• Destination Setup Menu

• Network Setup Menu

• Input Source Patch Menu

• Router Specification Menu
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From the System Menu, press {RESET} to display the System Reset Menu:

Figure 4-18.  System Reset Menu  (sample)

The System Reset Menu enables you to perform various system reset functions.  The 
following functions are provided:  

• Device — selects which device(s) to reset.  Choose between ALL, 
CONTROLLER, SP, or BP. 

• Reset Option — for the selected device(s), chooses the specific subset that you 
wish to reset.  Choose between All Detected SPs or Active Dests. 

• Reset Type — selects the type of reset that you wish to perform. Choose between 
SOFT or FACTORY.   Note that selecting SOFT will not delete any user defined 
configurations, while FACTORY deletes all user configurations.

• Press {RESET} to perform the selected reset operation.  When the confirmation 
screen appears:

~ Press {YES} to start the reset procedure.  An “In Progress” message will 
be displayed. 

~ Press {NO} to cancel the procedure.
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From the System Menu, press {SW VER} to display the Software Version Menu.

Figure 4-19.  Software Version Menu  (sample)

The Software Version Menu displays the software versions for the ScreenPRO-II 
Controller, all connected ScreenPRO-IIs, and BlendPRO-II.  The following functions are 
provided:  

• Controller — displays the Controller’s software version.

• BlendPRO-II — displays BlendPRO-II’s software version.  

• SP — these lines display each ScreenPRO-II’s software version.  One line is 
shown for each active destination.

• In the lower portion of the menu, the system actively compares all software 
versions to that of the Controller:  

~ If all software versions match the Controller’s version, the display 
indicates “All Software version(s) match!”

~ If a mismatch is present, the display indicates “Software version 
mismatch!.”

• Press {DOWNLOAD CODE} to begin the software download process, 
downloading code from the Controller to only those “mismatched” units.  The 
entire process takes several minutes to complete.

• Press {FORCE DOWNLOAD} to download code to all connected devices, 
typically for troubleshooting purposes, or to simply guarantee identical code in 
your entire system.  This process also takes several minutes to complete.  
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Note The two “download” softkeys are always present on this 
menu, even when all code versions match.
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From the System Menu, press {DIAG} to display the Diagnostics Setup Menu.

Figure 4-20.  Diagnostics Setup Menu  (sample)

The Diagnostics Setup Menu enables you to perform a variety of diagnostic tests on the 
ScreenPRO-II Controller.  The following functions are provided: 

• Reset Rotary Encoders — (Yes/No) determines whether or not you wish to reset 
the rotary encoder values when you exit the Rotary Encoder Menu.

• Press {TALLY} to display the Tally Diagnostic Menu, and immediately start a test 
of all eight tally relays.  This procedure takes several seconds to complete.  Press 
{EXIT} when complete. 

• Press {START LED TEST} to begin testing all ScreenPRO-II Controller LEDs.  
This procedure takes several seconds to complete.  Press {EXIT} when complete.

• Press {ROTARY ENCODER} to display the Rotary Encoder Menu.  Refer to the 
“Rotary Encoder Menu” section on page 114 for details.

• Press {TBAR & JOYSTICK} to display the TBar & Joystick Menu.  Refer to the 
“TBar & Joystick Menu” section on page 115 for details.

• Press {KEY DETECT} to display the Key Detect Menu.  Refer to the “Key Detect 
Menu” section on page 116 for details.
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From the Diagnostics Setup Menu, press {ROTARY ENCODER} to display the Rotary 
Encoder Menu. 

Figure 4-21.  Rotary Encoder Menu  (sample)

The Rotary Encoder Menu enables you to test the functionality of each rotary encoder, 
displaying both relative and absolute counts for each.  

• Press {EXIT} to return to the Diagnostics Setup Menu.
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From the Diagnostics Setup Menu, press {TBAR & JOYSTICK} to display the TBar & 
Joystick Menu. 

Figure 4-22.  TBar & Joystick Menu  (sample)

The TBar & Joystick Menu enables you to test the functionality of the TBar and Joystick.

• The TBAR range is 0 to 100%.  

• The Joystick range is -100 to 100 on each axis (X, Y and Z). 

• Press {EXIT} to return to the Diagnostics Setup Menu.
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From the Diagnostics Setup Menu, press {KEY DETECT} to display the Key Detect 
Menu. 

Figure 4-23.  Key Detect Menu  (sample)

The Key Detect Menu shows you the key that is pressed, its status (pressed or released) 
its scan code and its location in the row and column matrix. 

• Press {EXIT} to return to the Diagnostics Setup Menu.

E
X
I
T

KEY DETECTION DIAGNOSTICS

Key Label:

Released

0xC0

row=0 col=8

Key Status:

Key Scan Code:

SOURCE 1
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From the System Menu, press {DEST SETUP} to display the Destination Setup Menu.

 

Figure 4-24.  Destination Setup Menu  (sample)

The Destination Setup Menu enables you to define each destination.  The following 
functions are provided:

• Destination — sets the destination that you want to define.  Choices are 1 - 4 
(standard destinations), and Aux 1 - 4.  This field is independent of the 
destination(s) currently selected on the Destination Bus.      

• Type — displays (or sets) the selected destination type.

~ For standard destinations:
• Displays [Single Screen SP] if one ScreenPRO-II has been 

added to the destination’s configuration.
• Displays [Widescreen SP] if two, three or four ScreenPRO-IIs 

have been added to the destination’s configuration.

~ For Aux destinations, enables you to select between Aux, ImagePRO 
Aux or PrePRO-II Aux destinations.  

SP to Add

SP to Remove

SPs assigned to destination 1:

[ N/A ]
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Note The destination that you select does equate to the same 
destination button on the Controller.

Note When Aux 1, 2, 3, or 4 is selected, the {AUX SETUP} button 
appears, which enables you to set Aux destination 
parameters.  Refer to the “Aux Destination Setup” section 
on page 120 for details. 
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• SP to Add — (as you rotate the ADJ knob), lists all available ScreenPRO-II units 
that can be assigned to the selected destination.  Units are identified by their ID 
number.  If a ScreenPRO-II is currently assigned to another destination, it will not 
appear in the list.  

• SP to Remove — lists all assigned ScreenPRO-II units that can be removed from 
the selected destination.  Units are identified by their ID number.  

• Routing Mode — enables you to set the ScreenPRO-II’s routing mode — either 
Internal or External.  This function instructs the system how sources are used on 
the assigned ScreenPRO-II unit(s).

• At the bottom of the menu, the Status section dynamically lists the ScreenPRO-II 
IDs assigned to the current destination.  

• Press {ADD} to add the selected ScreenPRO-II (on the SP to Add line) to the 
current destination configuration.  

• Press {REMOVE} to remove the selected ScreenPRO-II (on the SP to Remove 
line) from the current destination configuration.

• Press {BACK} to return to the System Menu.   

Important If you have configured a widescreen destination, the moment 
you press {BACK}, the system automatically checks the 
termination status of each ScreenPRO-II.  

• If the termination switch is properly set on each 
ScreenPRO-II, no action is required.  

• If any termination switch is improperly set, the 
ScreenPRO-II Genlock Termination Menu appears, 
with instructions on how to correct the problem.  

Refer to the “ScreenPRO-II Genlock Termination Menu” 
section on page 119 for details.
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After having configured a wide screen destination, the ScreenPRO-II Genlock 
Termination Menu will automatically appear if the system senses that any of the 
termination switches (in the Widescreen Lock signal chain) are improperly set.  

A sample ScreenPRO-II Genlock Termination Menu is shown below:

Figure 4-25.  ScreenPRO-II Genlock Termination Menu

This menu provides important information about the current status of your system’s 
Widescreen Lock chain, and each ScreenPRO-II’s Termination Switch.  

To correct the error:  

• Review the menu information in detail.  

• Follow the instructions as noted in the menu to change the physical position of the 
termination switch(es) as instructed.  For information on the termination switch, in 
Chapter 3 refer to the “ScreenPRO-II Genlock Termination” section on page 76. 

• Press {CHECK TERM} to re-test the settings.

• If required, press {MORE} for additional “help” menus.

Note In Chapter 3, refer to the “BlendPRO-II Widescreen Lock 
Connections” section on page 77 for instructions on proper 
Widescreen Lock connection.
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Set to HI-Z:  SP 3

Error:  Termination setup incorrect

Press CHECK TERM to retest setting.

MORE

SP 2:  HI-Z

SP 4:  75 Ohm

Important If you press {BACK}, the ScreenPRO-II Genlock 
Termination Menu and the Destination Setup Menu will 
endlessly loop — until the termination problem is fixed. 
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When Aux 1, 2, 3, or 4 is selected on the Destination Setup Menu, you can select one of 
three types of Aux Destinations on the Type line:  

• Aux

• ImagePRO Aux

• PrePRO-II Aux.  

In each case, the {AUX SETUP} button appears, and when pressed, the Aux Setup Menu 
appears — which enables you to set parameters for the selected Aux destination.  Note 
that the menu changes, depending upon the selected type of destination.

By way of definition:

• Each type of Aux destination can be switched from the ScreenPRO-II Controller 
by selecting it on the Destination Bus, and then selecting the desired source on 
the Source Selection Bus.

• An Aux destination is the output of a router, which is typically connected directly to 
a monitor — rather than to the ScreenPRO-II.  This type of destination is single 
format (e.g., an analog monitor can only accept signals from an analog router). 

• An ImagePRO Aux destination is an external ImagePRO, a multi-format 
processor with three inputs (one analog, one SDI and one DVI) and the ability to 
scale these inputs to one common output format.  Typically, the ImagePRO output 
is connected to another display device such as a monitor or projector.     

• A PrePRO-II Aux destination is an external PresentationPRO-II, a multi-format 
processor with nine inputs (eight analog and one SDI), and the ability to scale 
these inputs to one common output format. Similar to ImagePRO, the PrePRO-II 
output is connected to another display device such as a monitor or projector.

For “standard” Aux destinations, press {AUX SETUP} to display the Aux 
Setup Menu:

 

Figure 4-26.  Aux Setup Menu — Aux Destination (sample)

The following functions are provided:

• Top Line — displays the selected Aux destination number. 
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• Source Mapping — two selections are available:

~ Input Patch — maps Aux sources according to how your inputs are 
patched to buttons in the console’s Source Selection bus.  

~ Direct Map — maps the Source Selection bus as a 1:1 map of your 
router inputs — for this destination only.

• Router Name — selects the router from which the Aux sources will be output.

• Router Output — selects the specific router output designated as an Aux (as 
assigned on the router’s Output Patch Menu).

• Press {RESET} to return all fields to <UNDEFINED>.

For ImagePRO Aux and PrePRO-II Aux destinations, press {AUX SETUP} 
to display the Aux Setup Menu:

 

Figure 4-27.  Aux Setup Menu — ImagePRO Aux Destination (sample)

The following functions are provided:

• Top Line — displays the selected Aux destination number. 

• Source Mapping — two selections are available:

~ Input Patch — maps Aux sources according to how your inputs are 
patched to buttons in the console’s Source Selection section.  

~ Direct Map — maps Aux sources according to how your inputs are 
connected to the router. 

• ImagePRO ID or PrePRO-II ID — selects the ID of the ImagePRO or PrePRO-II, 
to which you want to route Aux sources.

• In the Analog section:

~ Analog Router Name — selects the router from which analog sources 
will be routed to the ImagePRO or PrePRO-II.

~ Analog Router Output — selects the specific router output designated 
as Aux (as assigned on the router’s Output Patch Menu).
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~ ImagePRO Input or PrePRO-II Input — selects the ImagePRO or 
PrePRO-II input to which the analog router output is connected.

• In the SDI section:

~ SDI Router Name — selects the router from which SDI sources will be 
routed to the ImagePRO or PrePRO-II.

~ SDI Router Output — selects the specific router output designated as 
Aux (as assigned on the router’s Output Patch Menu).

~ ImagePRO Input or PrePRO-II Input — selects the ImagePRO or 
PrePRO-II input to which the SDI router output is connected.
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• In the DVI section (applies to ImagePRO Aux destinations only):

~ DVI Router Name — selects the router from which DVI sources will be 
routed to the ImagePRO.  

~ DVI Router Output — selects the specific router output designated as 
Aux (as assigned on the router’s Output Patch Menu).  

~ ImagePRO Input  — selects the ImagePRO input to which the DVI 
router output is connected.  

• Press {RESET} to return all fields to <UNDEFINED>.

Please note the following important points regarding Aux destinations:

• For proper operation, ImagePRO and PrePRO-II devices must be connected to 
the ScreenPRO-II Controller via Ethernet.

• ImagePRO and PrePRO-II output setups must be performed locally on the units 
themselves.

• Only one router of each type (Analog, DVI and SDI) can be connected to an 
ImagePRO unit.

• Only one Analog and one SDI router can be connected to a PrePRO-II unit.

• In order to properly create “source files” on ImagePRO: 

~ On the ScreenPRO-II Controller console, select a ScreenPRO-II 
Controller destination.

~ On the Input Menu, acquire the selected source in the normal manner.

~ Press {SAVE} to save the source in the normal manner, which in turn 
also creates a source file on the ImagePRO.

~ Repeat for all desired sources.  

Note The “copy down” of source file information is possible 
because the system “knows” that ImagePRO is connected to 
the same router from which the newly acquired input 
originates — all based on the patching configuration.  
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From the System Menu, press {NETWORK SETUP} to display the Network Setup Menu.

Figure 4-28.  Network Setup Menu  (sample)

For reference only, the Network Setup Menu displays the available IP range for the 
ScreenPRO-II Controller system.  The following information is provided:  

• Network DHCP — this non-selectable field confirms that the Controller is a DHCP 
server, by showing the [SERVER] label.  

• Ctrlr IP — this non-selectable field shows the Controller’s IP address.

• Port — this non-selectable field shows the Controller’s port.

• IP Range from / to — these non-selectable fields show the system’s available IP 
range that the server can provide.
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From the System Menu, press {INPUT PATCH} to display the Input Source Patch Menu.

Figure 4-29.  Input Source Patch Menu  (sample)

The Input Source Patch Menu enables you to associate (patch) specific router inputs to 
specific source buttons on the ScreenPRO-II Controller.  The menu also enables you to 
assign tallies, and select connections to the ScreenPRO-II units.  

The following functions are provided:  

• Source Number — selects the source button on the Controller that you want to 
patch.  The selection range is 1 - 16.  The source is chosen with the ADJ knob — 
not with the source buttons.

• Connection Type — determines how the selected source is connected: 

~ From a router — choose between up to eight MATRIXPRO routers, or a 
third party router (e.g., SIERRA, LEITCH, etc.) as selected on the 
Router Specification Menu.

~ To ScreenPRO-II’s internal matrix — choose ALL SP or an individual 
ScreenPRO-II ID.  The “ALL SP” selection assumes connections from 
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Important The fields that are shown on the Input Source Patch Menu 
change depending upon the selected Connection Type.

Important From a conceptual standpoint, there are no “direct” 
connections to a ScreenPRO-II scaler.  All connections, 
whether they are from a single source or an external router, 
connect to each ScreenPRO-II’s internal router matrix.
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DAs to similar ScreenPRO-II inputs, and enables all ScreenPRO-IIs to 
switch simultaneously to the same input.  

• Router Input — Applies to Router connections — this option selects the 
physical router input that you wish to associate with the source.  The available 
range depends on the number of router inputs that are defined in the Router 
Specification Menu.  

• ScreenPRO-II Input — selects the specific input on the ScreenPRO-II.

• Tally Number — Applies to all connections — this option enables you to assign 
any of the eight available tallies to any input source.  There are no restrictions on 
tally usage.  For example, inputs 1 and 8 could both map to tally 1 if desired.

• Press {ADD PATCH} to confirm any change that you make on the menu.  As you 
dial through the choices, the “SP Input is mapped to” lines will show if the current 
choice is already in use.  If the patch already exists and you “add” it, you will be 
asked to confirm.

• Press {DELETE PATCH} to delete all input patch registers for the selected input.  
When pressed:

~ The Connection Type setting changes to “UNDEFINED.”

~ The Router Input line is cleared.

This procedure is an excellent starting point if you are uncertain about specific 
input patch settings.  

In Chapter 5, refer to the “Input Patching” section on page 198 for important information 
about the system’s default Input Patch Table.

Note Asterisks around the ID number (e.g., *1*) indicate that the 
selected ID has not been detected by the system.  However, 
you can proceed with patching, and once the ID is detected, 
the patch will be completed as programmed. 

Note The same router input can be chosen for different source 
numbers.
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From the System Menu, press {ROUTER SETUP} to display the Router Specification 
Menu.

Figure 4-30.  Router Specification Menu  (sample)

The Router Specification Menu enables you to define input, output and communication 
parameters for all connected routers.  

The following functions are provided:  

• Number — select the number of the router that you wish to configure.  The 
system supports up to eight definitions.  

• Name — this non-selectable field shows the router’s assigned name.  After a 
factory reset, router number 1 defaults to [MATRIXPRO1] in Analog format, router 
number 2 defaults to [MATRIXPRO2] in SDI format, and router number 3 defaults 
to [MATRIXPRO3] in DVI format.   

• Manufacturer — identifies the router manufacturer.  Choose between FOLSOM, 
EXTRON, SIERRA, LEITCH, ISIS, DVILINK and DPI.  Refer to the “Router 
Interface Notes” section on page 128 for additional details about third party 
manufacturers. 

• Router Type — identifies the type of router being used.  The choices are 
ANALOG, DVI, SDI, D/A ANALOG, D/A DVI and D/A SDI.  Please note:

~ The {COMM SETUP} function must be set for Analog, DVI and SDI 
routers.

~ The D/A selections are provided for future implementation.  

• Number of Inputs — identifies the number of inputs on the selected router.  

• Number of Outputs — identifies the number of outputs on the selected router.

Number of Inputs

Number of Outputs

Manufacturer FOLSOM

16

B
A
C
K

N
A
V

A
D
J

ROUTER SPECIFICATION

Number 1

8

Communication Type ETHERNET

Router Type ANALOG

COMM
SETUP

OUTPUT
PATCH

ADD
NEW

DELETE
ROUTER

[ MATRIXPRO1 ]Name

Note When a router number is undefined, the name [ROUTER #] 
appears, and in the Number field, the word “EMPTY” 
appears before the selected number.
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• Communication Type — sets the device’s communication type, either RS-232,  
ETHERNET or LANTRONIX.

• Press {COMM SETUP} to display one of three Comm Setup Menus, depending 
on the selected Communication Type.  Refer to the “Comm Setup Menus” 
section on page 129 for details.  

• Press {DELETE ROUTER} to delete the current specification and change the 
selected router Number to <EMPTY>.

• Press {ADD NEW} after choosing an empty configuration’s Manufacturer, Type, 
Number of Inputs and Number of Outputs to save a new router specification.

• Press {OUTPUT PATCH} to display the Output Patch Menu.  Refer to the 
“Output Patch Menu” section on page 132 for details.

oçìíÉê=fåíÉêÑ~ÅÉ=kçíÉë

For selected third party routers, additional interface information is provided below.

• Extron Router Support

The ScreenPRO-II Controller supports Extron routers enabled with Ethernet.  

~ In the Router Specification Menu, set the Communication Type to 
ETHERNET.

~ In the Ethernet Setup Menu, dial in the router’s IP address, and keep 
the port number set to 23. 

~ Press {TEST COMM} to establish communications.

Due to the Extron protocol, the router’s matrix size will not be read by the 
Controller, but will instead default to 16 x 16.  When you return from the Ethernet 
Setup Menu to the Router Specification Menu, dial in the proper number of 
inputs and outputs to gain full access to the router.  

• DVILink 18x18 Router Support

The ScreenPRO-II Controller supports the DVILink 18x18 router enabled with 
serial control.  Connect the router to the EXT COMM port on the back of the 
Controller.  In Appendix A, refer to the “Serial Connector” section on page 261 
for pinouts.  

• Sierra Video Systems Router Support

The ScreenPRO-II Controller supports Sierra Video Systems routers enabled with 
serial control.  Connect the router to the EXT COMM port on the back of the 
Controller.  In Appendix A, refer to the “Serial Connector” section on page 261 
for pinouts.  

Note Ensure that you set the router’s IP address to work with the 
ScreenPRO-II Controller’s 192.168.0.xxx standard (e.g., 
192.168.0.245). Any 192.168.0.xxx address will work 
provided it does not conflict with the Controller, VPs or other 
network routers and devices.
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Information is provided for three different Comm Setup Menus:

• Ethernet Setup Menu

• RS-232 Setup Menu

• Lantronix Setup Menu

bíÜÉêåÉí=pÉíìé=jÉåì

On the Router Specification Menu, when the Communication Type is set to 
ETHERNET, press {COMM SETUP} to display the Ethernet Setup Menu: 

Figure 4-31.  Ethernet Setup Menu  (sample)

The Ethernet Setup Menu enables you to set the selected router’s IP address and port 
number.

• IP Address — sets the router’s IP address.  

• IP Port Number — sets the router’s IP port number, if applicable. 

• Press {NEXT IP QUAD} to advance to the next 3-digit set of numbers in the 
address.  Use the ADJ knob in the normal manner to change the digits.

• Press {TEST COMM} to test communications with the defined router:  

~ If the test is successful, a “ROUTER CONNECTED” message will 
appear that includes the Router name and version.

~ If the test is unsuccessful, a “ROUTER FAILED” message will appear.  In 
this condition, re-check all connections and settings, and repeat the test.
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On the Router Specification Menu, when the Communication Type is set to RS-232, 
press {COMM SETUP} to display the RS-232 Setup Menu: 

Figure 4-32.  RS-232 Setup Menu  (sample)

The RS-232 Setup Menu enables you to set the router’s RS-232 communications 
parameters.

• Baud Rate —  sets the desired baud rate (9600, 14400, 19200, 28800, 38400, 
57600, 115200).

• Data Bits — this value is fixed at [8].

• Parity — this value is fixed at [None].

• Stop Bits — this value is fixed at [1].

• Press {TEST COMM} to test communications with the defined router:  

~ If the test is successful, a “ROUTER CONNECTED” message will 
appear that includes the Router name and version.

~ If the test is unsuccessful, a “ROUTER FAILED” message will appear.  In 
this condition, re-check all connections and settings, and repeat the test.
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On the Router Specification Menu, when Communication Type is set to LANTRONIX, 
press {COMM SETUP} to display the Lantronix Setup Menu: 

Figure 4-33.  Lantronix Setup Menu  (sample)

The Lantronix Setup Menu enables you to set parameters for multiple Lantronix Ethernet-
to-Serial device servers.  The ScreenPRO-II Controller supports Lantronix models UDS100 
and UDS200.  The menu will appear blank until the Lantronix device is “discovered.”  

• Number — selects the number of the Lantronix device that you wish to set up.

• Press {DISCOVER LTRX} to set up communications with the Lantronix device.

• Channel — sets the specific Lantronix channel (1 or 2) that you wish to set up.  
Each Lantronix can control two serial routers.

• Baud Rate — sets the selected channel’s baud rate.

• Data Bits — sets the selected channel’s data bits.

• Stop Bit — sets the selected channel’s stop bit.

• Parity — sets the selected channel’s parity.

• IP — displays the IP address of the Lantronix.  This parameter must be set at the 
device itself.  

• MAC Addr — displays the hard-coded MAC address of the Lantronix.
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LANTRONIX SETUP

Number < EMPTY >

[ N/A ]Channel

[ N/A ]Baud rate

[ N/A ]Data bits

DISCOVER
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[ N/A ]Stop bit

[ N/A ]Parity

IP:  N/A

MAC Addr:  [ N/A ]

Important Prior to pressing {DISCOVER LTRX}, it is highly 
recommended that you set up a static IP address on the 
Lantronix device itself.  The recommended range is 
192.168.0.200 - 192.168.0.239 — such as not to conflict with 
other devices in the ScreenPRO-II Controller system.  Refer 
to the Lantronix UDS100 or UDS200 User’s Guide for 
instructions.
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From the Router Specification Menu, press {OUTPUT PATCH} to display the Output 
Patch Menu. 

Figure 4-34.  Output Patch Menu  (sample)

The Output Patch Menu allows you to associate router outputs to ScreenPRO-II inputs.  
When a router is chosen on the Router Specification Menu, you then use the Output 
Patch Menu to associate a specific output with a ScreenPRO-II ID and input.  This process 
creates a unique “Output Patch Table” for each defined router. 

The following functions are provided:  

• Router Output — selects the specific router output that is being patched.  The 
selectable range is 1 to the number of outputs defined in the Router 
Specification Menu (e.g., 1 - 16).  

• Device ID — selects the ScreenPRO-II ID to which the Router’s output will be 
connected.  The selectable range is 1 - 32.  

• SP Input — selects the physical ScreenPRO-II input to which the router’s output 
is patched.  

• Mixer Layer — this line displays N/A, as it does not apply to ScreenPRO-II.

• Press {ADD PATCH} to confirm any change that you make on the menu.  As you 
dial through the choices, the “SP Input is mapped to” lines will show if the current 
choice is already in use.  If the patch already exists and you “add” it, you will be 
asked to confirm.

• Press {DELETE PATCH} to delete all “Output Patch Table” registers for the 
selected router output.  This function is an excellent starting point if you are 
uncertain about specific output patch settings.  

In Chapter 5, refer to the “Router Setup” section on page 193 for important information 
about the system’s default Output Patch Table.
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The following topics are discussed in this section: 

• Miscellaneous Menu Tree

• Miscellaneous Menu Description

• Miscellaneous Sub Menus

jáëÅÉää~åÉçìë=jÉåì=qêÉÉ
The figure below illustrates the Miscellaneous Menu Tree:

Figure 4-35.  Miscellaneous Menu Tree

All functions and sub menus are discussed in the following sections.   
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The Miscellaneous Menu accesses ScreenPRO-II Controller functions that do not fall into 
other distinct menu categories.

Figure 4-36.  Miscellaneous Menu

To access the menu:

• Press MISC on the Home Menu.

The following “miscellaneous” functions are provided: 

• Press {CONSL} to access the Console Port Setup Menu.  Refer to the “Console 
Port Setup Menu” section on page 135 for details.

• Press {LOCK} to access the Lockout Code Menu.  Refer to the “Lockout Code 
Menu” section on page 136 for details.

• Press {EDID} to access the EDID DVI Input Format Menu.  Refer to the “EDID 
DVI Input Format Menu” section on page 137 for details.

• Press {LIGHT ADJUST} to access the Keypad Backlight Menu.  Refer to the 
“Keypad Backlight Menu” section on page 138 for details.

• Press {LCD SETTINGS} to access the LCD Settings Menu.  Refer to the “LCD 
Settings Menu” section on page 139 for details.

• Press {USER PREF} to access the User Preference Menu.  Refer to the “User 
Preference Menu” section on page 140 for details.

• Press {BACKUP RESTORE} to access the Backup/Restore Menu.  Refer to the 
“Backup/Restore Menu” section on page 141 for details.
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The following sub menus can be accessed from the Miscellaneous Menu:

• Console Port Setup Menu

• Lockout Code Menu

• EDID DVI Input Format Menu

• Keypad Backlight Menu

• LCD Settings Menu  

• User Preference Menu

• Backup/Restore Menu

`çåëçäÉ=mçêí=pÉíìé=jÉåì
From the Miscellaneous Menu, press {CONSL} to display the Console Port Setup 
Menu:

Figure 4-37.  Console Port Setup Menu  (sample) 

This menu enables you to verify (or change) ScreenPRO-II Controller’s serial port 
communication settings (for the Ext Comm port).  The following functions are provided: 

• Baud Rate — sets the port’s baud rate.  Range: 2400 to 115200.

• Data Bits — sets the port’s data bits.  Range:  5 to 8.

• Parity — sets the port’s parity:  Even, Odd or None. 

• Stop Bits — sets the port’s stop bits:  1, 1.5 or 2.
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From the Miscellaneous Menu, press {LOCK} to display the Lockout Code Menu:

Figure 4-38.  Lockout Code Menu  (sample) 

The Lockout Code Menu enables you to define a programmable lockout code, so that the 
Controller can be locked out from unauthorized users.  The following functions are 
provided: 

• The Lockout Code field defines which code is currently enabled.

~ Select Default to enable the system’s default lockout code:  1111

~ Select Custom to enable a custom lockout code, as entered on the 
Change Lockout Code Menu. 

• Press {CHANGE CODE} to display the Change Lockout Code Menu.

Figure 4-39.  Change Lockout Code Menu  (sample) 
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To enter a new lockout code, use the eight numbered buttons on the Source 
Selection Bus, and then confirm the new code.

In Chapter 6, refer to the “Locking and Unlocking the Controller” section on page 252 for 
instructions on using the Controller Panel Lockout mode.  

bafa=asf=fåéìí=cçêã~í=jÉåì
From the Miscellaneous Menu, press {EDID} to display the EDID DVI Input Format 
Menu:

Figure 4-40.  EDID DVI Input Format Menu  (sample) 

The EDID DVI Input Format Menu enables you to update the system’s preferred EDID 
resolution for each ScreenPRO-II’s two DVI inputs (Background and DSK) — for the 
selected destination bus.  

Extended Display Identification Data (EDID) is a VESA standard data format that contains 
information about a display device and its resolution, both preferred and allowed.  The 
system’s EDID file is stored in non-volatile memory.  This file is read by an external 
computer’s DVI graphic card when the computer’s DVI output is connected to ScreenPRO-
II via the DVI-I connector during boot-up.  The ScreenPRO-II must be powered on first for 
the EDID information to be read.  

The following functions are provided:

• Destination — sets the destination bus on which you want to program EDID — all 
or individual ScreenPRO-II units.

• Format — selects the preferred DVI video format with which you want to program 
the selected ScreenPRO-II(s) EDID non-volatile memory

• Current — displays the current EDID video format that resides in memory.

• Press {PROGRAM EDID} to program EDID with the new selected format.  A 
warning message will be shown.  
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Please note the following important points regarding EDID:

• For the computer to correctly see the EDID data:

a. Turn on ScreenPRO-II power.  

b. Connect the DVI cable from the computer’s video card to one of 
ScreenPRO-II’s DVI connectors.  

c. Boot the computer.

d. Once EDID programming is complete, you will be prompted to power 
down the external computer, power it back on again, and then ensure 
that the computer’s format is set to match.

• A ScreenPRO-II’s EDID prom is not reset to any default during a factory reset.  To 
change the EDID, you must use the EDID DVI Input Format Menu.

hÉóé~Ç=_~ÅâäáÖÜí=jÉåì
From the Miscellaneous Menu, press {LIGHT ADJUST} to show the Keypad Backlight 
Menu:

Figure 4-41.  Keypad Backlight Menu  (sample) 

The Keypad Backlight Menu enables you to adjust the backlight level of all buttons on the 
ScreenPRO-II Controller.  

The following functions are provided:

• Keypad Backlight — adjusts the backlight level.  Backlight range is 0 (backlight 
off) to 100 (backlight on full).  
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From the Miscellaneous Menu, press {LCD SETTINGS} to show the LCD Settings 
Menu:

Figure 4-42.  LCD Settings Menu  (sample) 

The LCD Settings Menu enables you to adjust contrast and brightness settings for the 
touch screen, and also calibrate the touch screen.  The following functions are provided:

• Rotate the BRITE knob to adjust touch screen brightness.

• Rotate the CONTRAST knob to adjust touch screen contrast.

• Press {RESET} to return settings to the factory default values.

• Press {LCD CAL} to calibrate the touch screen display to your finger, or to a 
stylus.  Once pressed, you will be prompted to touch the center of a target three 
times.  At the conclusion of the procedure, the display is calibrated and the system 
returns to the Home Menu.
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From the Miscellaneous Menu, press {USER PREF} to display the User Preference 
Menu:

Figure 4-43.  User Preference Menu  (sample) 

The User Preference Menu enables you to set a variety of user preference parameters.  
The following functions are provided:

• Black Invalid Video — selects the method by which the scaler “loading” 
procedure is shown on Preview, when the user changes inputs:

~ ON — shows black when scalers are loaded.  In addition:
• Black is shown when a background channel (BG) becomes 

invalid.
• The DSK will be turned off when source video becomes invalid.

~ OFF — shows the full scaler loading procedure, which can temporarily 
include non-sync and non-stable video.  

In Chapter 6, refer to the “Setting User Preferences” section on page 221 for instructions.
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From the Miscellaneous Menu, press {BACKUP RESTORE} to display the Backup/
Restore Menu:

Figure 4-44.  Backup/Restore Menu  (sample) 

The Backup/Restore Menu enables you to back up and restore system configurations, 
using the console’s Flash Memory Card capability.  You can also use this function to 
transfer configurations between Controllers as required.   

The following functions are provided:

• Device — Selects the device(s) that you want to backup or restore.  Choose 
between the Ctrlr, SP or Ctrlr+SP.

• Controller Options — Selects which portion of the selected devices you want to 
backup or restore.  Choose between All, System or Presets. 

• SP to Restore — Selects the device(s) that you wish to restore.  Choose between 
All devices, or the ID of a specific ScreenPRO-II (e.g., 1, 2, 3).

• Press {BACKUP} to perform a backup operation to the Flash Memory Card using 
the selected device(s) and options.  

• Press {CHECK CARD} to check the system for the presence of a Flash Memory 
Card.  If a memory card is present, the system then checks for the presence of a 
system configuration on the card.  

• Press {RESTORE} to restore a system configuration from the Flash Memory Card 
to the selected device(s).

In Chapter 6, refer to the “Using Backup and Restore” section on page 253 for 
instructions.
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The following topics are discussed in this section:

• Frame Grab Menu Tree

• Frame Grab Menu Description

cê~ãÉ=dê~Ä=jÉåì=qêÉÉ
The figure below illustrates the Frame Grab Menu Tree:

Figure 4-45.  Frame Grab Menu Tree

All functions and menus are discussed in the following sections.
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The figure below illustrates a sample Frame Grab Menu:

Figure 4-46.  Frame Grab Menu  (sample)

To access the Frame Grab Menu:

• On Preview, select the layer (Layer A or B) or the background (BG A or BG B) 
from which you want to capture a “full screen” still frame.

• Press FRAME GRAB on the Home Menu.

The Frame Grab Menu enables you to capture still frames into each ScreenPRO-II 
system’s three internal frame stores.  The “sources” of the still frames are each 
ScreenPRO-II’s BG A and BG B inputs, or the scaled inputs (Layer A or B).  

Please note:

• For widescreen destinations, even though you are using the frame stores of 
multiple ScreenPRO-II units, you are conceptually working with only three frame 
stores — each of which captures’s its “slice” of the complete widescreen image.   

• For single screen destinations, you are working with the individual destination’s 
three frame stores in the normal manner.   

Regarding captures:

• All captures of the background (BG A or BG B) must occur on Preview — the 
desired full screen source to capture must be visible on Preview.  You will get an 
error message if you attempt to capture while the source is on Program.  

• All captures of the layers (Layer A or Layer B) can occur on either Preview or 
Program. 

Once captured, a still frame can be assigned as the input “type” for BG A, BG B, the DSK 
source or the LOGO — basically any “green” button in the Layer Control Section.  

Each frame store utilizes the “temp” (temporary) memory for on-air production.  During 
operation, you can overwrite the memory with new captured stills as desired — as it takes 
only a few seconds to capture a still.  Note that stills in “temp” memory are lost when the 
system is powered down.

You can also store three stills in “permanent” flash memory, which will not be lost when the 
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system is powered down.  Thus, at any one time, you could have a maximum of three stills 
in temporary memory, and three different stills in permanent memory. 

At bootup, the contents of flash memory is read into “temp” memory for use on-air.  It takes 
several minutes to save a still into permanent memory, and this procedure should not be 
performed on-air.  Permanent frames can also be overwritten.  

The following Frame Grab Menu functions are provided:

• Destination — displays the currently selected destination.  

• ID — displays the ID(s) of the selected destination’s associated ScreenPRO-II 
system(s).  

• Frame Number — enables you to select FG_1, FG_2 or FG_3 for capture, 
storage, erasure, recall or deletion.

• Capture Format — displays the output resolution.  Each ScreenPRO-II always 
captures a full screen image at the output resolution — regardless of the input 
resolution.

• Name — displays the name of the file.

~ UNSAVED indicates that the file’s source is temporary memory.  

~ SAVED indicates that the file is permanently stored.  If this appears, the 
permanent file has been read into “temp” memory for use on-air.

• Format — displays the resolution of the captured frame.

• Press {NAME} to display the Frame Grab Name Menu.  Refer to the “Frame 
Grab Name Menu” section on page 145 for details.

• Press {ERASE} to permanently erase the selected frame from permanent (flash) 
memory.  This process takes from 1 to 2 minutes, and locks the console during the 
procedure.  You will be asked to confirm before proceeding.  

• Press {CAPTURE} to capture a still into the selected “temporary” frame store.  
Once pressed, the screen will indicate that the frame is being captured.

• Press {SAVE} to save the captured frame into permanent (flash) memory within 
the selected register.  This process takes from 2 to 3 minutes, and locks the 
console during the procedure.  You will be asked to confirm before proceeding.

• Press {DELETE} to mark the selected permanent frame as deleted — but note 
that the ERASE function is still required for permanent deletion.  You can consider 
this as a “quick” delete function.

• Press {RECALL} to recall a selected frame from permanent (flash) storage back 
into temporary memory.   

In Chapter 6, refer to the “Working with Still Frames” section on page 246 for instructions.

Note You can perform this function even if there is no frame stored 
in the permanent register.
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The figure below illustrates a sample Frame Grab Name Menu:

Figure 4-47.  Frame Grab Name Menu  (sample)

The Frame Grab Name Menu enables you to name a saved frame grab, using a customer 
supplied PS-2 keyboard.  

The following functions are provided:

• Saved Location — enables you to select the saved frame that you want to name.  
You must use the Save function (on the Frame Grab Menu) as a prerequisite to 
naming the frame. 

• Current Name — displays the name of the saved frame. 

• New Name — enables you to enter a new name with the PS-2 keyboard.  Once 
entered, the name is “attached” to the file that already resides in permanent (flash) 
memory.  The name will now be shown on all menus in which a still frame can be 
selected (e.g., LOGO Menu, DSK Input Setup Menu, Background Input Setup 
Menu, etc.).
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then hit Enter to save it.

Note The optional Tally board is required for the “naming” feature.  
The board includes the tally connector plus a PS-2 connector 
for the Keyboard Port.  
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The figure below illustrates a sample Effects Menu:

Figure 4-48.  Effects Menu  (sample)

To access the menu:

• Press EFFECTS on the Home Menu.

The Effects Menu allows you to modify and manage effects on a destination-by-
destination basis, including the ability to define key frames, paths and effect properties.  
The following functions are provided:

• Destination — displays the currently selected destination.  

• Key Frame Effect — enables you to select the type of motion for a “move.”  

• Transition Rate — sets the auto-transition rate that is used when the Auto Trans 
button is pressed.  The transition value is in 0.1 second increments.

• Transition Wipe — sets the transition type when the WIPE button is selected.  
Choose between Wipe Right, Wipe Left, Wipe Down, Wipe Up, Curtain Open, 
Curtain Close, Box In and Box Out.  

• Transition Edge Width — When WIPE is selected, this field enables you to set 
the transition’s edge type.  The range (in pixels) is from 0 to 256.

In Chapter 6, refer to the “Working with Transitions” section on page 241 for instructions.
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Transition Rate 1.0
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Note Only the Linear motion type is supported.  All other key frame 
effects are ignored by ScreenPRO-II destinations. 

Note Wide screen destinations only support Mix transitions.  Key 
frame effects are ignored by ScreenPRO-II destinations.  
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The Status Menu provides basic status information:

Figure 4-49.  Status Menu  (sample)

To access the Status Menu:

• Press STATUS on the Home Menu.

The following status information is provided: 

• ScreenPRO-II Controller — (top line) displays the Controller’s software version.

• SCREENPRO-II — lists the number of ScreenPRO-II units detected.

• PREPRO-II — lists the number of PresentationPRO-II units detected.

• IMAGEPRO — lists the number of ImagePRO units detected.

• ROUTERS — lists the number of Routers detected.

• BLENDPRO-II — lists the number of BlendPRO-II units detected.  

H
O
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E

SP II Controller Ver 1.0

SCREENPRO II:  4

BLENDPRO II:  1  

PREPRO II:  0

IMAGEPRO:  2

ROUTERS:  2

Note If certain error conditions exist, the Status Menu displays 
additional messages such as “Checksum Mismatch” and 
“Please Upgrade.”
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mfm=^ÇàìëíãÉåí=jÉåì
The following topics are discussed in this section:

• PIP Adjustment Menu Tree

• PIP Adjustment Menu Description

• PIP Adjustment Menu Functions

• PIP Adjustment Sub Menus

mfm=^ÇàìëíãÉåí=jÉåì=qêÉÉ
The figure below illustrates the PIP Adjustment Menu tree:

Figure 4-50.  PIP Adjustment Menu Tree

All functions and sub menus are discussed in the following sections. 
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Menu
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mfm=^ÇàìëíãÉåí=jÉåì=aÉëÅêáéíáçå
The figure below illustrates a sample PIP Adjustment Menu:

Figure 4-51.  PIP Adjustment Menu  (sample)

The PIP Adjustment Menu provides tools that enable you to adjust the “active” PIP.  To 
access the menu:

• Press LAYER A or LAYER B in the Layer Control Section, then ...

• Press the PIP button in the Layer Function Section.  

mfm=^ÇàìëíãÉåí=jÉåì=cìåÅíáçåë
The following PIP Adjustment Menu functions are provided:

• H Size — adjusts the PIP’s horizontal size in pixels.  The “%” value is the PIP’s 
size as a percentage of the screen’s horizontal resolution.  The numeric value is 
the PIP’s width in pixels.  To adjust, use the ADJ knob or the Joystick’s Z-Axis 
knob.  

• V Size — adjusts the PIP’s vertical size in pixels.  The “%” value is the PIP’s size 
as a percentage of the screen’s vertical resolution.  The numeric value is the PIP’s 
height in pixels.  To adjust, use the ADJ knob or the Joystick’s Z-Axis knob.  

• H Position — indicates the PIP’s position, relative to the horizontal center of the 
screen (00), as measured from the exact center of the PIP.  Thus, the value -34 is 
34 pixels to the left of center.  To adjust, move the Joystick left and right or use the 
ADJ knob. 

• V Position — indicates the PIP’s position, relative to the vertical center of the 
screen (00), as measured from the exact center of the PIP.  Thus, the value 70 is 
70 pixels above center.  To adjust V Position, move the Joystick up and down or 
use the ADJ knob.  

• Move Rate — adjusts the rate (in 0.1 second increments) for programmed PIP 
movement from key frame to key frame.  To adjust, use the ADJ knob or twist the 
Joystick Z-Axis knob.  

H Position

V Position

V Size  < 58.9%  > 452
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Move Rate 0.8

Key Frame Effect [ LINEAR ]

H Size  < 37.3%  > 674

TRACK SIZE

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - 

OPERATION:

JOY Z to SIZE, X Y TO POSITION
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• Key Frame Effect — indicates the “motion type” that is used to move the PIP 
from point to point.  

• Press {BORDR} to display the Border Menu.  Refer to the “Border Menu” 
section on page 151 for details.

• Press {SHDOW} to display the Shadow Menu.  Refer to the “Shadow Menu” 
section on page 152 for details.

• Press {EFX} to display the Image Effects Menu.  Refer to the “Image Effects 
Menu” section on page 153 for details.

• At the bottom of the PIP Adjustment Menu, the {TRACK SIZE} check box has 
the following functions:

~ Check the {TRACK SIZE} check box to lock H Size and V Size together.  
Regardless of the PIP’s current aspect ratio, its size will adjust 
proportionally when the Joystick’s Z-Axis knob or the ADJ rotary knob is 
used to change size.

~ Uncheck the {TRACK SIZE} check box to adjust H Size or V Size 
individually, without affecting the other parameter.  In this way, you can 
stretch the PIP horizontally or vertically.

• Press Source in the Joystick Section to display the Input Source Adjustment 
Menu.  Refer to the “Source Adjustment Menus” section on page 165.

Please note the following related functions:

• To return the PIP to its default size and aspect ratio, press the Reset button in the 
Joystick Section.

• To adjust the PIP with fine resolution, press the Fine Adjust button in the 
Joystick Section.

mfm=^ÇàìëíãÉåí=pìÄ=jÉåìë
The following sub menus can be accessed from the PIP Adjustment Menu:

• Border Menu

• Shadow Menu

• Image Effects Menu

Complete descriptions are provided in the following sections.

Note Only the Linear motion type is supported.  All other key frame 
effects are ignored by ScreenPRO-II destinations. 
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From the PIP Adjustment Menu, press {BORDR} to display the Border Menu.

Figure 4-52.  Border Menu  (sample)

The Border Menu enables you to add a border to a PIP, and adjust its shape, style and 
color as desired.  

The following functions are provided:  

• Mode — enables or disables the PIP’s border. 

• Style — select one of multiple border styles, including single color and dual color 
with various combinations of soft edge.

• Color — enables you to individually adjust the border’s Red, Green and Blue 
attributes as desired.

• Size Specified In — select the method by which you want to specify the border 
size, either as a percentage of the PIP size or in pixels.  

• Size — adjust’s the border size, using the method selected on the “Size 
Specified In” line.  Note that if “% of PIP” is selected and you switch to “Pixels,” 
the system auto converts one display method to the other.

• Press {PIP} to return to the PIP Adjustment Menu.  Refer to the “PIP 
Adjustment Menu Functions” section on page 149 for details.

• Press {SHDOW} to display the Shadow Menu.  Refer to the “Shadow Menu” 
section on page 152 for details.

• Press {EFX} to display the Image Effects Menu.  Refer to the “Image Effects 
Menu” section on page 153 for details.
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Note You can also access the Border Menu from the Shadow 
Menu and the Image Effects Menu by pressing {BORDR}.
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From the PIP Adjustment Menu, press {SHDOW} to display the Shadow Menu.

Figure 4-53.  Shadow Menu  (sample)

The Shadow Menu enables you place a shadow behind a PIP, and adjust its size, position 
and transparency.  

The following functions are provided:  

• Mode — enables or disables the PIP’s shadow. 

• H Size  < % > — adjusts the shadow’s horizontal size as a percentage of the PIP’s 
size.  If {TRACK SIZE} is checked, H and V size adjust proportionally.

• V Size  < % > — adjusts the shadow’s vertical size as a percentage of the PIP’s 
size.  If {TRACK SIZE} is checked, H and V size adjust proportionally.

• H Pos  < % > — adjusts the shadow’s horizontal position as an offset from the 
base PIP image.  The value represents a percentage of the PIP’s size.   

• V Pos  < % > — adjusts the shadow’s vertical position as an offset from the base 
PIP image.  The value represents a percentage of the PIP’s size.

• Transparency — adjusts the shadow’s transparency, from 0 (full transparency) to 
1024 (opaque).  

• Check {TRACK SIZE} to adjust the shadow’s H Size and V Size proportionally.

• Press {PIP} to return to the PIP Adjustment Menu.  Refer to the “PIP 
Adjustment Menu Functions” section on page 149 for details.

• Press {BORDR} to display the Border Menu.  Refer to the “Border Menu” 
section on page 151 for details.

• Press {EFX} to display the Image Effects Menu.  Refer to the “Image Effects 
Menu” section on page 153 for details.
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H Pos  < % >

V Pos  < % >

TRACK SIZE

B
O
R
D
R

E
F
X

Note You can also access the Shadow Menu from the Border 
Menu and the Image Effects Menu by pressing {SHDOW}.
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fã~ÖÉ=bÑÑÉÅíë=jÉåì
From the PIP Adjustment Menu (or the Key Menu), press {EFX} to display the Image 
Effects Menu.

Figure 4-54.  Image Effects Menu  (sample)

The Image Effects Menu enables you to creatively manipulate the selected PIP or Key.  

• Monochrome Mode — turns chroma on or off.  When the mode is enabled, the 
image is completely monochrome.   

• Red — adjusts the image’s red saturation.  Adjustment range is 0 to 100.   

• Green — adjusts the image’s green saturation.  Adjustment range is 0 to 100.   

• Blue — adjusts the image’s blue saturation.  Adjustment range is 0 to 100.   

• Invert — inverts all image colors.     

• Hue — adjusts the image’s hue, by rotating color vectors throughout the 360 
degree color spectrum.   
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- - - - - -  STROBE  - - - - - -

Mode Off

Interval (frames) 2

Note When adjusting PIPs, you can also access the Image Effects 
Menu from the Border Menu or the Shadow Menu by 
pressing {EFX}.

When adjusting Keys, you can also access the Image Effects 
Menu from the Key Adjustment Menu or the Matte Menu by 
pressing {EFX}.

Note The Red, Green and Blue adjustments work whether or not 
Monochrome Mode is enabled.

Tip For a sepia tone effect, turn Monochrome Mode on, and set 
Red to 100, Green to 65 and Blue to 10.
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• Mode — In the “Strobe” section, enables or disables the strobe mode which when 
enabled, acts as a programmable freeze.    

• Interval (frames) — In the “Strobe” section, sets the freeze interval.   

• Press {RESET RGB} to reset all image colors to their default values.

• Press {PIP} to return to the PIP Adjustment Menu.  Refer to the “PIP 
Adjustment Menu Functions” section on page 149 for details.

• Press {BORDR} to display the Border Menu.  Refer to the “Border Menu” 
section on page 151 for details.

• Press {SHDOW} to display the Shadow Menu.  Refer to the “Shadow Menu” 
section on page 152 for details.  

Note To remove any image effects from the PIP or Key, press the 
RESET button in the Layer Functions Section — while the 
Image Effects Menu is active.  No other PIP parameters will 
be affected.
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The following topics are discussed in this section: 

• Key Menu Tree

• Key Menu Description

• Key Menu Functions

• Key Sub Menus

hÉó=jÉåì=qêÉÉ
The figure below illustrates the Key Menu Tree:

Figure 4-55.  Key Menu Tree

All functions and sub menus are discussed in the following sections. 
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The figure below illustrates a sample Key Menu, when Luma key is selected:

Figure 4-56.  Key Menu  (sample)

The Key Menu provides tools to adjust the “active” key.  To access the menu:

• Press LAYER A or LAYER B in the Layer Control Section, then ...

• Press the KEY button in the Layer Function Section. 

hÉó=jÉåì=cìåÅíáçåë
The available Key Menu functions change, depending upon the type of key selected.

• Key Type — enables you to choose the type of key:  

~ Choose between Luma or Color when the Mix Mode is enabled (Split 
button is off).  

~ Choose between Luma, Color, or Cut + Fill when Split Mode is enabled 
(Split button is on).    

Refer to the following sections for details.

• Luma Key Functions

• Color Key Functions

• Cut + Fill Key Functions
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A Luma (luminance) key is one in which the hole-cutting information is derived from the 
luminance (brightness) level of the key source.  

The following Key Menu functions are provided when Luma key is selected:

• Invert Mode — enables you to invert the key signal.

• Clip — adjusts the threshold of the video that electronically “cuts” into the 
background image.  A hole will be cut into the background anywhere that 
foreground luminance is greater than the clip level.  The hole is then filled with the 
Fill Source.  Adjustment range is 0 to 1023.

• Gain — adjusts the sensitivity of the keyer, enabling you to change the sharpness 
of the keyed image.  Gain only affects the key hole, as set by the clip.  Adjustment 
range is 0 to 1023.99.

• Opacity — enables you to adjust the opacity of the keyed image, from fully 
opaque to fully transparent.  Adjustment range is 0 to 1024.

• Fill Source — determines the video that fills the key hole:

~ Self — fills the hole with the key source video itself, for example, the 
video from a character generator or logo.

~ Matte — fills the hole with a color, which can then be adjusted with the 
Matte Menu.  

• Press {STATS} to display the Status Menu.  Refer to the “Status Menu” section 
on page 147 for details.

• Press {EFX} to display the Image Effects Menu.  Refer to the “Image Effects 
Menu” section on page 153 for details.

• Press {MATTE} to display the Matte Menu.  Refer to the “Matte Menu” section on 
page 159 for details.

• Press {SIZE & POS} to display the Key Adjustment Menu.  Refer to the “Key 
Adjustment Menu” section on page 160 for details.

`çäçê=hÉó=cìåÅíáçåë
A Color key is one in which the hole-cutting information is derived from a specific RGB 
value — including luminance.  

The following Key Menu functions are provided when Color key is selected:

• Red Color — adjusts the red component of the selected key color, from 0 to 1024.

• Green Color — adjusts the green component of the key color, from 0 to 1024.

• Blue Color — adjusts the blue component of the key color, from 0 to 1024.

• Red Threshold — adjusts the key’s clip along the Cyan vector (as demonstrated  
using a CIE color chip chart).

Note Luma keys can be selected on both the Layer A and Layer B 
keyers, in both Split and Mix modes.

Note Color keys can be selected on both the Layer A and Layer B 
keyers, in both Split and Mix modes.
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• Green Threshold — adjusts the key’s clip along the Magenta vector. 

• Blue Threshold — adjusts the key’s clip along the Yellow vector

• Red Mask — adjusts the background mask to/from black along the Cyan vector.

• Green Mask — adjusts background mask to/from black along the Magenta vector.

• Blue Mask — adjusts background mask to/from black along the Yellow vector.

• Opacity — adjusts the opacity of the keyed image, from fully opaque to fully 
transparent.  Adjustment range is 0 to 1024. 

• Press {STATS} to display the Status Menu.  Refer to the “Status Menu” section 
on page 147 for details.

• Press {EFX} to display the Image Effects Menu.  Refer to the “Image Effects 
Menu” section on page 153 for details.

• Press {PICK COLOR} to choose the keying color visually.  Once pressed, the 
{GRAB COLOR} label appears, and a crosshair appears on Preview.  Use the 
Joystick to move the crosshair around the Preview monitor as desired.

• Press {GRAB COLOR} to select the color directly underneath the crosshair.  
These values are immediately mapped into the Red, Green and Blue color fields 
on the menu, and can be adjusted with the knobs in the normal manner. 

• Press {SIZE & POS} to display the Key Adjustment Menu.  Refer to the “Key 
Adjustment Menu” section on page 160 for details.

`ìí=H=cáää=hÉó=cìåÅíáçåë
A Cut + Fill key is one in which the hole-cutting information is provided by a Key on Layer 
B, while the fill information is provided by the effect on Layer A (either a PIP or a Key).  

Cut + Fill functions are identical to those available when a Luma Key is selected.  Refer to 
the “Luma Key Functions” section on page 157 for details.

In Chapter 6, refer to the “Working with Layers” section on page 226 for instructions on 
using all types of keys.

hÉó=pìÄ=jÉåìë
The following sub menus can be accessed from the Key Adjustment Menu:

• Matte Menu

• Key Adjustment Menu

Note Cut + Fill keys can only be selected on Layer B when the 
Split Mode is enabled.
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From the Key Menu, press {MATTE} to display the Matte Menu.  

Figure 4-57.  Matte Menu  (sample)  

The Matte Menu enables you to adjust the fill color of a matte key.  The following functions 
are provided:  

• Red — adjusts the red component of the matte fill as required, from 0 to 1024.

• Green — adjusts the green component of the matte fill, from 0 to 1024.

• Blue — adjusts the blue component of the matte fill, from 0 to 1024.

• Press {STATS} to display the Status Menu.  Refer to the “Status Menu” section 
on page 147 for details.

• Press {KEY} to display the Key Menu.  Refer to the “Key Menu Description” 
section on page 156 for details.

• Press {EFX} to display the Image Effects Menu.  Refer to the “Image Effects 
Menu” section on page 153 for details.

• Check {TRACK RGB} to lock RGB values together, and adjust them all 
simultaneously.  Uncheck to unlock the values, and adjust colors individually.

• Press {SIZE & POS} to display the Key Adjustment Menu.  Refer to the “Key 
Adjustment Menu” section on page 160 for details.  

• Press {MIN} (if present) to change the highlighted color to 0.

• Press {MAX} (if present) to change the highlighted color to 1023.

• Press {BLACK} (if present) to change all three colors to 0.
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Note The menu (and slight variations of the menu) can also be 
accessed from the DSK Adjustment Menu and the BG Input 
Setup Menus.  The menu’s “title” on the top line will change 
accordingly.  
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From the Key Menu, press {SIZE & POS} to display the Key Adjustment Menu.

Figure 4-58.  Key Adjustment Menu  (sample)

The Key Adjustment Menu is virtually identical to the PIP Adjustment Menu — except 
that it pertains to Keys rather than PIPs.  The following functions are provided:  

• H Size — adjusts the Key’s horizontal size in pixels.  The “%” value indicates the 
key’s size as a percentage of the screen’s horizontal resolution.  The numeric 
value is the Key’s width in pixels.  To adjust, use the ADJ knob or the Joystick’s Z-
Axis knob.  

• V Size — adjusts the Key’s vertical size in pixels.  The “%” value indicates the 
Key’s size as a percentage of the screen’s vertical resolution.  The numeric value 
is the Key’s height in pixels.  To adjust, use the ADJ knob or the Joystick’s Z-Axis 
knob.

• H Position — indicates the Key’s position, relative to the horizontal center of the 
screen (00), as measured from the exact center of the Key.  Thus, the value -160 
is 160 pixels to the left of center.  To adjust, use the ADJ knob or move the 
Joystick left and right. 

• V Position — indicates the Key’s position, relative to the vertical center of the 
screen (00), as measured from the exact center of the Key.  Thus, the value 64 is 
64 pixels above center.  To adjust, use the ADJ knob or move the Joystick up and 
down.  

• Move Rate — adjusts the rate (in 0.1 second increments) for programmed Key 
movement, from key frame to key frame.  To adjust, use the ADJ knob or twist the 
Joystick Z-Axis knob.  

• Key Frame Effect — indicates the “motion type” that is used to move the Key 
from point to point.  
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OPERATION:

JOY Z to SIZE.  X Y TO POSITION

Note Only the Linear motion type is supported.  All other key frame 
effects are ignored by ScreenPRO-II destinations. 
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• Press {STATS} to display the Status Menu.  Refer to the “Status Menu” section 
on page 147 for details.

• Press {KEY} to display the Key Menu.  Refer to the “Key Menu Description” 
section on page 156 for details.

• Press {MATTE} to display the Matte Menu.  Refer to the “Matte Menu” section on 
page 159 for details.

• Press {EFX} to display the Image Effects Menu.  Refer to the “Image Effects 
Menu” section on page 153 for details.

• At the bottom of the Key Adjustment Menu, the {TRACK SIZE} check box has 
the following functions:

~ Check the {TRACK SIZE} check box to lock H Size and V Size together.  
Regardless of the Key’s current aspect ratio, its size will adjust 
proportionally when the Joystick’s Z-Axis knob or the ADJ rotary knob is 
used to change size.

~ Uncheck the {TRACK SIZE} check box to adjust H Size or V Size 
individually, without affecting the other parameter.  In this way, you can 
stretch the Key horizontally or vertically.

Please note the following related functions:

• To return the Key to its default size and aspect ratio, press the RESET button in 
the Joystick Section.

• To adjust the Key with fine resolution, press the FINE ADJUST button in the 
Joystick Section.
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Press CLONE to display the Clone Setup Menu.

Figure 4-59.  Clone Setup Menu  (sample)

The Clone Menu enables you to set up parameters for a cloned layer.  Please note:

• The mode can only be enabled when a widescreen destination is selected. 

• The mode cannot be enabled if the PIP or Key straddles any part of the center of 
the overall widescreen.

• Both PIPs and Keys can be cloned.

• You can perform a Move in conjunction with a cloned layer.

The following functions are provided:  

• Destination — displays the currently selected destination.

• Clone Type — sets the type of clone “motion.”

~ Offset — both images move together with a fixed pixel offset between 
the two.  For example, if you adjust H Position, both images move left 
and right.  If you adjust V Position, both images move up and down.

Figure 4-60.  Clone Offset Mode
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~ Mirror — both images move together as if a mirror is positioned in the 
middle of the widescreen overlap region.  For example, if you adjust H 
Position, both images move towards (and away from) the center of the 
widescreen.  

Figure 4-61.  Clone Mirror Mode

• Offset — if “Offset” is selected on the Clone Type line, this field enables you to 
set the offset (in pixels).  If “Mirror” is selected, the field is hidden.

PIP A Cloned 
PIP A
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Crop Menu
`êçé=jÉåì
With a PIP or Key selected, press Crop (in the Joystick Section) to display the Crop 
Menu, as shown in the sample below.

Figure 4-62.  Crop Menu  (sample)

The Crop Menu enables you crop the sides of a PIP or a Key without affecting the size of 
the source image.  The menu works with the Top Left and Bottom Right buttons:

• When Top Left is enabled, the menu adjustments only affect the top and left sides 
of the PIP or Key.  The legend on the menu’s top line reads TOP-LEFT.

• When Bottom Right is enabled, menu adjustments only affect the bottom and 
right sides of the PIP or Key.  The legend on the top line reads BOTTOM-RIGHT.

• When the Top Left and Bottom Right buttons are off, menu adjustments affect all 
sides of the PIP or Key.  The legend on the top line reads ALL-SIDES. 

The following functions are provided:  

• H Size — adjusts the PIP or Key’s horizontal size.  The “%” indicates size as a 
percentage of the screen’s horizontal resolution.  The value is the width in pixels.  

• V Size — adjusts the PIP or Key’s vertical size.  The “%” indicates size as a 
percentage of the screen’s vertical resolution.  The value is the height in pixels.    

• Mode — in the Aspect Ratio section, this function selects one of several 
standard aspect ratios:  16:9, 5:4, 4:3, 3:2 and 1:1.

• Ratio — displays the corresponding ratio based on the selected Mode (1.777, 
1.25, 1.333, 1.500, 1.000) and enables you to select custom aspect ratios.

• Enable the {TRACK SIZE} check box to proportionally crop H Size and V Size.  
Disable the function for individual parameter adjustments.

- - - - Aspect Ratio - - - -

Mode

V Size  < 50.0%  >

Ratio

512

1.333

H
O
M
E

N
A
V

OPERATION:

JOY Z TO CROP SIZE

4:3

A
D
J

CROP ADJUSTMENT ALL-SIDES

H Size  < 53.3%  > 682

S
T
A
T
S

TRACK SIZE

Note To remove any crop effects from the PIP or Key, press the 
RESET button in the Joystick Section — while the Crop 
Menu is active.  No other parameters will be affected.
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Source Adjustment Menus
pçìêÅÉ=^ÇàìëíãÉåí=jÉåìë
The following topics are discussed in this section:

• Source Adjustment Menu Trees

• Source Adjustment Menu Description

• Source Adjustment Menu Functions
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Source Adjustment Menus
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The figure below illustrates the two Source Adjustment Menu Trees.

Figure 4-63.  Source Adjustment Menu Trees

All functions and sub menus are discussed in the following sections.
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KEY SOURCE
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MENU

STATS
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Key Frame Effect
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KEY
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SIZE & 
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Key
Menu

KEY MATTE

Image Effects
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Source Adjustment Menus
pçìêÅÉ=^ÇàìëíãÉåí=jÉåì=aÉëÅêáéíáçå
Two similar Source Adjustment Menus are available:

• If a PIP is selected, press Source (in the Joystick Section) to display the Input 
Source Adjustment Menu.

• If a Key is selected, press {SIZE & POS} on the Key Menu to access the Key 
Adjustment menu, then press Source (in the Joystick Section) to display the 
Key Source Adjustment Menu.

Both menus are virtually identical in their functionality, with the exception of the available 
branches.  The figure below illustrates a sample Input Source Adjustment Menu:

Figure 4-64.  Input Source Adjustment Menu  (sample)

The figure below illustrates a sample Key Source Adjustment Menu:

Figure 4-65.  Key Source Adjustment Menu  (sample)

H Position

V Position

V Size  < 100.0%  > 475

0

H
O
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E

N
A
V

INPUT SOURCE ADJUSTMENT

B
O
R
D
R

0

A
D
J

S
H
D
O
W

E
F
X

Move Rate 2.0

Key Frame Effect [ Linear ]

H Size  < 100.0%  > 640

TRACK SIZE

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - 

OPERATION:

JOY Z TO SIZE, X Y TO POSITION

H Position

V Position

V Size  < 0.3%  > 1024

0

S
T
A
T
S

N
A
V

KEY SOURCE ADJUSTMENT

K
E
Y 0

A
D
J

M
A
T
T
E

E
F
X

Move Rate 2.0

Key Frame Effect [ Linear ]

H Size  < 1.9%  > 1280

TRACK SIZE

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - 

OPERATION:

JOY Z TO SIZE, X Y TO POSITION
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Source Adjustment Menus
As shown in the samples above, the two menus are virtually identical — and also virtually 
identical to the PIP and Key Adjustment menus.  The exception is that the two Source 
adjustment menus pertain to the source “inside” the PIP or Key — rather than the 
boundaries of the PIP or Key itself.  

In this way, for example, a PIP can remain in its exact location on screen, but you can scale 
or re-position the image inside the PIP.

pçìêÅÉ=^ÇàìëíãÉåí=jÉåì=cìåÅíáçåë
The following Source Adjustment Menu functions are provided:

• H Size — adjusts the source’s horizontal size in pixels.  The “%” value indicates 
the source’s size as a percentage of the original PIP or Key’s horizontal resolution.  
The numeric value is the source’s width in pixels.  To adjust, use the ADJ knob or 
the Joystick’s Z-Axis knob.  

• V Size — adjusts the source’s vertical size in pixels.  The “%” value indicates the 
size as a percentage of the original PIP or Key’s vertical resolution.  The numeric 
value is the source’s height in pixels.  To adjust, use the ADJ knob or the 
Joystick’s Z-Axis knob.  

• H Position — indicates the source’s horizontal position, relative to its default 
horizontal position (00) with no offset.  Thus, the value 50 is 50 pixels to the right 
of its default position.  To adjust, use the ADJ knob or move the Joystick left and 
right. 

• V Position — indicates the source’s vertical position, relative to its default vertical 
position (00) with no offset.  Thus, the value -10 is 10 pixels below its default 
position.  To adjust, use the ADJ knob or move the Joystick up and down.  

• Move Rate — adjusts the rate (in 0.1 second increments) for programmed Key or 
PIP movement, from key frame to key frame.  To adjust, use the ADJ knob or twist 
the Joystick Z-Axis knob.  

• Key Frame Effect — indicates the “motion type” that is used to move the PIP or 
Key from point to point.  

• At the bottom of each menu, the {TRACK SIZE} check box has the following 
functions:

~ Check the {TRACK SIZE} check box to lock H Size and V Size together.  
Regardless of the PIP or Key’s current aspect ratio, its size will adjust 
proportionally when the Joystick’s Z-Axis knob or the ADJ rotary knob is 
used to change size.

~ Uncheck the {TRACK SIZE} check box to adjust H Size or V Size 
individually, without affecting the other parameter.  In this way, you can 
stretch the PIP horizontally or vertically.

For Input Source Adjustments:

• Press {BORDR} to display the Border Menu.  Refer to the “Border Menu” 
section on page 151 for details.

• Press {SHDOW} to display the Shadow Menu.  Refer to the “Shadow Menu” 
section on page 152 for details.

Note Only the Linear motion type is supported.  All other key frame 
effects are ignored by ScreenPRO-II destinations. 
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Source Adjustment Menus
• Press {EFX} to display the Image Effects Menu.  Refer to the “Image Effects 
Menu” section on page 153 for details.

For Key Source Adjustments:

• Press {STATS} to display the Status Menu.  Refer to the “Status Menu” section 
on page 147 for details.

• Press {KEY} to display the Key Menu.  Refer to the “Key Menu Description” 
section on page 156 for details.

• Press {MATTE} to display the Matte Menu.  Refer to the “Matte Menu” section on 
page 159 for details.

• Press {EFX} to display the Image Effects Menu.  Refer to the “Image Effects 
Menu” section on page 153 for details.

Please note the following related functions:

• To return the source to its default size and aspect ratio, press the RESET button in 
the Joystick Section.

• To adjust the source with fine resolution, press the FINE ADJUST button in the 
Joystick Section.
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4.  Menu Orientation
Background Input Setup Menu
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The BG (Background) Input Setup Menu enables you to set up and define background 
sources A and B.  For each background source, you can choose between a solid matte 
color, a DVI input or a captured frame grab (FG).  The menus change depending on the 
selected background “type.”  

To access the menu:

• Press BG A or BG B in the Controller’s Layer Control Section. 

~ If the selected background is already on Program, the BG Input Setup 
Menu will not appear.

~ If the selected background is not on Program, the menu appears.

The following topics are discussed in this section:

• Background Input Setup Menu Tree

• Shared Background Menu Functions

• Background Menu Functions — Matte Type

• Background Menu Functions — DVI Type

• Background Menu Functions — FG Type
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4.  Menu Orientation
Background Input Setup Menu
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The figure below illustrates the Background Input Setup Menu Tree.

Figure 4-66.  Background Input Setup Menu Tree

All functions and sub menus are discussed in the following sections.

BG INPUT SETUP
MENU

Key Type (FG)

HOME

BG
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SAVE
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HOME

RESET

SAVE

APPLY
FORMAT

Type (Matte)
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Destination

ID

SAVE
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Background Input Setup Menu
pÜ~êÉÇ=_~ÅâÖêçìåÇ=jÉåì=cìåÅíáçåë
The figure below illustrates a sample BG Input Setup Menu, showing shared functions: 

Figure 4-67.  BG Input Setup Menu  (sample)

The following functions are shared — regardless of the selected background type:

• Top Line — indicates the selected background:  BG_A or BG_B.

• Destination — displays the currently selected destination.  Note that different 
backgrounds can be assigned to different destinations.

• ID — displays the ID of the selected destination’s associated ScreenPRO-II.  Note 
that with wide screen destinations, the background for each ScreenPRO-II can be 
individually adjusted.  

• Type — selects the desired background type:

~ When MATTE is selected, a solid color can be used as the background.  
Refer to the “Background Menu Functions — Matte Type” section on 
page 173 for menu details.

~ When DVI is selected, a digital graphic from a computer or other DVI 
source can be used as the background.  Refer to the “Background 
Menu Functions — DVI Type” section on page 175 for menu details.

~ When FG_1, FG_2 or FG_3 is selected, a captured still frame can be 
used as the background source.  Refer to the “Background Menu 
Functions — FG Type” section on page 176 for menu details.

ID [ All ]

H
O
M
E

N
A
V

BG INPUT SETUP BG_A

DestinatDestination [ 1 ]

Type Matte

Important In a widescreen configuration, because the electronics on 
individual ScreenPRO-II units may not match from unit to unit, 
you may be required to adjust a ScreenPRO-II background 
individually — by first selecting a specific destination ID. 
172 ScreenPRO-II Controller  •  User’s Guide



4.  Menu Orientation
Background Input Setup Menu
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The figure below illustrates a sample BG Input Setup Menu when “Matte” is selected as 
the background type. 

Figure 4-68.  BG Input Setup Menu — Matte Type  (sample)

The following functions are provided for a Matte background:

• Press {MATTE} to display the BG Matte Menu.  Refer to the “BG Matte Menu” 
section on page 174 for details.

• Press {SAVE} to store all selected background settings.  

In Chapter 6, refer to the “Background Transitions” section on page 227 for operating 
instructions.
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Background Input Setup Menu
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From the BG Input Setup Menu, press {MATTE} to access the BG Matte Menu.

Figure 4-69.  BG Matte Menu  (sample)

The Background Matte Menu enables you to create a solid background matte color to use 
behind your PIPs and Keys.  Each ScreenPRO-II supports two separate matte colors — 
one for BG_A and one for BG_B.  

• Red — adjusts the red component of the background matte color, from 0 to 1023.

• Green — adjusts the green component of the background matte, from 0 to 1023.

• Blue — adjusts the blue component of the background matte, from 0 to 1023.

• Press {MIN} to change the highlighted color to 0.

• Press {MAX} to change the highlighted color to 1023.

• Press {BLACK} to change all three colors to 0.  

In Chapter 6, refer to the “Background Transitions” section on page 227 for operating 
instructions.

Green 204

B
A
C
K

N
A
V

A
D
J

BG MATTE

Red 528

Blue 260
M
I
N

M
A
X

BLACK

Note The default state is a black matte color.
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Background Input Setup Menu
_~ÅâÖêçìåÇ=jÉåì=cìåÅíáçåë=Ô=asf=qóéÉ
The figure below illustrates a sample BG Input Setup Menu when “DVI” is selected as the 
background type.  

Figure 4-70.  BG Input Setup Menu — DVI Type  (sample)

The following functions are provided for a DVI background:

• Format — this line performs two functions:

~ Displays the resolution that is automatically determined by the FORCE 
ACQUIRE function. 

~ Enables you to manually set the resolution of the incoming source, if 
desired.  Once the format is selected manually with the ADJ knob, press 
{APPLY FORMAT} to “accept” and activate the format.  

• For the two Crop settings:

~ If the source’s input resolution matches the output resolution, or if the 
output resolution is larger than the input resolution, the Crop settings will 
be bracketed.  

~ If the input data is smaller than the output resolution, the area around the 
active data is set to black.

~ If the source’s input resolution is larger than the output resolution, the H 
Offset and V Offset values can be used to choose which portion of the 
background you want to display.  

~ Press {RESET} to reset the H and V offsets to 0.  

• Press {SAVE} to store all selected settings.

• Press {APPLY FORMAT} to “activate” the selected format.

• Press {FORCE ACQUIRE} to automatically detect the input signal resolution and 
update the display Format field accordingly.  

Format 1024 x 768 @ 60
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BG INPUT SETUP BG_A
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FORMAT

FORCE
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S
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Crop:  H Offset [ 0 ]

V Offset [ 0 ]

ID All

Destinat

Destination [ 1 ]

Type DVI
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The figure below illustrates a sample BG Input Setup Menu when a captured frame grab 
(FG_1, FG_2 or FG_3) is selected as the background type.  

Figure 4-71.  BG Input Setup Menu — Frame Grab Type  (sample)

When FG_1, FG_2 or FG_3 is selected as the background type, a captured still frame can 
be used as the background.  This source type cannot be selected until one or more frames 
have been captured.  

• Press {SAVE} to store all selected settings.

Refer to the “Frame Grab Menu” section on page 142 for details on the Frame Grab 
Menu.  In Chapter 6, refer to the “Working with Still Frames” section on page 246 for 
frame grab instructions.
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DSK Menus
aph=jÉåìë
The following topics are discussed in this section:

• DSK Menu Tree

• DSK Adjustment Menu

• DSK Input Setup Menu

aph=jÉåì=qêÉÉ
The figure below illustrates the DSK Menu Tree.

Figure 4-72.  DSK Menu Tree

All functions and sub menus are discussed in the following sections.
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DSK Menus
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The DSK Adjustment Menu provides the tools necessary to adjust the DSK (Downstream 
Key.  To access the menu:

• Press {DSK} in the Layer Control Section.

The available DSK Adjustment Menu functions change, depending upon the selected 
“Key Type.”

• When Luma is selected, you can perform a luminance DSK.  Refer to the “DSK 
Luma Key Functions” section on page 178 for details.

• When Color is selected, you can perform a color DSK.  Refer to the “DSK Color 
Key Functions” section on page 179 for details.  

aph=iìã~=hÉó=cìåÅíáçåë
A Luma (luminance) key is one in which the hole-cutting information is derived from the 
luminance (brightness) level of the key source.  The figure below illustrates a sample DSK 
Adjustment Menu when Luma key is selected:

Figure 4-73.  DSK Adjustment Menu — Luma (sample)

The following DSK Adjustment Menu functions are provided when Luma is selected as 
the DSK type:

• Destination — displays the currently selected destination.  

• ID — displays the ID of the selected destination’s associated ScreenPRO-II.   

• Invert Mode — enables you to invert the DSK signal.

• Clip — adjusts the threshold of the video that electronically “cuts” into the 
background image.  A hole will be cut into the background anywhere that 
foreground luminance is greater than the clip level.  The hole is then filled with the 
Fill Source.  Adjustment range is 0 to 1023.

• Gain — adjusts the sensitivity of the keyer, enabling you to change the sharpness 
of the keyed image.  Gain only affects the key hole, as set by the clip.  Adjustment 
range is 0 to 1023.99.
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• Opacity — enables you to adjust the opacity of the keyed image, from fully 
opaque to fully transparent.  Adjustment range is 0 to 1024.

• Fill Source — determines the video that fills the DSK hole:

~ Self — fills the hole with the DSK source video itself, such as the video 
from a character generator.

~ Matte — fills the hole with a matte color, which can be adjusted with the 
DSK Matte Adjustment Menu.  Refer to the “Matte Menu” section on 
page 159 for details.

• Press {STATS} to display the Status Menu.  Refer to the “Status Menu” section 
on page 147 for details.

• Press {INPUT SETUP} to display the DSK Input Setup Menu.  Refer to the “DSK 
Input Setup Menu” section on page 180 for details.

aph=`çäçê=hÉó=cìåÅíáçåë
A Color key is one in which the hole-cutting information is derived from a specific RGB 
value — including luminance.  The figure below illustrates a sample DSK Adjustment 
Menu when Color key is selected:

Figure 4-74.  DSK Adjustment Menu — Color (sample)

The following DSK Adjustment Menu functions are provided when Color is selected as 
the DSK type:

• Destination — displays the currently selected destination.  

• ID — displays the ID of the selected destination’s associated ScreenPRO-II.  

• Red Color — adjusts the red component of the DSK color, from 0 to 1024.

• Green Color — adjusts the green component of the DSK color, from 0 to 1024.

• Blue Color — adjusts the blue component of the DSK color, from 0 to 1024.

• Red Threshold — adjusts the DSK’s clip along the Cyan vector (as demonstrated  
using a CIE color chip chart).

• Green Threshold — adjusts the DSK’s clip along the Magenta vector. 
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• Blue Threshold — adjusts the DSK’s clip along the Yellow vector

• Red Mask — adjusts the background mask to/from black along the Cyan vector.

• Green Mask — adjusts background mask to/from black along the Magenta vector.

• Blue Mask — adjusts background mask to/from black along the Yellow vector.

• Opacity — adjusts the opacity of the keyed image, from fully opaque to fully 
transparent.  Adjustment range is 0 to 1024. 

• Press {STATS} to display the Status Menu.  Refer to the “Status Menu” section 
on page 147 for details.

• Press {PICK COLOR} to choose the keying color visually.  Once pressed, the 
{GRAB COLOR} label appears, and a crosshair appears on Preview.  Use the 
Joystick to move the crosshair around the Preview monitor as desired.

• Press {GRAB COLOR} to select the color directly under the crosshair.  These 
values are immediately mapped into the Red, Green and Blue color fields on the 
menu, and can be adjusted with the knobs in the normal manner. 

• Press {INPUT SETUP} to display the DSK Input Setup Menu.  Refer to the “DSK 
Input Setup Menu” section on page 180 for details.

aph=fåéìí=pÉíìé=jÉåì
The figure below illustrates a sample DSK Input Setup Menu:

Figure 4-75.  DSK Input Setup Menu  (sample)

The following menu functions are provided:

• Destination — displays the currently selected destination.  

• ID — displays the ID of the selected destination’s associated ScreenPRO-II. 

• DSK Input — displays the input connector from which the DSK source is pulled.
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• Type — selects the desired DSK type:

~ When None is selected, the DSK circuitry for a selected ScreenPRO-II 
(as chosen with the ID field), can be turned off.  This selection is 
recommended, for example, when a DSK is only required on one of three 
screens (in a wide screen configuration), and when only a single head 
graphics card would be required for the “active” DSK source.

~ When DVI is selected, a digital graphic from a computer or other DVI 
source can be used as the DSK Source.  

Refer to the “Background Menu Functions — DVI Type” section on 
page 175 for menu details.  Note that the functions on the Background 
Input Setup Menu are identical to those on the DSK Input Setup Menu 
when DVI is selected.  

~ When FG_1, FG_2 or FG_3 is selected, a captured still image can be 
used as the DSK source.  

Refer to the “Background Menu Functions — FG Type” section on 
page 176 for menu details.  Note that the functions on the Background 
Input Setup Menu are identical to those on the DSK Input Setup Menu 
when FG_1, FG_2 or FG_3 is selected.  
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The figure below illustrates a sample LOGO Menu:

Figure 4-76.  LOGO Menu  (sample)

The LOGO Menu enables you to select the full screen source for the panel’s LOGO button.  
You can choose between the three internal frame stores (FG_1, FG_2 or FG_3), or black. 

Because the LOGO is the highest priority layer and downstream of all other effects, the 
“black” source can serve as a convenient way to fade all effects to black — without 
changing any of the image setups underneath the LOGO.  

To access the menu:

• Press the LOGO button in the Layer Control Section.

The following LOGO Menu functions are provided:

• Type — enables you to select still frames FG_1, FG_2, FG_3 or Black as the 
LOGO source.  Use the Frame Grab Menu to capture frames.  Refer to the 
“Frame Grab Menu” section on page 142 for details.  

• In the Temp FG Info section:

~ File Name — displays the selected still frame’s temporary storage 
register.

~ Resolution — displays the resolution of the selected still frame.

Once you have reviewed all of the sections in this chapter, please continue with Chapter 5, 
“System Setup” on page 183.
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Note On factory reset, “black” is the default LOGO source.  If you 
capture a frame and assign it as the LOGO source, that 
frame will be the default upon power up.  
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This chapter provides comprehensive instructions for setting up the ScreenPRO-II 
Controller system.  The following topics are discussed:

• Setup Prerequisites

• System Setup Sequence

• System Power Up

• Return to Factory Default

• Touch Screen Calibration

• Programming EDID

• Restore from Flash Memory Card

• Standard Destination Setup

• Router Setup

• AUX Destination Setup

• Input Patching

• Output Format Setup

• Sync Setup

• Genlock Setup

• Projector Setup

• Background Setup

• Input Setup

• DSK Setup Procedure

• LOGO Setup Procedure

• Saving the Setup

• Backup to Flash Memory Card

Note Once you have reviewed all of the sections in this chapter, 
please continue with Chapter 6, “Operations” on page 215.
ScreenPRO-II Controller  •  User’s Guide 183



5.  System Setup
Setup Prerequisites
pÉíìé=mêÉêÉèìáëáíÉë
Before starting to set up your ScreenPRO-II Controller system, please review the following 
important prerequisites:

• Ensure that you are familiar with all ScreenPRO-II Controller system hardware, 
including all Controller sections, and the functions of all buttons within the 
sections.  Refer to Chapter 2, “Hardware Orientation” on page 31 for details.

• Ensure that hardware is properly installed, and that all sources, routers and 
peripherals are properly connected.  Refer to Chapter 3, “Hardware Installation” 
on page 53 for details.

• If you will be using a widescreen configuration, ensure that all “Widescreen Lock” 
connections to/from BlendPRO-II are properly installed.  In Chapter 3, refer to the 
“BlendPRO-II Widescreen Lock Connections” section on page 77 for details.

• Ensure that you are familiar will all ScreenPRO-II Controller menus and sub-
menus.  Refer to Chapter 4, “Menu Orientation” on page 85 for details.

• Ensure that your connection charts are complete, and readily available for 
reference throughout this chapter.  In Chapter 3, refer to the “Connection Charts” 
section on page 56 for details.

Please note:

• In this chapter, when a procedure tells you to “scroll to” a certain line, use the 
rotary knob labelled NAV to move the highlight. 

• When a procedure tells you to “adjust” or “select” a certain parameter, use the 
ADJ rotary knob. 

Figure 5-1.  Menu Navigation
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This section provides a top level view of the entire ScreenPRO-II Controller setup 
procedure, plus links to each individual procedure.  

Preliminary steps:

1. “ID Setup and Remote Enable,” page 186. 

2. “System Power Up,” page 187.

3. “Return to Factory Default,” page 189.

Next, set up all menus under the MISC heading:

4. “Touch Screen Calibration,” page 189.

5. “Programming EDID,” page 190.

6. “Restore from Flash Memory Card,” page 191. 

Next, set up all menus under the System heading:

7. “Standard Destination Setup,” page 192. 

8. “Router Setup,” page 193.  

9. “AUX Destination Setup,” page 195. 

10. “Input Patching,” page 198. 

Next, set up all menus under the Output heading:

11. “Output Format Setup,” page 199.  

12. “Sync Setup,” page 200.  

13. “Genlock Setup,” page 201. 

14. “Projector Setup,” page 202. 

Set up all background inputs and primary sources:

15. “Background Setup,” page 205. 

16. “Input Setup,” page 206. 

17. “DSK Setup Procedure,” page 211. 

18. “LOGO Setup Procedure,” page 212. 

To complete your setup:

19. “Saving the Setup,” page 213. 

20. “Backup to Flash Memory Card,” page 213. 

All of the above procedures are covered in the following sections.

Important For the optimum ScreenPRO-II Controller system setup, it is 
recommended that you follow all procedures in the order 
outlined below.
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ScreenPRO-II Controller system setup:  Step 1.

In this procedure, you will set up individual ScreenPRO-II IDs and enable remote control. 
Each ScreenPRO-II in your system must have a unique ID.

Use the following steps to set up ScreenPRO-II IDs and remote control: 

1. On an individual ScreenPRO-II system, press {REMOTE CONTROL} on the 
Home Menu to access the Remote Control Menu.

2. Scroll to the Unit ID line, and select a unique ID for the ScreenPRO-II chassis.  
The ID range is 1 to 32.

3. Scroll to the Remote Control/DHCP line, and enable remote control and DHCP.  

4. Repeat steps 1 through 3 for all other ScreenPRO-II units in your system.

1

Note When remote control is on, the {HOME} buttons disappears, 
the ScreenPRO-II’s front panel is disabled, and the unit’s IP 
address is dynamically assigned.  All control now originates 
from the ScreenPRO-II Controller’s console.
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ScreenPRO-II Controller system setup:  Step 2.

In this procedure, you will power up the entire system, and download code (if required).

Use the following steps to power up your ScreenPRO-II Controller system:

1. Ensure that all individual ScreenPRO-II units are powered up.

2. Power up all routers in your system, and allows them to fully boot up.  These are 
your devices with static IP addresses.

3. Power up the ScreenPRO-II Controller, and allow it to fully boot up.  This is the 
system’s DHCP server.

4. If you will be using a widescreen configuration, power up the BlendPRO-II.

5. Power up all PresentationPRO-II units and ImagePRO units in your system.  This 
sequence enables the ScreenPRO-II Controller to “serve” IP addresses to the 
other peripherals.

6. Power up all additional peripherals, such as monitors and projectors.

7. Check the ScreenPRO-II Controller’s Status Menu, and ensure that all devices 
have been recognized.  By default, this menu should appear at power up.  If it is 
not shown, press STATUS on the Home Menu.  

8. Check code compatibility —  when the ScreenPRO-II Controller connects to the 
individual devices, it automatically checks the compatibility of the code versions.  

~ If the Controller’s code version matches that of the ScreenPRO-II units, 
PresentationPRO-II units and BlendPRO-II, the Status Menu is shown 
— and you do not need to download code.  

~ If the message “Checksum Mismatch” appears on the Status Menu, 
you must download code.  Please continue with the “Downloading 
Code” procedure on page 188.

~ If the Controller’s code version is incompatible with the code version of a 
ScreenPRO-II, PresentationPRO-II or BlendPRO-II (or a combination of 
units), all buttons will flash on the Controller console.  The Status Menu 
is shown with the message “Please Upgrade.”  Please continue with the 
“Downloading Code” procedure on page 188.

2
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When an incompatibility exists between software code versions, all buttons will flash on the 
Controller console.  In this situation, the Status Menu automatically appears with the 
message “Please Upgrade.”  

Use the following steps to download code from the Controller to the target device(s), 
including ScreenPRO-II, PresentationPRO-II and BlendPRO-II:

1. From the Controller’s Home Menu, press SYSTEM > {SW VER} to display the 
Software Version Menu.  Any incompatibilities will be listed. 

Figure 5-2.  Software Version Menu  (sample)

2. Press {DOWNLOAD CODE} to begin the download process, which takes several 
minutes to complete.

During the procedure, several “progress” messages will be shown.  When the entire 
procedure is complete, the Download Code Results Menu will display a summary of the 
download.  Please note:

• Results may appear on multiple pages.  

• If required, press {PG DN} and {PG UP} to move between pages.

• Press {DETAILS} to view additional information for a specific download. 

At the conclusion of the procedure, each ScreenPRO-II, PresentationPRO-II and 
BlendPRO-II is running the same version of code as the Controller.  
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Controller’s version
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Return to Factory Default
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ScreenPRO-II Controller system setup:  Step 3.

In this procedure, you will perform a factory reset — in order to reset all router tables and 
source mappings.  The procedure guarantees that any previous setups and presets (e.g., 
those that may have been programmed by other users), do not remain in system memory.

Prerequisite — Ensure that you are familiar with the System Reset Menu.  
In Chapter 4, refer to the “System Reset Menu” section on page 111.

Use the following steps to return the system to factory default values:

1. On the Home Menu, press SYSTEM to access the System Menu.

2. Press {RESET} to display the System Reset Menu. 

3. On the Device line and select ALL.

4. Scroll to the Reset Type line and select FACTORY.   

5. Press {RESET}.  When the confirmation screen appears, press {YES} to delete all 
user configurations and reset the system to factory default values.

qçìÅÜ=pÅêÉÉå=`~äáÄê~íáçå

ScreenPRO-II Controller system setup:  Step 4.

In this procedure, you will calibrate the Touch Screen.  

Prerequisite — Ensure that you are familiar with the LCD Settings Menu.  In 
Chapter 4, refer to the “LCD Settings Menu” section on page 139.

Use the following steps to calibrate the Touch Screen:

1. On the Home Menu, press MISC to access the Miscellaneous Menu.

2. Press {LCD SETTINGS} to show the LCD Settings Menu.

3. Press {LCD Cal} to display the first Touch Screen Calibration Menu.  

4. Follow the directions on the menu to complete the calibration procedure. 

3

4
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ScreenPRO-II Controller system setup:  Step 5 

In this procedure, you will program EDID (Extended Display Identification Data), as a 
prerequisite for background and DSK setup.  The procedure guarantees proper 
communications at the preferred resolution between each ScreenPRO-II’s DVI inputs and 
your system’s PCs.

Prerequisite — Ensure that you are familiar with the EDID DVI Input Format 
Menu.  In Chapter 4, refer to the “EDID DVI Input Format Menu” section on 
page 137.

Use the following steps to program each ScreenPRO-II’s EDID:

1. Ensure that ScreenPRO-II output format matches your projector’s native 
resolution.  In Chapter 4, refer to the “Output Menu Functions” section on 
page 102 for output format information.

2. Ensure that the computer(s) or external equipment that you wish to use as 
background and DSK source(s) are capable of supporting the selected output 
resolution.

3. Ensure that all DVI inputs to each ScreenPRO-II are disconnected.

4. On the Home Menu, press MISC to access the Miscellaneous Menu.

5. Press {EDID} to display the EDID DVI Input Format Menu.

6. On the Destination line, select the individual destination who’s EDID you wish to 
program, or select ALL if all destinations will be using the same resolution.

7. Note the Current line, which displays the current EDID video format that resides 
in memory.  If this format is already set to the desired resolution, no programming 
is required.  You can exit this procedure, and continue with other setup steps.

8. If a new resolution is required, scroll to the Format line and use the ADJ knob to 
select the preferred EDID format.  

9. Press {PROGRAM EDID}.  A warning message will be shown.  Press 
{CONTINUE} to continue with the procedure.

10. Once EDID programming is complete, reconnect each external computer and 
power it back on.  

11. On each PC’s desktop, right-click to display the Display Properties Window.  

12. Select the Settings Tab, and verify that the PC’s resolution matches that which 
you just programmed into EDID.  If not, set the resolution as required.

13. If you selected an individual destination in step 6, repeat steps 6 through 12 for 
each remaining destination.

5
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Restore from Flash Memory Card
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ScreenPRO-II Controller system setup:  Step 6 (optional)

In this procedure, you will restore your system configuration from flash memory — provided 
that you previously backed up your system to the flash memory card.

Prerequisite — Ensure that you are familiar with the Backup/Restore 
Menu.  In Chapter 4, refer to the “Backup/Restore Menu” section on 
page 141.

Use the following steps to restore your system from the flash memory card:

1. Ensure that your flash memory card is properly inserted in the Controller’s 
MEMORY CARD slot on the rear panel.

2. On the Home Menu, press MISC to access the Miscellaneous Menu.

3. Press {BACKUP RESTORE} to display the Backup/Restore Menu.

4. Press {CHECK CARD} to ensure that the Controller recognizes the card.

5. On the Device line, select Ctrlr+SP to perform a complete “restore.”

6. On the Controller Options line, select All. 

7. On the SP to Restore line, select All.

8. Press {RESTORE} to restore the selected system configuration.

At the conclusion of this procedure, your system is completely set up — exactly the way 
that you left it when you performed a complete system “backup.”  No further setup 
operations are required.  Please continue with system operations.  Refer to Chapter 6, 
“Operations” on page 215 for details. 

6
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ScreenPRO-II Controller system setup:  Step 7 

In this procedure, you will set up the system’s “standard” destinations (single screen and 
widescreen) on the Controller’s Destination Bus.

Prerequisites — Ensure that you are familiar with the Destination Setup 
Menu.  In Chapter 4, refer to the “Destination Setup Menu” section on 
page 117.   

Use the following steps to set up a single screen or a widescreen destination:

1. From the Home Menu, press SYSTEM to access the System Menu.

2. Press {DEST SETUP} to display the Destination Setup Menu.

3. Scroll to the Destination line and select the destination that you want to define — 
either 1, 2, 3 or 4.  

4. Scroll to the SP to Add line and select the ID of an available ScreenPRO-II.  If a 
ScreenPRO-II is already assigned to a destination, it will not appear in the list.  

5. Press {ADD} to add the highlighted ScreenPRO-II to the destination.  Once 
added, the ID will appear in the bottom portion of the menu.  Please note:

~ For a Single Screen configuration, add only one ScreenPRO-II.  Repeat 
from step 3 to define all remaining single screen destinations.

~ For a Wide Screen configuration, add as many ScreenPRO-IIs as 
required — up to the maximum of 4.  

6. If required, scroll to the SP to Remove line and select the ID of a ScreenPRO-II 
that you want to remove from the current configuration.   Press {REMOVE} to 
clear the ScreenPRO-II from the destination.    

7. Press {BACK} to return to the System Menu.  

8. Press {HOME} to return to the Home Menu.

9. Press {SAVE} to save the new system configuration in memory.

This completes the procedure for defining single and widescreen destinations.  The 
selected buttons on the Destination Bus are now active. 

7

Note Up to 4 “standard” destinations can be assigned (single 
screen and widescreen), but only 1 widescreen destination is 
allowed.

Note When there are no more ScreenPRO-IIs available to assign, 
the right-hand column displays N/A.

Important If the ScreenPRO-II Genlock Termination Menu appears 
after you press {BACK}, there is a termination switch 
problem.  In Chapter 4, refer to the “ScreenPRO-II Genlock 
Termination Menu” section on page 119 for details.
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ScreenPRO-II Controller system setup:  Step 8 

In this procedure, you will set up the system’s routing switchers.

Prerequisites — Ensure that you are familiar with the following menus:

~ Router Specification Menu.  In Chapter 4, refer to the “Router 
Specification Menu” section on page 127.

~ Comm Setup Menu.  In Chapter 4, refer to the “Comm Setup Menus” 
section on page 129.

~ Output Patch Menu.  In Chapter 4, refer to the “Output Patch Menu” 
section on page 132.

Use the following steps to set up your system’s routers:

1. Ensure that your router(s) are properly connected to the ScreenPRO-II Controller 
system.  In Chapter 3, refer to the “System Installation” section on page 73.

2. For Ethernet controlled routers, ensure that your router’s protocol is supported.  
The list of supported manufacturers currently includes the Folsom MatrixPro 
series, and routers from Sierra, Extron, Leitch, Isis, DVILink and DPI. 

3. For Ethernet controlled routers, ensure that you know each router’s IP address.  If 
required, preset IP addresses at the routers themselves.  Refer to each router’s 
User’s Guide for instructions.  

Please note that MatrixPRO routers default to the following IP addresses:

~ MatrixPRO Analog Router:  192.168.0.241

~ MatrixPRO SDI Router:  192.168.0.242

4. From the Home Menu, press SYSTEM to access the System Menu.

5. Press {ROUTER SETUP} to display the Router Specification Menu.

6. On the Number line, select the number of the router that you wish to configure.

7. On the Manufacturer line, select the router manufacturer.  

8. On the Router Type line, select the type of router being used.

9. On the Number of Inputs line, select the router’s input count.

10. On the Number of Outputs line, select the routers’ output count.

11. On the Communication Type line, select the type of communication that you are 
using to connect to the router. 

12. Press {COMM SETUP} to display the appropriate Comm Setup Menu for the 
selected device.  

13. For Ethernet controlled routers, verify that the IP Address field matches the 
router’s IP address.  If not, use the ADJ knob in conjunction with the {NEXT IP 
QUAD} button to change the address as required.

14. Test communications:

~ For serial and Ethernet controlled routers, press {TEST COMM}.

~ For Lantronix devices, press {DISCOVER LTRX}.  
If the message “Communication Failed” appears, take the necessary actions to 
rectify the error and repeat this step as required.

8
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15. Press {BACK} to return to the Router Specification Menu.

16. Press {OUTPUT PATCH} to display the Output Patch Menu for the selected 
router.  On the top line, note the router name and confirm that this is the router that 
you wish to patch.  

The table below illustrates the default output patch table (as configured after a 
factory reset).  The table is valid for both analog and digital routers.

If you have a Folsom MatrixPRO Router and you have connected the router 
outputs per the table above, no setup is necessary on the Output Patch Menu — 
unless you specifically want to patch the outputs in a different manner.  This 
“default” configuration is ideal for most single and widescreen applications.

17. To “custom” patch router outputs, use the following steps:

a. On the Router Output line, select the output that you want to patch.

b. If you are uncertain about the current patch, or if you want to remove the 
current (existing) patch and start clean, press {DELETE PATCH}.

c. On the Device ID line, select the ScreenPRO-II ID to which you want to 
patch the selected router output.

d. On the SP Input line, select the specific ScreenPRO-II input to which 
you want to patch the selected router output.

e. Press {ADD PATCH} to confirm your changes.  The new “mapping” 
appears on the menu.

f. Repeat step 17 to patch additional outputs.

18. To designate a router output as an “Aux” output:

a. On the Router Output line, select the specific router output that you 
want to designate as an Aux output.

b. If you are uncertain about the current patch, or if you want to remove the 
current (existing) patch and start clean, press {DELETE PATCH}.

c. On the Device ID line, select None.

d. Press {ADD PATCH} to confirm the change.

e. Repeat step 18 to designate additional Aux outputs.

19. Press {BACK} to return to the Router Specification Menu.

Table 5-1. Default Output Patch Table   

Router Output ScreenPRO-II ID
ScreenPRO-II Input 

(Analog or SDI)

1 1 1

2 1 2

3 2 1

4 2 2

5 3 1

6 3 2

7 4 1

8 4 2
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20. Repeat from step 6 for the next router that you wish to assign.

21. When you have configured all of your system’s routers, on the Router 
Specification Menu, scroll to the Number line, and scan through the remaining 
router numbers.  Other than the ones which you just assigned, if there are any 
router numbers that do not say <EMPTY> on the Number line, press {DELETE 
ROUTER} to remove the specification from the system.

22. Press {BACK} to return to the System Menu.

23. Press {HOME} to return to the Home Menu.

24. Press SAVE to save the current configuration.

^ru=aÉëíáå~íáçå=pÉíìé

ScreenPRO-II Controller system setup:  Step 9 

In this procedure, you will set up the system’s Aux (Auxiliary) destinations. 

Prerequisites — Ensure that you are familiar with the following menus:

~ Destination Setup Menu.  In Chapter 4, refer to the “Destination Setup 
Menu” section on page 117.

~ Aux Destination Setup Menu.  In Chapter 4, refer to the “Aux 
Destination Setup” section on page 120.   

The following topics are discussed:

• Aux Destination Overview

• Aux Destination Setup

• ImagePRO or PrePRO-II Aux Destination Setup

^ìñ=aÉëíáå~íáçå=lîÉêîáÉï
The ScreenPRO-II Controller system provides three types of Aux destinations — Aux, 
ImagePRO Aux and PrePRO-II Aux.  Each type of destination can be switched from the 
ScreenPRO-II Controller by selecting it on the Destination Bus, then selecting the desired 
source on the Source Selection Bus.

• An Aux destination is the output of a router, which is typically connected directly to 
a monitor — rather than to the ScreenPRO-II.  This type of destination is single 
format (e.g., an analog monitor can only accept signals from an analog router). 

• An ImagePRO Aux destination is an external ImagePRO, a multi-format 
processor with three inputs (one analog, one SDI and one DVI) and the ability to 
scale these inputs to one common output format.  Typically, the ImagePRO output 
is connected to another display device such as a monitor or projector.     

• A PrePRO-II Aux destination is an external PresentationPRO-II, a multi-format 
processor with nine inputs (eight analog and one SDI), and the ability to scale 
these inputs to one common output format. Similar to ImagePRO, the PrePRO-II 
output is connected to another display device such as a monitor or projector.

9

Note Up to 4 “Aux” destinations can be assigned.  These are 
accessible by pressing the red DEST AUX button.
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This section provides instructions for setting up an Aux destination.

Use the following steps to set up an Aux destination:

1. Ensure that your have properly configured one (or more) router outputs as “Aux” 
outputs.  If not, refer to the “Router Setup” section on page 193 for instructions.

2. From the Home Menu, press SYSTEM to access the System Menu.

3. Press {DEST SETUP} to display the Destination Setup Menu.

4. On the Destination line, select the Aux destination that you want to define — 
either Aux 1, Aux 2, Aux 3 or Aux 4.  

5. Scroll to the Type line and select Aux.  

6. Press {AUX SETUP} to display the Aux Setup Menu.  

7. On the Source Mapping line, two choices are available:

~ Select Input Patch if you want to map Aux sources according to how 
inputs are patched to buttons on the Source Selection bus.  Note that 
this is the typical choice.  

~ Select Direct Map if you want the Source Selection bus to be a 1:1 
mapping of your router inputs — for this Aux destination only.  

8. On the Router Name line, select the router on which you configured the Aux 
output(s).  

9. On the Router Output line, select the specific router output that you wish to 
designate as the Aux destination.  Note that only outputs configured as “Aux” will 
appear in the list.

10. Press {BACK} to return to the Destination Setup Menu.

11. Repeat from step 4 to configure additional Aux outputs.

12. Press {BACK} to return to the System Menu.

13. Press {HOME} to return to the Home Menu.

14. Press {SAVE} to save the new system configuration in memory.

This completes the procedure for defining Aux destinations.  The selected button(s) on the 
Destination Bus are now active. 

fã~ÖÉmol=çê=mêÉmolJff=^ìñ=aÉëíáå~íáçå=pÉíìé
This section provides instructions for setting up an ImagePRO Aux or PrePRO-II Aux 
destination.

Use the following steps to set up an ImagePRO or PrePRO-II Aux destination:

1. Ensure that your have properly configured one (or more) router outputs as “Aux” 
outputs.  If not, refer to the “Router Setup” section on page 193 for instructions.

2. From the Home Menu, press SYSTEM to access the System Menu.

3. Press {DEST SETUP} to display the Destination Setup Menu.

4. On the Destination line, select the Aux destination that you want to define — 
either Aux 1, Aux 2, Aux 3 or Aux 4.  

5. Scroll to the Type line and select ImagePRO Aux or PrePRO-II Aux.  

6. Press {AUX SETUP} to display the Aux Setup Menu.  
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7. On the Source Mapping line, two choices are available:

~ Select Input Patch if you want to map Aux sources according to how 
inputs are patched to buttons on the Source Selection bus.  Note that 
this is the typical choice.  

~ Select Direct Map if you want the Source Selection bus to be a 1:1 
mapping of your router inputs — for this Aux destination only.  

8. On the ID line, select the ID of the ImagePRO or PrePRO-II to which you want to 
route Aux sources.

9. In the Analog section:

a. On the Analog Router Name line, select the router from which analog 
sources will be routed to the ImagePRO (or PrePRO-II).

b. On the Analog Router Output line, select the specific router output that 
you designated as an Aux output. 

c. On the ImagePRO Input (or PrePRO-II Input) line, select the 
ImagePRO or PrePRO-II input to which the analog router output is 
connected.

10. In the SDI section:

a. On the SDI Router Name line, select the router from which SDI sources 
will be routed to the ImagePRO (or PrePRO-II).

b. On the SDI Router Output line, select the specific router output that you 
designated as an Aux output.

c. On the ImagePRO Input (or PrePRO-II Input) line, select the 
ImagePRO or PrePRO-II input to which the SDI router output is 
connected.

11. In the DVI section (applies to ImagePRO Aux destinations only):

a. On the DVI Router Name line, select the router from which DVI sources 
will be routed to the ImagePRO.  

b. On the DVI Router Output line, select the specific router output that you 
designated as an Aux output. 

c. On the ImagePRO Input line, select the ImagePRO input to which the 
DVI router output is connected.  

12. Press {BACK} to return to the Destination Setup Menu.

13. Repeat from step 4 to configure another ImagePRO or PrePRO-II Aux 
destination.

14. Press {BACK} to return to the System Menu.

15. Press {HOME} to return to the Home Menu.

16. Press {SAVE} to save the new system configuration in memory.

This completes the procedure for defining  ImagePRO or PrePRO-II Aux destinations.  The 
selected button(s) on the Destination Bus are now active.  Please note:

• For proper operation, ImagePRO and PrePRO-II devices must be connected to 
the ScreenPRO-II Controller via Ethernet.

• ImagePRO and PrePRO-II output setups must be performed locally on the units 
themselves.

• Only one router of each type (Analog, DVI and SDI) can be connected to an 
ImagePRO unit.
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ScreenPRO-II Controller system setup:  Step 10 

Prerequisites — Ensure that you are familiar with the Input Source Patch 
Menu.  In Chapter 4, refer to the “Input Source Patch Menu” section on 
page 125.

In this procedure, you will associate (patch) specific router inputs to specific source buttons 
on the ScreenPRO-II Controller, and assign tally connections as desired.  

The ScreenPRO-II Controller creates a unique “Input Patch Table” for each default router.  
After a factory reset, the table defaults to the following settings:

You may elect to use the “automatic” patches as shown above, or you can create custom 
patches as required for specific input configurations.  

Use the following steps to patch router inputs:

1. From the Home Menu, press SYSTEM to display the System Menu.  

2. Press {INPUT PATCH} to display the Input Source Patch Menu.

3. On the Source Number line, select the source button on the Controller that you 
want to patch.

4. On the Connection Type line, select the method by which the source is 
connected:

~ Select a router by name (e.g., MatrixPRO), or ...

~ Select an individual ScreenPRO-II ID, or ...

~ Select “ALL SP” to assume connections from D/As to similar inputs on 
all ScreenPRO-IIs in your configuration.

5. If you selected a router, on the Router Input line, select the physical router input 
that you wish to associate with the Controller’s source number.  

10

Important You may not need to change the input patches if you want to 
use those already contained in the default Input Patch Table.    

Table 5-2. Default input patch table after factory reset  

Router 
Number

Router
 Name

Router
Type

Router
Input Sources:

Map to Controller
Sources: Tally

1 MatrixPRO1 Analog 1 - 16 1 - 16 1 - 8 defined only

2 MatrixPRO2 SDI Undefined Undefined Undefined

Tip The same router input can be patched to one (or more) 
source numbers.  For example, if you want to use a DVD 
player in both 16:9 and 4:3 formats, patch it to inputs 8 and 16 
(the shifted source 8).  Using the input setup procedure, set 
up each input for the desired aspect ratio.
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6. If you selected an individual ScreenPRO-II ID or ALL SP, on the ScreenPRO-II 
Input line, select the specific input connector on the ScreenPRO-II.

7. On the Tally Number line, select the tally that you want to associate with the 
source button.  

8. Press {ADD PATCH} to confirm your changes.  

9. Repeat the procedure from step 3 to patch additional Controller buttons.

10. (Optional)  If required, press {DELETE PATCH} to clear all registers for a selected 
Controller input.  This enables you to start again with an “undefined” patch.

11. Press {BACK} to return to the System Menu.

12. Press {HOME} to return to the Home Menu.

13. Press {SAVE} to save the new system configuration in memory.  

lìíéìí=cçêã~í=pÉíìé

ScreenPRO-II Controller system setup:  Step 11 

Prerequisites — Ensure that you are familiar with the Output Menu.  In 
Chapter 4, refer to the “Output Menu Functions” section on page 102.

In this procedure, you will configure the output format for each ScreenPRO-II that is used in 
your ScreenPRO-II Controller system.  

Use the following steps to set up the ScreenPRO-II output format:

1. From the Home Menu, press OUTPUT to display the Output Menu.  

2. On the Destination Bus, select the destination that you want to configure.

3. On the Format line, select the resolution and frame rate at which you want to 
drive the destination’s projector(s).  To minimize synchronization problems, select 
a frame rate that is consistent with your input sources.

4. Press {APPLY FORMAT} to accept the selection. 

5. Repeat from step 2 to set additional destination output formats.  

6. Press {HOME} to return to the Home Menu.

7. Press {SAVE} to save the new system configuration in memory.

Important If you elect to use tallies, the optional Tally board must be 
installed, and relay connections must be run to the devices 
that you wish to tally.  In Appendix A, refer to the “Tally 
Connector” section on page 262 for connector pinouts. 

11

Important Be sure to select your projector’s native resolution and a 
frame rate that is consistent with your inputs — for example, if 
you are using 59.94 NTSC video inputs, run the output at the 
same rate in order to be synchronous.  
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ScreenPRO-II Controller system setup:  Step 12  

Prerequisites — Ensure that you are familiar with the Settings Menu.  In 
Chapter 4, refer to the “Settings Menu” section on page 104.

In this procedure, you will set up sync parameters for the monitors and projectors 
connected to the system — for the destination selected on the Output Menu.  

Use the following steps to set up sync parameters:

1. From the Home Menu, press OUTPUT to display the Output Menu.  

2. On the Destination Bus, select the destination that you want to configure.

3. Press {SETTINGS} to display the Settings Menu.

4. On the Output Monitor line, select the device(s) that are affected by the sync 
settings — All, Preview, SPII Program or BPII Program. 

5. On the Sync Out line, set the desired sync value — +H+V, -H-V, +H-V, -H+V or 
CSync. 

6. On the SOG line, select a specific “sync on green” signal — Off, Standard or Tri-
Level (for certain HD devices).  

7. On the Gamma line, set the output gamma for the selected destination.

8. On the Raster Box Size line, set the size of the raster box that appears around 
PIPs and Keys.  

9. Press {BACK} to return to the Output Menu.

10. Repeat from step 2 to set sync parameters for additional destinations.  

11. Press {HOME} to return to the Home Menu.

12. Press {SAVE} to save the new system configuration in memory.

12

Note It is recommended that you leave the sync parameters at their 
default (factory reset) values.  However, should you need to 
adjust individual settings for a particular monitor and projector 
configuration, use the following procedure.

Important It is recommended that you leave Gamma at the unity setting 
(1.0).  Change the value only if you need to compensate for a 
gamma problem in your projector or monitor.  

Note As required, you can change the Raster Box value during 
operations without affecting sync settings.
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ScreenPRO-II Controller system setup:  Step 13  

Prerequisites — Ensure that you are familiar with the Genlock Menu.  In 
Chapter 4, refer to the “Genlock Menu” section on page 103.

In this procedure, you will set up Genlock for each destination selected on the Output 
Menu.  Please note:

• For Single Screen Destinations — if you elect to connect an external genlock 
signal to ScreenPRO-II (and loop that signal from chassis to chassis), use this 
procedure to select the genlock “type” and verify the current setting of each 
ScreenPRO-II’s Termination Switch.   

• For Widescreen Destinations — if you elect to connect an external genlock 
signal to BlendPRO-II, use this procedure to select the genlock “type.”   

Use the following steps to set up Genlock:

1. From the Home Menu, press OUTPUT to display the Output Menu.  

2. On the Destination Bus, select the destination that you want to configure.

3. Press {GLCK} to display the Genlock Menu.

4. For all types of destinations, on the Source line, set the genlock source, either 
Black Burst, CSync or None.

5. For single screen destinations only, on the Termination line, verify the setting of 
the ScreenPRO-II’s Termination Switch.

6. Press {BACK} to return to the Output Menu.

7. Repeat from step 2 to set additional destination genlock types.  

8. Press {HOME} to return to the Home Menu.

9. Press {SAVE} to save the new system configuration in memory.

13

Important For Widescreen destinations, the Widescreen Lock and 
External Genlock signals must be set according to the 
procedures outlined in Chapter 3, in the “BlendPRO-II 
Widescreen Lock Connections” section on page 77.
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ScreenPRO-II Controller system setup:  Step 14  

Prerequisites — Ensure that you are familiar with the following menus and 
applications:

~ Test Pattern Menu.  In Chapter 4, refer to the “Test Pattern Menu” 
section on page 105.

~ Wide Screen Menu.  In Chapter 4, refer to the “Wide Screen Settings 
Menu” section on page 106.

~ Configurator Application.  You can use the Configurator application to 
assist with wide screen setup.  The software is available via download 
from the website, or contact Barco Technical Support.  In Appendix B, 
refer to the “Contact Information” section on page 268 for information.  

In this section, you will set up your projectors for both single screen and widescreen 
destinations.  The following procedures are provided:

• Single Screen Projector Setup

• Wide Screen Projector Setup

páåÖäÉ=pÅêÉÉå=mêçàÉÅíçê=pÉíìé
Use the following steps to set up a projector for a single screen destination:

1. From the Home Menu, press OUTPUT to display the Output Menu.  

2. On the Destination Bus, select the destination whose projector you want to 
configure.

3. Press {TEST PATTERN} to display the Test Pattern Menu.

4. On the Output Monitor line, select the output(s) on which you want a test pattern 
to appear — All, Preview, SPII Program or BPII Program.

5. On the Mode line, select On.

6. On the Type line, select the Burst test pattern.

7. On the Raster Box line, select On.

8. At the projector itself, perform the following adjustments to ensure that the output 
data from the selected device is properly displayed:

~ Adjust the image for a minimum amount of noise.

~ Adjust the pixel clock for proper image position, such that the entire 
Raster Box is visible.

9. On the Type line, select one of the many Gray Scale test patterns, as desired.

10. At the projector itself, adjust color balance, brightness and contrast.  

11. Once the projector is properly set, turn Off both the Raster Box and the Mode.

12. Press {BACK} to return to the Output Menu.

14

Important Refer to your projector’s technical manual for information on 
all projector setup and adjustment procedures. 
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13. Repeat from step 2 for additional single screen destination projector setups.

14. Press {HOME} to return to the Home Menu.

15. Press {SAVE} to save the new system configuration in memory.

táÇÉ=pÅêÉÉå=mêçàÉÅíçê=pÉíìé
Use the following steps to set up projectors for a wide screen application.  

1. If you elected to use the Configurator application to assist with your widescreen 
setup parameters, ensure that you have completed the following steps:

a. On the Configurator’s Show Layout Tab, click the radio buttons for the 
ScreenPRO-II Controller and your desired show layout.

b. On the Configurator’s Screen Details Tab, click the large “W” to display 
the Wide Screen Parameters Window.

c. In the Wide Screen Parameters Window, enter your screen’s H and V 
dimensions and the number of projectors.

d. Click Calculate to determine the required overlap.

e. Make a note of these values.  You will transfer them to the Controller’s 
Wide Screen Settings Menu in the following steps.

2. From the Home Menu, press OUTPUT to display the Output Menu.  

3. On the Destination Bus, select your system’s wide screen destination.

4. Press {TEST PATTERN} to display the Test Pattern Menu.

5. On the Output Monitor line, select the output(s) on which you want a test pattern 
to appear — All, Preview, SPII Program or BPII Program.

6. On the Mode line, select On.

7. On the Type line, select the Burst test pattern.

8. On the Raster Box line, select On.

9. Press {BACK} to return to the Output Menu.

10. Press {WIDE SCREEN} to display the Wide Screen Settings Menu.  Note that 
the Total Projectors line shows the total number of ScreenPRO-II units that you 
defined in the wide screen configuration (on the Destination Setup Menu).

11. Scroll to the Total H Res line and enter the total number of horizontal pixels in the 
overall wide screen display.  

12. Scroll to the Background Format line and select the method by which your 
background graphics were originally produced:  Edge-butted or Overlapped.

13. Scroll to the Marker Mode line and enable (or disable) the system’s wide screen 
markers, to show the boundaries of active data.  

Note This procedure affects all projectors assigned to the selected 
wide screen configuration.

Note As required, you can change the Marker Mode value during 
operations without affecting other wide screen settings.
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14. Scroll to the Overlap Width line and enter the desired overlap (in pixels) between 
projectors.  

15. Scroll to the Data Doubling line and enable or disable data doubling as required 
for your configuration.

16. Scroll to the Justification line and set the desired wide screen justification, either 
Center or Left.

17. In the Feathering section, scroll to the Mode line and enable or disable edge 
feathering as required for your configuration.

18. Scroll to the Gamma line and set the gamma for the feathered regions as desired.  
The default value is 2.2.

19. At each projector, perform the following adjustments to ensure that the output data 
is properly displayed:

~ Adjust the images for a minimum amount of noise.

~ Adjust the pixel clocks for proper image position, such that the entire 
Raster Box is visible.

20. Press {BACK} to return to the Output Menu.

21. Press {TEST PATTERN} to display the Test Pattern Menu.

22. On the Type line, select one of the many Gray Scale test patterns, as desired.

23. At each projector, adjust color balance, brightness and contrast.  

24. Once each projector is properly set, scroll to the Alignment Test Pattern line and 
enable the function.  This special test pattern allows you to perform projector lens 
shift and registration adjustments.

a. At each projector, perform lens shift and registration adjustments.

b. If required, adjust the horizontal and vertical “totals” to match those 
entered on the Wide Screen Settings Menu.

c. When adjustments are complete, turn off the Alignment Test Pattern.

25. Press {BACK} to return to the Output Menu.

26. Press {HOME} to return to the Home Menu.

27. Press {SAVE} to save the new system configuration in memory.

Important Refer to your projector’s technical manual for information on 
all projector setup and adjustment procedures. 

Note Refer to your projector’s technical manual for information on 
all lens shift and registration procedures. 
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ScreenPRO-II Controller system setup:  Step 15  

Prerequisites — Ensure that you are familiar with the following menus:

~ Background Input Setup Menu.  In Chapter 4, refer to the 
“Background Input Setup Menu” section on page 170.

~ BG Matte Menu.  In Chapter 4, refer to the “BG Matte Menu” section on 
page 174.

In this procedure, you will set up the Controller’s two “background” sources (for the BG A 
and BG B buttons).  Remember that each button can be configured as a live DVI input, as 
a matte color, or as a frame grab.   

Use the following steps to set up your background sources:

1. Determine how you would like to configure your background and DSK sources.  
As a recommendation, the following configuration is typically used:

~ The BG A input is configured as a live DVI source.

~ The BG/DSK Input B is used primarily as the DSK source, and 
secondarily as a background frame grab source.   

2. On the Destination Bus, select the destination whose background sources you 
want to configure.

3. On the ScreenPRO-II Controller console, press BG A to display the Background 
Input Setup Menu.  

4. To configure a matte background:

a. Scroll to the Type line and select Matte.

b. Press {MATTE} to display the BG Matte Menu.

c. Adjust the matte color as desired.

d. Press {BACK} to return to the Background Input Setup Menu.

e. Press {SAVE}.
5. To configure a live DVI background:

a. Ensure that your DVI source (PC) is properly connected to the 
ScreenPRO-II chassis, and that the PC is turned on.

b. Ensure that EDID is properly set.  If not, refer to the “Programming 
EDID” section on page 190 for details. 

c. Scroll to the Type line and select DVI.

d. Press {FORCE ACQUIRE}.

e. Press {SAVE}.

15

Note In both single and widescreen modes, remember that BG B 
and the DSK are mutually exclusive.  This occurs because 
the BG/DSK Input B is shared between the DSK and BG B 
on all individual ScreenPRO-II units.
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6. To configure a frame grab background:

a. Ensure that you have captured a still frame, either from a live DVI 
background or from one of the two layers (LAYER A or LAYER B).  In 
Chapter 6, refer to the “Working with Still Frames” section on page 246 
for instructions.

b. Scroll to the Type line and select FG_1, FG_2 or FG_3.

c. Press {SAVE}.
7. Repeat from step 3 for BG B.

8. Repeat from step 2 for the next destination’s background sources that you want to 
configure.

9. When all background sources have been configured for all destinations, press 
{HOME} to return to the Home Menu.

10. Press {SAVE} to save the new system configuration in memory.

fåéìí=pÉíìé

ScreenPRO-II Controller system setup:  Step 16 

Prerequisites — Ensure that you are familiar with the Input Menu.  In 
Chapter 4, refer to the “Input Menu” section on page 88.

In these procedures, you will set up the system’s inputs, and adjust phase and color 
balance for wide screen configurations only.  The following procedures are provided:  

• Standard Input Setup

• Widescreen Phase and Color Balance Setup

pí~åÇ~êÇ=fåéìí=pÉíìé
Use the following steps to set up inputs.  This procedure applies to both single screen 
and widescreen destinations. 

1. On the Destination Bus, select the destination whose inputs you want to 
configure.

2. On the ScreenPRO-II Controller console, select a layer (LAYER A or LAYER B).

3. Press {HOME} to display the Home Menu.

4. Press INPUT to display the Input Menu.  

5. On the Source Selection Bus, select the first source that you want to set up.   

6. Press {FORCE ACQUIRE} to perform the optimum image setup.

7. Perform additional setups on the Input Menu — if required:

a. If you need to manually set the resolution, scroll to the Format line and 
select the desired format.  Press {APPLY FORMAT} to accept.  

b. Scroll to the Sampling Mode line and set the sampling mode.

c. Scroll to the Contrast line and set the input’s contrast.  

d. Scroll to the Brightness line and set the input’s brightness.  

16
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e. Scroll to the Gamma line and set the input gamma.

f. Scroll to the Input Sync Type line and set the type of sync used by the 
selected source.  

g. Scroll to the Pulldown Compensation line and enable (or disable) the 
mode.

h. Scroll to the Sync Slice <mv> line and adjust as required.

i. Scroll to the Sharpness line and set the input’s sharpness.  

j. Press {SAVE} to save the input configuration.

8. Perform additional setups on the Aspect Ratio Menu — if required:

a. Press {AR} to display the Aspect Ration Menu.

b. Adjust the Mode and Ratio as required.

c. Press {SAVE} to save the input configuration.

d. Press {BACK} to return to the Input Menu.

9. Perform additional setups on the Sizing Menu — if required:

a. Press {SIZING} to display the Sizing Menu.

b. If 1:1 Sampling was selected:
• Scroll to the Clock Phase line and set the system’s A/D 

converter.
• Scroll to the H Total line and set the total pixel count per line.  
• Scroll to the H Active line and set the width of the active area.
• Scroll to the H Position line and set the start of the active 

area’s horizontal offset from H sync.
• Scroll to the V Active line and set the number of vertical lines in 

the image.  
• Scroll to the V Position line and set the start of the active area’s 

vertical offset from V sync.
• Press {SAVE} to save the input configuration.
• Press {BACK} to return to the Input Menu.

c. If Oversample was selected:
• Scroll to the Right Edge line and adjust as required.
• Scroll to the Left Edge line and adjust as required.
• Scroll to the Top Edge line and adjust as required.
• Scroll to the Bottom Edge line and adjust as required.
• Press {SAVE} to save the input configuration.  
• Press {BACK} to return to the Input Menu.

10. Perform additional setups on the Color Balance Menu — if required:

a. Press {COLOR BALANCE} to display the Color Balance Menu.

b. If an RGB source was selected:
• Scroll to the Red Contrast line and adjust as required.
• Scroll to the Red Brightness line and adjust as required.
• Scroll to the Green Contrast line and adjust as required.
• Scroll to the Green Brightness line and adjust as required.
• Scroll to the Blue Contrast line and adjust as required.
• Scroll to the Blue Brightness line and adjust as required.
• Press {SAVE} to save the input configuration.  
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• Press {BACK} to return to the Input Menu.

c. If a Composite, S-Video or YPbPr source was selected: 
• Scroll to the Saturation line and adjust as required.
• Scroll to the Hue line and adjust as required.  
• Press {SAVE} to save the input configuration.  
• Press {BACK} to return to the Input Menu.

11. Repeat from step 5 for the next source that you want to set up.

12. When all sources have been set up for this destination, press {HOME} to return to 
the Home Menu.

13. Press {SAVE} to save the new system configuration in memory.  

14. If required, repeat the entire procedure from step 1 for other destinations.

Important You do not have to repeat the input setup procedure for your 
other destinations if either of the following criteria are met:

• Your other destinations use sources that are patched 
to the same router.

• Your other destinations are configured using the “ALL 
SP” function on the Input Source Patch Menu.

In this case, all other system destinations will automatically 
receive input configuration files via the system’s “copy down” 
functionality.

You do have to repeat the input setup procedure if either of 
the following criteria are met:

• Your other destinations use a different router.

• Your other destinations use unique input patching.
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This section provides instructions for phase and color balance setup for wide widescreen 
destinations utilizing BlendPRO-II.  Please note the following important points:

• For the optimum setup, it is highly recommended that you can output a test 
pattern from each source — however, you can make adjustments using a live 
image if necessary.  For example, if the source is a PC, the best results can be 
achieved when a full screen test pattern can be generated on the desktop.  

• A test pattern application is available on the website (http://video.folsom.com).  
Click Downloads, select BlendPRO from the drop-down list, then download the 
Alignment Patterns application.

• The following “phase adjustment” steps apply to RGB and YUV analog sources.

• The following “color balance” steps apply to all types of analog sources — RGB, 
YUV, Composite and S-Video.  

• The following adjustment steps are not required for digital sources.  

mÜ~ëÉ=^ÇàìëíãÉåíë
Use the following steps to set up phase for widescreen destinations — for RGB and 
YUV sources only.   

1. Ensure that you have performed the “standard” setups for your sources.  If not, 
refer to the “Standard Input Setup” section on page 206 for details.

2. From the Home Menu, press SYSTEM to display the System Menu.

3. Turn the Modify Layers on Program function to On.

4. On the Destination Bus, select your widescreen destination.

5. On the ScreenPRO-II Controller console, select LAYER A.

6. On the Source Selection Bus, select the first source that you want to set up. 

7. Press PIP to display the PIP Adjustment Menu.

8. Ensure that the image’s border and shadow are turned off.  Use the Border Menu 
and Shadow Menu as required.

9. (Recommended)  Output a Burst test pattern from the selected source.

10. On the PIP Adjustment Menu, use H Size and V Size to size the PIP such that 
that it matches the input’s resolution.  In this way, there will be no scaling.

11. Press AUTO TRANS to transition the PIP to program.  This will ensure that you 
can make your adjustments with data doubling and edge feathering visible.

12. Using the H Position function, move the PIP into the screen 1 region. 

13. Press HOME > INPUT > {SIZING} to display the Sizing Menu for the source.

14. On the Destination line, select the “screen 1” destination.  

15. Adjust Clock Phase for the cleanest and brightest image.

16. If required, adjust H Position so that all of the image’s pixels are visible. 

17. Press PIP to display the PIP Adjustment Menu.  

Note These adjustments are primarily visual, rather than precisely 
numerical.  Here, for each destination, you are visually 
matching sources across your system’s scalers.
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18. Press {SAVE} to save the input configuration.

19. Move the PIP into the next screen’s region.

20. Repeat steps 13 through 19 for all remaining widescreen destinations.

21. When complete, clear the layer and transition it off program.

22. On the ScreenPRO-II Controller console, select LAYER B.

23. Repeat the entire procedure from step 6 — for the same source.

24. When you have completed setting up the first source for both layers, repeat the 
entire procedure from step 5 — for all remaining RGB and YUV sources that you 
want to set up.  Ensure that you set up both layers for each source.

`çäçê=_~ä~åÅÉ=^ÇàìëíãÉåíë
The following steps are a continuation of the complete widescreen source setup procedure.

Use the following steps to set up color balance for widescreen destinations — for all 
types of analog sources — RGB, YUV, Composite and S-Video.   

25. (Recommended)  Output a Gray Steps test pattern from the selected source.

26. On the ScreenPRO-II Controller console, select LAYER A.

27. On the Source Selection Bus, select the first source that you want to set up. 

28. Press PIP to display the PIP Adjustment Menu.  

29. Scale the source such that it spans all screens in your widescreen configuration.

30. Press AUTO TRANS to transition the PIP to program.  This will ensure that you 
can make your adjustments with data doubling and edge feathering visible.

31. Press HOME > INPUT to display the Input Menu for the source.

32. Visually, find the pair of adjacent destinations that most closely match each other 
across your widescreen blend regions.  Select one of these as your “reference” 
destination and the other as your first “adjustment” destination.  

33. On the Destination line, select the first “adjustment” destination.  

34. Adjust the source as follows:

a. On the Input Menu, adjust Brightness and Contrast to visually match 
the “reference” destination.

b. On the Color Balance Menu, adjust Red, Green, and Blue values to 
visually match the “reference” destination.  If a Composite or S-Video 
source was selected, adjust Saturation and Hue.  

c. Press {SAVE} to save the input configuration.

35. On the Destination line, select the next adjacent destination and repeat step 34 
— matching Brightness, Contrast and Color Balance across the blend region.

36. Repeat step 35 for all remaining destinations.

37. When complete, clear the layer and transition it off program.

38. On the ScreenPRO-II Controller console, select LAYER B.

39. Repeat the entire procedure from step 27 — for the same source.

40. When you have completed adjusting color balance for the first source for both 
layers, repeat the entire procedure from step 26 — for all remaining RGB, YUV, 
Composite and S-Video sources that you want to set up.  Ensure that you set up 
both layers for each source.
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ScreenPRO-II Controller system setup:  Step 17 

Prerequisites — Ensure that you are familiar with the following menus:

~ DSK Adjustment Menu.  In Chapter 4, refer to the “DSK Adjustment 
Menu” section on page 178.

~ DSK Input Setup Menu.  In Chapter 4, refer to the “DSK Input Setup 
Menu” section on page 180.

In this procedure, you will set up the system’s DSK.  Remember that the DSK can be 
configured as a live DVI input or as a frame grab.   

Use the following steps to set up your DSK source:

1. Determine how you would like to configure your background and DSK sources.  
As a recommendation, the following configuration is typically used:

~ The BG A input is configured as a live DVI source.

~ The BG/DSK Input B is used primarily as the DSK source, and 
secondarily as a background frame grab source.   

2. On the Destination Bus, select the destination whose DSK source you want to 
configure.

3. On the ScreenPRO-II Controller console, press DSK to display the DSK 
Adjustment Menu.  

4. Press {INPUT SETUP} to display the DSK Input Setup Menu.

5. To configure a live DVI input as the DSK:

a. Ensure that your DVI source (PC) is properly connected to the 
ScreenPRO-II chassis, and that the PC is turned on.

b. Ensure that EDID is properly set.  If not, refer to the “Programming 
EDID” section on page 190 for details. 

c. Scroll to the Type line and select DVI.

d. Press {FORCE ACQUIRE}.

e. Press {SAVE}.
6. To configure a frame grab DSK:

a. Ensure that you have captured a still frame, either from a live DVI 
background or from one of the two layers (LAYER A or LAYER B).  In 
Chapter 6, refer to the “Working with Still Frames” section on page 246 
for instructions.

b. Scroll to the Type line and select FG_1, FG_2 or FG_3.

c. Press {SAVE}.

7. Press {KEY} to return to the DSK Adjustment Menu.

17

Note In both single and widescreen modes, remember that BG B 
and the DSK are mutually exclusive.  This occurs because 
the BG/DSK Input B is shared between the DSK and BG B 
on all individual ScreenPRO-II units.
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8. On the Key Type line, select the type of key desired (Luma or Color).

9. Adjust key parameters as required:

~ For a Luma Key, adjust Invert Mode, Clip, Gain, Opacity and Fill 
Source for the optimum visual key.

~ For a color key, pick the desired color, then adjust Red, Green and Blue 
Color, Threshold, Mask and Opacity. 

10. When your DSK is fully adjusted, press {HOME} to return to the Home Menu.

11. Press {SAVE} to save the new system configuration in memory.

ildl=pÉíìé=mêçÅÉÇìêÉ

ScreenPRO-II Controller system setup:  Step 18  

Prerequisites — Ensure that you are familiar with the LOGO Menu.  In 
Chapter 4, refer to the “LOGO Menu” section on page 182.

In this procedures, you will set up the system’s LOGO.  Remember that the LOGO can be 
configured as black or as a frame grab.

Use the following steps to set up the LOGO:

1. On the Destination Bus, select the destination whose LOGO you want to 
configure.

2. On the ScreenPRO-II Controller console, press LOGO to display the LOGO 
Menu.  

3. To configure a black LOGO:

a. Scroll to the Type line and select Black.

4. To configure a frame grab LOGO:

a. Ensure that you have captured a still frame, either from a live DVI 
background or from one of the two layers (LAYER A or LAYER B).  In 
Chapter 6, refer to the “Working with Still Frames” section on page 246 
for instructions.

b. Scroll to the Type line and select FG_1, FG_2 or FG_3.

18
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ScreenPRO-II Controller system setup:  Step 19  

When all system setup procedures have been complete, press {HOME} to display the 
Home Menu, then press {SAVE}.  This action saves the state of the Controller in non-
volatile memory.  

Once pressed, the Touch Screen menu reads “Saving System Configuration.”  If you 
cycle power, the Controller will return to its state at the time of the “save.”  

_~Åâìé=íç=cä~ëÜ=jÉãçêó=`~êÇ

ScreenPRO-II Controller system setup:  Step 20  

Prerequisites — Ensure that you are familiar with the Backup/Restore 
Menu.  In Chapter 4, refer to the “Backup/Restore Menu” section on 
page 141.

In this procedure, you will back up your system configuration to a Flash Memory Card.   

Use the following steps to back up your system:

1. Ensure that you have a (customer supplied) Flash Memory Card available.

2. Insert the Flash Memory Card into the Controller’s rear panel Memory Card slot.

3. From the Home Menu, press MISC to display the Miscellaneous Menu.

4. Press {BACKUP RESTORE} to display the Backup/Restore Menu.  

5. On the Device line, select Ctrlr+SP to perform a complete “backup.”

6. On the Controller Options line, select All. 

7. Press {CHECK CARD} to check for the presence of a Flash Memory Card.  

8. Press {BACKUP} to perform a backup operation to the Flash Memory Card using 
the selected device(s) and options.  

19

20

Note You can only store one system configuration on a Flash 
Memory Card.
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This chapter includes operational instructions for all ScreenPRO-II Controller modes and 
functions.  The following topics are discussed:

• Prerequisites

• Operational Configuration

• Working with Destinations

• Working with Layers

• Working with Layer Functions

• Using Move

• Working with Transitions

• Working with Presets

• Working with Still Frames

• Using the DSK

• Using the LOGO

• Locking and Unlocking the Controller

• Working with Tallies

• Using Backup and Restore
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Prior to using the ScreenPRO-II Controller system, please ensure the following:

• All system inputs, backgrounds, the DSK and the LOGO are properly configured.  
In Chapter 5, refer to the following sections for details:

~ “Input Setup" on page 206.

~ “Background Setup" on page 205.

~ “DSK Setup Procedure" on page 211.

~ “LOGO Setup Procedure" on page 212.

• Ensure that you are familiar with all front panel controls.  In Chapter 2, refer to the 
“ScreenPRO-II Controller Front Panel" section on page 34 for details. 

• Ensure that you are familiar with all system menus, and in particular, the 
operational menus.  In Chapter 4, refer to the following sections for details:

~ Refer to the “PIP Adjustment Menu" section on page 148 for details on 
all PIP adjustment menu items.

~ Refer to the “Key Menu" section on page 155 for details on all Key 
adjustment menu items.

~ Refer to the “Source Adjustment Menus" section on page 165 for 
details on all input source adjustment parameters.  

Tip As you review each function, it is recommended that you try 
out (and practice) each feature at the ScreenPRO-II 
Controller itself — using a fully configured system consisting 
of Program and Preview monitors, projectors, and all the 
necessary sources and backgrounds. 

Note In this chapter, when a sequence of menu selections is 
required to complete a given procedure, the ">" symbol is 
used to divide each successive menu pick.  

Example:  To access the Genlock Menu, press 
{HOME} > {OUTPUT} > {GLCK}.
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The following topics are discussed in this section:

• Monitor Layout

• Touch Screen Calibration

• Lookahead Preview

• Understanding Raster Boxes

• A Word About LOS

• Setting User Preferences

• Understanding Input File Mapping

jçåáíçê=i~óçìí
Use the following diagram as a recommended layout for your monitors.  A sample dual-
screen widescreen configuration is shown.  

Figure 6-1.  Recommended Monitor Layout

For optimum viewing and utility, place your Preview monitors on the left, and your Program 
monitors on the right.

qçìÅÜ=pÅêÉÉå=`~äáÄê~íáçå
Touch Screen calibration is an excellent prerequisite to all operating procedures.

Use the following steps to calibrate your Touch Screen display:

1. If required, press {HOME} to display the Home Menu.

2. Press MISC to show the Miscellaneous Menu.

3. Press {LCD SETTINGS} to display the first LCD Settings Menu.  

4. Press {LCD Cal} to display the first Touch Screen Calibration Menu.  

5. Follow directions on screen to complete the calibration procedure. 

Preview – 
Screen 1

Preview – 
Screen 2

Program – 
Screen 1

Program – 
Screen 2
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If you are using a wide screen configuration, ensure that your Wide Screen Markers 
are enabled:  

1. From the Home Menu, press OUTPUT to display the Output Menu.

2. On the Destination Bus, select your system’s wide screen destination.

3. Press {WIDE SCREEN} to display the Wide Screen Settings Menu.  

4. Scroll to the Marker Mode line and enable the system’s wide screen markers, to 
show the boundaries of active data.  

In wide screen applications, Wide Screen Markers are thin vertical green lines at the 
edges of the screens that are used to denote the actual projected image area.  

Using edge feathering and data doubling, the BlendPRO-II provides perfect and seamless 
wide screen images.  Because of the required overlap, a portion of the original image is 
unused, and does not get projected.  The location of the unused portion depends on your 
selected justification — left or center. 

With each type of justification, the Wide Screen Markers accurately denote the unused 
portion, thus enabling you to properly compose your screens.

• Left Justified Markers

The figure below illustrates the Wide Screen Marker in a left justified 
configuration.  Images to the left of the green vertical line are projected.  Images to 
the right are not. 

Figure 6-2.  Wide Screen Marker, Left Justification

• Center Justified Markers

The figure below illustrates the two Wide Screen Markers in a center justified 
configuration.  Images between the two vertical green lines are projected.  Images 
outside of the lines are not. 

Figure 6-3.  Wide Screen Marker, Center Justification

Preview #2Preview #1

Preview #1 Preview #2

Wide
Screen
Marker

Preview #2Preview #1

Preview #1 Preview #2

Wide
Screen
Marker

Wide
Screen
Marker
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The ScreenPRO-II Controller uses a “lookahead” preview system that ensures the 
accuracy of all your transitions.  The “look” or appearance that you create on Preview 
represents the exact appearance of Program — after you transition the images to Program.

The illustration below represents a simple Preview-to-Program transition.  
SPLIT mode is on, enabling you to have two PIPs on screen simultaneously:

Figure 6-4.  Program-to-Preview Transition with Lookahead

• In frame 1, Program consists of a background and a single PIP. 

• In frame 2, a second PIP is selected and positioned on Preview.

• When CUT or AUTO TRANS is pressed, the PIP transitions to Program.  Frame 3 
represents the Program screen — identical to the Preview “look” in frame 2.

• Frame 4 represents Preview after the transition.  Preview will continue to match 
Program until you modify the preview image, in preparation for the next transition.

With these facts in mind, ensure that you always create the desired “next” look in Preview.  
In this manner, there won’t be any operational surprises:

• By using lookahead, you’ll always know visually what PIPs and keys you want to 
transition TO Program.

• Conversely, you’ll always know what PIPs and keys to you wish to clear — to 
visually remove elements FROM Program.  

   Background A

PIP A

   Background A

PIP A

PIP B

Program

Preview

    Background A

PIP A

PIP B

  

Preview

   Background A

PIP A

PIP B

CUT

1

2

3

4

AUTO
TRANS

Program
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With ScreenPRO-II Controller, Raster Boxes are always enabled on Preview, each PIP or 
Key is surrounded by a thin border that helps you identify the PIP or Key’s original layer.  

• The PIP or Key with a red “corner” style raster box is Layer A.  

• The PIP or Key with a red “dashed” raster box is Layer B.

Figure 6-5.  Raster Box Styles  (sample)

• The "blinking" raster box is always the one enabled for modification, and its 
corresponding layer button will blink. 

• Raster boxes that are underneath other layers (such as another PIP, the DSK or 
the LOGO) are still visible on Preview.   

Figure 6-6.  Raster Box Visibility  (sample)

Remember that Raster Box size can be adjusted:

1. From the Home Menu, press OUTPUT to display the Output Menu.

2. On the Destination Bus, select the destination that you want to configure.

3. Press {SETTINGS} to display the Settings Menu.

4. On the Raster Box Size line, set the size of the raster box that appears around 
PIPs and Keys.  

PIP A PIP B

PIP A

PIP B
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On rare occasion, you can experience LOS (loss of signal) — typically due to a poor video, 
graphics or computer connection.  In these cases, the ScreenPRO-II Controller obeys a 
precise set of rules for how to handle the signals:

• Scaler LOS — If there is a LOS for a video signal inside a scaler (PIP or KEY), 
the video switches to black, but the scaler remains in its current size and position.  

• Background LOS — If there is a LOS for a background DVI input, the video 
switches to the background’s selected matte color.    

• DSK LOS — If there is a LOS for the DSK, the system switches the DSK Off 
(specifically, selecting "none" as the type).    

In each case, when the video signal recovers, the system re-enables it as before.

pÉííáåÖ=rëÉê=mêÉÑÉêÉåÅÉë
Prior to operations, be sure to set user preferences as desired:

1. From the Miscellaneous Menu, press {USER PREF} to display the User 
Preference Menu.

2. On the Black Invalid Video line, select the method by which the scaler “loading” 
procedure is shown on Preview, when you change inputs:

~ Select ON to show black when scalers are loaded.  In addition, Black will 
be shown when a background channel (BG) becomes invalid, and the 
DSK will be turned off when source video becomes invalid.

~ Select OFF to show the full scaler loading procedure, which can 
temporarily include non-sync and non-stable video.  

råÇÉêëí~åÇáåÖ=fåéìí=cáäÉ=j~ééáåÖ
This section provides information on how the ScreenPRO-II Controller system stores the 
characteristics of each input in files, and how those files are used during operations.

During the input setup procedure, after adjusting each input parameter, pressing the 
{SAVE} button saves those characteristics in a file.  The file stores all definitions for that 
source alone, along with the associated destination.

From that point forward, each time you press that source button and assign it to a PIP or a 
Key, the stored file is recalled and the image appears on Preview (typically after a brief 
delay).  The delay occurs as each input is instantly re-scaled per the file’s instructions, and 
the scaler is instantly re-programmed with the file’s data.

With regards to router connections, an input file is independent of the physical connector. 
Even though only certain sources can be connected to specific connectors (e.g., Analog or 
SDI), once a connector is selected (on the Input Menu) and an input file is created for the 
source, that file can be recalled on any of the same type of connectors in the system, 
provided that a router is properly connected and assigned.  This in no way forces all of the 
other connectors to only accept that particular kind of source signal.
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Destinations can be configured as single screens, multiple screens (in wide screen 
applications), auxiliary router outputs, ImagePRO Aux destinations and PresentationPRO-II 
Aux destinations.  

• When single and wide screen (Projector) destinations are activated, Program 
output is routed to the selected projectors.

• When Aux destinations are activated, selected inputs (sources) can be routed to 
the selected router outputs, or to external devices (such as ImagePRO and 
PresentationPRO-II).

For destination setup instructions, refer to the following sections in Chapter 5:

• “Standard Destination Setup," page 192.

• “Router Setup," page 193.

• “AUX Destination Setup," page 195.

The following topics are discussed in this section:

• Activating Destinations

• Clearing Destinations

• Routing Sources to Destinations

^Åíáî~íáåÖ=aÉëíáå~íáçåë

Use the following steps to activate and deactivate destinations:

1. To activate a single Standard Destination, turn DEST AUX off, then press the 
desired button on the Destination Bus.  All other destinations will turn off.

2. To activate multiple Standard Destinations, turn DEST AUX off, then 
simultaneously press the desired buttons on the Destination Bus.  Any other 
active destinations will turn off.

3. To activate a single Aux Destination, turn DEST AUX on, then press the desired 
button on the Destination Bus.  All other Aux destinations will turn off.

4. To activate multiple Aux Destinations, turn DEST AUX off, then simultaneously 
press the desired buttons on the Destination Bus.  Any other active Aux 
destinations will turn off.

In each case, please note:

• Remember that destination buttons are not toggles.

• The selected buttons light when activated.  Any combination of active destination 
buttons can be selected.

• When you press a single button or a group of buttons, your selection is mutually 
exclusive with all other active destinations.  

• Press the All button to turn all destinations on.  

1

DEST
AUX

All
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Use the following steps to clear destinations:

1. To clear all destinations, double-punch the All button.

2. To clear a single destination (or multiple destinations) from an active group, turn 
DEST AUX on or off as desired, then simultaneously press the destinations that 
you want to remain on.

Destinations 1, 2 and 3 are active.  To clear destination 2, simultaneously 
press destinations 1 and 3. 

oçìíáåÖ=pçìêÅÉë=íç=aÉëíáå~íáçåë
When routing sources to both standard and Aux destinations, please note:

• Remember that the Destination/Aux Bus is one bus — it is not two separate and 
independent buses. 

• Any source that you select will apply to all enabled buses — even if that bus is not 
currently visible (due to the state of the DEST AUX button). 

• Any transition that you perform will apply to all enabled buses — even if that bus is 
not currently visible (due to the state of the DEST AUX button).

Use the following steps to route a source to a destination (or multiple destinations):

1. On the Destination/Aux Bus, enable or disable the DEST AUX button as 
desired.

2. Enable only the destination button(s) on which you want to pend a route.  

3. For "standard" destinations, select the desired layer (LAYER A or LAYER B).  
This step is not required for an Aux bus route.

4. On the Source Selection Bus, select the source that you want to route to the 
selected destination(s).    

5. Repeat steps 1 through 3 for additional source-to-destination combinations.

6. Enable all destinations that you want to transition. 

7. Perform the desired transition in the normal manner.  Once performed, the 
pending route is completed.  

All

Note At this point, the route is pending on Preview.  You are free to 
manipulate the source (e.g., PIP and Key), but the route will 
not occur until the destination is enabled, and the next 
transition is performed.

Note If you want to clear the pending route prior to performing it, 
simply clear the lit Aux destination(s).
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Following are several simple examples of source-to-destination routing:

Single source to single destination

Route Source 1 to Destination 1:

a. Turn DEST AUX off.

b. Press Destination 1.

c. Press LAYER A.

d. Select Source 1.

e. Press AUTO TRANS.

Single source to single Aux destination

Route Source 2 to Aux Destination 2:

a. Turn DEST AUX on.

b. Press Destination 2.

c. Select Source 1.

d. Press AUTO TRANS.

Single source to multiple destinations

Route Source 8 to Destinations 1, 2 and 3:

a. Turn DEST AUX off.

b. Press Destinations 1, 2 and 3 simultaneously.

c. Press LAYER A.

d. Select Source 8.

e. Press AUTO TRANS.

Multiple sources to multiple standard destinations 

Route Source 2 to Destination 1, and Source 3 to Destination 2:

a. Turn DEST AUX off.

b. Press Destination 1.

c. Press LAYER A.

d. Select Source 2.

e. Press Destination 2.

f. Press LAYER A.

g. Select Source 3.

h. Press Destinations 1 and 2 simultaneously.

i. Press AUTO TRANS.

Single source to multiple Aux and standard destinations 

Route Source 3 to Destinations 1 and 2, and Aux Destinations 1 and 2:

a. Turn DEST AUX off.

b. Press Destinations 1 and 2 simultaneously.

c. Press LAYER A.

d. Turn DEST AUX on.

e. Press Destinations 1 and 2 simultaneously.
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f. Select Source 3.

g. Press AUTO TRANS.

Multiple sources to multiple Aux and standard destinations 

Route Source 5 to Destinations 1 and 2, and Source 7 to Aux Destinations 3 
and 4:

a. Turn DEST AUX off.

b. Press Destinations 1 and 2 simultaneously.

c. Press LAYER A.

d. Select Source 5.

e. Double-punch the ALL button to clear all destinations.

f. Turn DEST AUX on.

g. Press Destinations 3 and 4 simultaneously.

h. Select Source 7.

i. Turn DEST AUX off.

j. Press Destinations 1 and 2 simultaneously.

k. Press AUTO TRANS.
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The following topics are discussed in this section:

• Switching Sources

• Background Transitions

• Understanding Split and Mix Modes

• Working with PIPs in Split Mode

• Working with PIPs in Mix Mode

• Modifying PIPs

• Working with Keys in Split Mode

• Working with Keys in Mix Mode

• Using Cut & Fill

• Modifying Keys

• Clearing Layers from Program

• Modifying Layers On Program

pïáíÅÜáåÖ=pçìêÅÉë
The Source Selection Bus allows you to choose the sources that are routed into PIPs and 
keys.  Please note:

• Use the SHIFT button to access sources 9 through 16.

• The SDI 1 and SDI 2 buttons are only active when a ScreenPRO-II is configured 
to use internal routing.  The buttons are disabled when external routing is used.

Use the following steps to switch sources into a PIP or a Key:

1. Press LAYER A or LAYER B in the Layer Control Section.  Note:

~ The button blinks to indicate that it is available for modification.  

~ The associated layer’s raster box blinks on Preview.

~ If a PIP or Key is assigned to the layer, its source can now be changed.

2. Press the desired button on the Source Selection Bus to assign that source to 
the PIP or Key.  The button blinks to indicate that it is active for modification.  

Please note the following important points regarding sources:

• When the Red LED above a source button is lit, the source is on Program — 
provided that its associated Destination button is active.

• When a source button is lit solid, the source is on Preview — but it is not active for 
manipulation.  Only blinking source buttons are active for modification.

• When the Red LED above a source button is blinking, the mixer is set to Mix 
Mode (the Split button is off).  The blinking Red LED indicates the layer that is on 
Program, and the alternate layer is enabled for modification.  

• Multiple sources can appear on Program and Preview simultaneously, but only 
one button can be blinking and active for modification on Preview.
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• If you select a layer in the Layer Control Section that is lit (but not blinking), it 
blinks — and the corresponding “assigned” source on the Source Selection Bus 
blinks.  This method also allows you to quickly verify layer/source selections.

_~ÅâÖêçìåÇ=qê~åëáíáçåë

Use the following steps to perform a transition from one background to another:

1. Press and light the background button to which you want to transition.  The button 
blinks to indicate it is active for modification on Preview.  Please note:

~ If the background is already on Program, the Background Input Setup 
Menu appears, but changes cannot be made.

~ If the background is not on Program, the Background Input Setup 
Menu appears and the background "type" can be changed.   

2. With the background button blinking and active for modification, select the type of 
background to which you want to transition.  Scroll to the Type line:

~ Select DVI to use an unscaled full-screen graphic.  Ensure that the DVI 
source is properly set up.  

~ Select MATTE to use a solid color.  Press {MATTE} to display the 
Background Matte Menu, and adjust the color as required.  In 
Chapter 4, refer to the "BG Matte Menu" section on page 174 for details.

~ Select FG_1, FG_2 or FG_3 to use a captured still frame as the 
background source.  Refer to the "Working with Still Frames" section 
on page 246 for details.  

3. Set the background toggle mode.  In the Layer Functions Section: 

~ Enable the Toggle button to toggle between the last two selected 
backgrounds on each transition.

~ Disable the Toggle button to retain the last selected background on the 
next transition. 

4. Perform the desired transition.

Please note the following important points regarding background transitions:

• If BG A is on Program and BG A is selected in Preview, there will be no change of 
backgrounds on the next transition.  The similar situation is true for BG B.

• If BG A is on Program and BG B is selected in Preview, BG A will transition to BG 
B on the next transition.    

BG
A

Note If you select Background B and a pop-up window alerts you 
to a resource conflict, the DSK is in use on Program.  The 
DSK must be cleared from Program before Background B 
can be used.
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The ScreenPRO-II Controller provides two different modes with which you can transition 
PIPs and Keys:  

• Split Mode

• Mix Mode

péäáí=jçÇÉ

With the Split button lit, the mixer’s two layers operate independently.  You can size, 
position, manipulate and transition the following combinations of effects:

• One or two PIPs

• One or two Keys

• One PIP and one Key

jáñ=jçÇÉ
With the Split button off, the mixer’s layers are ganged together, and two mutually-
exclusive sub-modes now determine the mixer’s function:  Mix Source and Swap.  

• With Mix Source mode enabled, both of the mixer’s PIPs or Keys are perfectly 
co-located.  Layer A and Layer B are exactly the same size — in exactly the same 
position — with exactly the same border and shadow.  This mode is ideal for 
transitioning images inside a static PIP.  Even though two identical PIPs are used, 
they visually appear as one.

• With Swap mode enabled, both of the mixer’s PIPs or Keys can be located 
independently, with different positions, sizes, borders and shadows.  Layer A and 
Layer B can be positioned and sized as desired — but only one can be on 
Program at a time.

  

With both Mix Source and Swap modes, one additional “transition” function can be used 
without restriction.  

• With Toggle mode enabled, sources toggle back and forth with each transition.  
When a PIP or Key source is selected in Preview and a transition is performed, 
the Program source “flip-flops” to Preview.  Subsequent transitions simply 
alternate between sources.  Any new source can be selected in Preview, and as 
long as Toggle is on, the last two selected sources will alternate.

• With Toggle off, the source selected in Preview stays in Preview, once the 
transition is complete.  In this mode, you must change Preview sources manually.  

Please note the following important points regarding Mix Mode:

• In Mix Mode, there is always a layer available In Preview for a new source to be 
selected and taken to Program.

• Four transition combinations are possible:  

~ Mix Source with Toggle On

~ Mix Source with Toggle Off

~ Swap with Toggle On

~ Swap with Toggle Off

Split

Mix
Source

Swap

Toggle
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tçêâáåÖ=ïáíÜ=mfmë=áå=péäáí=jçÇÉ
In Split Mode, the mixer’s two layers operate independently.  

Use the following steps to work with PIPs in Split Mode.  

1. In the Layer Control Section, ensure that the Split button is On.

2. Press the desired layer button (A or B).  Please note:

~ The layer button blinks to indicate that it is active for modification.

~ In the Source Selection Bus, the source assigned to the layer blinks.

~ On Preview, the raster box for the selected layer blinks (even if it is 
hidden under another layer). 

3. In the Layer Functions Section, ensure that the PIP button is lit and the PIP 
Adjustment Menu is visible.  If the menu is not visible, press PIP.  

4. On the Source Selection Bus, press the button for the desired (new) source.  
The button blinks to indicate that it is selected, and the source appears within the 
PIP on Preview.

5. Adjust the PIP’s size, position, border, shadow, source image, cropping and 
special effects.  Refer to the “Modifying PIPs" section on page 230 for details.

6. Prior to the transition, you can set up an additional layer if desired in Split Mode:

~ To set up an additional “Split Mode” PIP in Preview, repeat the 
procedure from step 2.  

~ To set up a Key in Preview, refer to the “Working with Keys in Split 
Mode" section on page 231.

7. Press CUT or AUTO TRANS to transition the look to program.  Refer to the 
“Working with Transitions" section on page 241 for details.

8. Repeat the procedure from step 1 for the next transition.

tçêâáåÖ=ïáíÜ=mfmë=áå=jáñ=jçÇÉ
In Mix Mode, the mixer’s layers are ganged together.  Both PIPs can be perfectly co-
located on screen (Mix Source mode), or both can operate independently (Swap mode), 
but only one PIP can be on Program at a time.

Use the following steps to work with PIPs in Mix Mode.

1. In the Layer Control Section, ensure that the Split button is Off.

2. Press the desired layer button (A or B).  Please note:

~ The layer button blinks to indicate that it is active for modification.

~ In the Source Selection Bus, the source assigned to the layer blinks.

Note Even though this mode allows you to display two PIPs (or 
Keys) on air, it is more restrictive.  Once both layers are on 
Program, you must transition them off Program, make 
changes — and then transition them back on.

Layer
A

Note Even if the layer is on Program, the PIP Adjustment Menu 
appears, but parameters can not be adjusted.
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~ On Preview, the raster box for the selected layer blinks (even if it is 
hidden under the DSK). 

3. In the Layer Functions Section, ensure that the PIP button is lit and the PIP 
Adjustment Menu is visible.  If the menu is not visible, press PIP.

4. Set the desired Mix Mode:

~ To co-locate the mixer’s PIPs, enable the Mix Source button.

~ To locate the mixer’s PIPs independently, enable the Swap button.

~ To toggle sources, enable the Toggle button.

5. On the Source Selection Bus, press the button for the desired (new) source.  
The button blinks to indicate that it is selected, and the source appears within the 
PIP on Preview.

6. Adjust the PIP’s size, position, border, shadow, source image, cropping and 
special effects.  Refer to the “Modifying PIPs" section on page 230 for details.

7. Press CUT or AUTO TRANS to transition the new look to program.  Refer to the 
“Working with Transitions" section on page 241 for details.

8. Repeat the procedure from step 1 for the next transition.

jçÇáÑóáåÖ=mfmë
Use the following steps to modify a PIP:  

1. Ensure that the PIP is selected in the Layer Control Section, and active for 
modification on Preview.  

2. If the PIP Adjustment Menu is not visible, press PIP.

3. Size and Position — Use the Size and Position controls in the PIP Adjustment 
Menu to manipulate the PIP on Preview.  In Chapter 4, refer to the "PIP 
Adjustment Menu Description" section on page 149 for details.

4. Source Size — Press Source (in the Joystick Section) to display the Input 
Source Adjustment Menu.  Use the Size and Position controls to manipulate 
the source image within the PIP.  In Chapter 4, refer to the "Source Adjustment 
Menu Description" section on page 167 for details. 

5. Crop — Press Crop (in the Joystick Section) to display the Crop Adjustment 
Menu.  Select the type of crop, the aspect ratio, and the image’s H and V size.  In 
Chapter 4, refer to the "Crop Menu" section on page 164 for details.    

6. Border — From the PIP, Shadow or Effects menus, press {BORDR} to display 
the Border Menu.  Select the border’s style, color and size.  In Chapter 4, refer to 
the "Border Menu" section on page 151 for menu details.   

7. Shadow — From the PIP, Border or Effects menus, press {SHDOW} to display 
the Shadow Menu.  Choose the shadow’s size, position and transparency.  In 
Chapter 4, refer to the "Shadow Menu" section on page 152 for details.

8. Special Effects — From the PIP, Shadow or Border menus, press {EFX} to 
display the Image Effects Menu.  Select the desired effect such as monochrome, 
invert, hue and strobe.  In Chapter 4, refer to the "Image Effects Menu" section 
on page 153 for details.

9. Global Functions — Remember that the following global functions are always 
available:

~ Press Reset (in the Joystick Section) to reset the current effect (e.g., 
PIP, Key, crop, etc.) to a nominal default value.
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~ Press Full Screen to bring the PIP to full screen, using the source’s 
height as the defining factor.  

~ Press Freeze to freeze the PIP (on both Program and Preview).  Press 
again to unfreeze.

10. Transition — Transition the new look to program with a CUT or AUTO TRANS.  
Refer to the “Working with Transitions" section on page 241 for details.

tçêâáåÖ=ïáíÜ=hÉóë=áå=péäáí=jçÇÉ
In Split Mode, the mixer’s two layers operate independently.  

Use the following steps to work with Keys in Split Mode.  

1. In the Layer Control Section, ensure that the Split button is On.

2. Press the desired layer button (A or B).  Please note:

~ The layer button blinks to indicate that it is active for modification.

~ In the Source Selection Bus, the source assigned to the layer blinks.

~ On Preview, the raster box for the selected layer blinks (even if it is 
hidden under another layer). 

3. In the Layer Functions Section, ensure that the KEY button is lit and the Key 
Menu is visible.  If the menu is not visible, press KEY.  

4. On the Source Selection Bus, select the desired (new) key source.  The button 
blinks to indicate that it is selected, and the source appears on Preview.

5. Adjust the Key’s type, clip, gain, opacity, fill, size, position, source image and 
cropping.  Refer to the “Modifying Keys" section on page 233 for details.

6. Prior to the transition, you can set up an additional effect if desired in Split Mode:

~ To set up an additional “Split Mode” Key in Preview, repeat the 
procedure from step 2.  

~ To set up a PIP in Preview, refer to the “Working with PIPs in Split 
Mode" section on page 229.

7. Press CUT or AUTO TRANS to transition the look to Program.  Refer to the 
“Working with Transitions" section on page 241 for details.

8. Repeat the procedure from step 1 for the next transition.

Note Even though this mode allows you to display two PIPs (or 
Keys) on air, it is more restrictive.  Once both layers are on 
Program, you must transition them off Program, make 
changes — and then transition them back on.

Note Even if the layer is on Program, the Key Menu appears, but 
parameters can not be adjusted.
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tçêâáåÖ=ïáíÜ=hÉóë=áå=jáñ=jçÇÉ
In Mix Mode, the mixer’s layers are ganged together.  Both Keys can be perfectly co-
located on screen (Mix Source mode), or both can operate independently (Swap mode), 
but only one Key can be on Program at a time.

Use the following steps to work with Keys in Mix Mode.

1. In the Layer Control Section, ensure that the Split button is Off.

2. Press the desired layer button (A or B).  Please note:

~ The layer button blinks to indicate that it is active for modification.

~ In the Source Selection Bus, the source assigned to the layer blinks.

~ On Preview, the raster box for the selected layer blinks (even if it is 
hidden under the DSK). 

3. In the Layer Functions Section, ensure that the KEY button is lit and the Key 
Menu is visible.  If the menu is not visible, press KEY.

4. Set the desired Mix Mode:

~ To co-locate the mixer’s Keys, enable the Mix Source button.

~ To locate the mixer’s Keys independently, enable the SWAP button.

~ To toggle sources, enable Toggle.

5. On the Source Selection Bus, select the desired (new) key source.  The button 
blinks to indicate that it is selected, and the source appears on Preview.

6. Adjust the Key’s mode, clip, gain, opacity, fill, size, position, source image and 
cropping.  Refer to the “Modifying Keys" section on page 233 for details.

7. Transition the new look to Program with a CUT or AUTO TRANS.  Refer to the 
“Working with Transitions" section on page 241 for details.

8. Repeat the procedure from step 1 for the next transition.

rëáåÖ=`ìí=C=cáää
A Cut + Fill key is one in which the hole-cutting information is provided by a Key on Layer 
B, while the fill information is provided by an effect on Layer A (either a PIP or a Key).  

Use the following steps to create a Cut & Fill Key:

1. In the Layer Control Section, ensure that the Split button is On.

2. Press the Layer A button, and configure your "fill" video as either a PIP or a Key 
in the normal manner.  This is the video that will appear "inside" the key.  
(Typically, the fill video is a PIP.)

3. Press the Layer B button and select Key.

4. On the Key Type line, select Cut + Fill.

5. Use the Clip, Gain and Opacity controls to set the appearance of the fill video as 
desired. 

6. Alternate between selecting Layer A and Layer B, and use each layer’s Size and 
Position controls to position the fill within the key as desired. 

Note Cut + Fill keys can only be selected on Layer B when the 
Split Mode is enabled.
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7. Many creative options are available with Cut + Fill keys.  You can ...

~ Use the "Join" mode to link the cut and fill layers together, such that they 
move together as one.  Refer to the "Using Join Mode" section on 
page 237 for details.

~ Program a "Move" with the combined Cut + Fill effect.  Refer to the 
"Using Move" section on page 238 for details.

~ Program a "Move" with only the key signal — such that the moving key 
travels over a static fill, revealing portions of the fill as the move 
progresses from point to point.

8. Transition the new look to Program with a CUT or AUTO TRANS.  Refer to the 
“Working with Transitions" section on page 241 for details.

jçÇáÑóáåÖ=hÉóë
Use the following steps to modify a Key:

1. Ensure that the Key is selected in the Layer Control Section, and active for 
modification on Preview.  

2. If the Key Menu is not visible, press KEY in the Layer Functions Section.

3. Key Type — Use the controls in the Key Menu to select the desired key type — 
Luma, Color, or Cut + Fill.  In Chapter 4, refer to the "Key Menu Functions" 
section on page 156 for menu details.  

4. Clip, Gain, Mode, Opacity — Use the controls in the Key Menu to adjust the 
Key’s clip, gain, invert mode and opacity on Preview.  In Chapter 4, refer to the 
"Key Menu Functions" section on page 156 for menu details.

5. Fill Source — Use the controls in the Key Menu to select a self or matte fill key.  
If Matte is selected, press {MATTE} to display the Matte Menu, with which you 
can choose the matte fill color.   In Chapter 4, refer to the "Matte Menu" section 
on page 159 for menu details.

6. Size and Position — From the Key Menu, press {SIZE & POS} to display the 
Key Adjustment Menu.  Use the controls to manipulate the Key on Preview.  In 
Chapter 4, refer to the "Key Adjustment Menu" section on page 160 for details.

7. Crop — Press Crop (in the Joystick Section) to display the Crop Adjustment 
Menu.  Select the type of crop, the aspect ratio, and the image’s H and V size.  In 
Chapter 4, refer to the "Crop Menu" section on page 164 for details.    

8. Source Size — Press Source (in the Joystick Section) to display the Key 
Source Adjustment Menu.  Adjust the source image’s size and position within 
the Key.  In Chapter 4, refer to the "Source Adjustment Menu Description" 
section on page 167 for menu details. 

9. Special Effects — From the Key, Key Adjustment, Key Source Adjustment or 
Matte Menu, press {EFX} to display the Image Effects Menu.  Select the desired 
effect, including monochrome, chroma and hue, invert and strobe.  In Chapter 4, 
refer to the "Image Effects Menu" section on page 153 for details.

Note Remember that Cut + Fill keys can only be selected on 
Layer B when the Split Mode is enabled.
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10. Global Functions — Remember that the following global functions are always 
available to you:

~ Press Reset to reset the current effect (e.g., PIP, Key, crop, etc.) to a 
nominal default value.

~ Press Full Screen to bring the Key to full screen, using the source’s 
height as the defining factor.  

~ Press Freeze to freeze the Key (on both Program and Preview).  Press 
again to unfreeze.

11. Transition — Transition the new look to program with a CUT or AUTO TRANS.  
Refer to the “Working with Transitions" section on page 241 for details.

`äÉ~êáåÖ=i~óÉêë=Ñêçã=mêçÖê~ã
The clear layer procedure enables you to remove layers from Program — including 
backgrounds, layers, the DSK and the LOGO.  In this mode, always remember to take 
advantage of the system’s Lookahead Preview function.  Refer to the "Lookahead 
Preview" section on page 219 for additional details.

Use the following steps to clear a layer from Program:

1. Check (and compare) the Program and Preview monitors, and note the layer(s) 
that you wish to clear.  In the Layer Control Section, Red LEDs above the 
buttons indicate the layers that are on Program.  

2. If the button for the layer that you wish to clear is not lit, press to light it — and 
ensure the button is blinking.   

3. In the Layer Control Section, press Clear Layer.  This action turns off the 
selected layer button and visually clears the layer from Preview.  This step is valid 
for all buttons in the Layer Control Section.    

4. Prior to transition, if you want to clear additional layers, repeat steps 2 and 3.

5. Transition the new "look" to program with a CUT or AUTO TRANS.  The selected 
layer(s) will transition off of Program.

jçÇáÑóáåÖ=i~óÉêë=lå=mêçÖê~ã
The ScreenPRO-II Controller enables you to modify layers directly on Program, without first 
setting up a "look" on Preview.  The mode is typically used for creating and viewing a "look" 
on Program (especially in conjunction with a large screen projector) when the Preview 
monitor may be too small to realize the desired result. 

Use the following steps to modify layers directly on Program:

1. From the Home Menu, press SYSTEM to access the System Menu.  

2. Scroll to the Modify Layers On Program line and turn the mode ON.  You can  
now change PIPs and Keys directly on Program.  

Please note:

• When you switch sources directly on Program, you may notice a glitch in the 
image as the scalers recall the source’s file.  

• If you use camera inputs in this mode, it is recommended that you use an external 
Genlock signal.  Refer to the "Understanding Input File Mapping" section on 
page 221 for details on source files.

Clear
Layer
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tçêâáåÖ=ïáíÜ=i~óÉê=cìåÅíáçåë
The following topics are discussed in this section: 

• Changing the Layer Mode

• Using Full Screen

• Using Clone

• Using Swap Z-Order

• Using Freeze

• Using Reset

• Using Join Mode

`Ü~åÖáåÖ=íÜÉ=i~óÉê=jçÇÉ
Use the following steps to change the layer mode:

1. Ensure that the PIP or Key that you wish to change is selected in the Layer 
Control Section, and active for modification.

2. In the Layer Functions Section:

~ Press PIP to change a Key to a PIP, or ... 

~ Press Key to change a PIP to a Key.

rëáåÖ=cìää=pÅêÉÉå

Use the following steps to take the active PIP or Key to full screen:

1. Ensure that the PIP or Key is selected in the Layer Control Section, and active 
for modification in Preview.

2. In the Layer Functions Section, press Full Screen.  The source’s height will be 
used as the parameter that define’s the full screen size.  If borders are ON, they 
will be taken into account so that they are visible.  Shadows will not be taken into 
account for the full screen size.

rëáåÖ=`äçåÉ
The Clone mode is designed for widescreen configurations only.  It enables you to make an 
exact copy of a layer onto the opposite screen.  All parameters of the PIP or Key are 
cloned, including the shadow, key effects, border and size.  Once cloned, you can select 
between a “mirror” or an “offset” clone.

Use the following steps to clone a layer:

1. Ensure that a PIP or Key is selected in the Layer Control Section, and active for 
modification in Preview.

2. Ensure that the PIP or Key is positioned fully within the boundaries of an outside 
destination’s screen.  If the PIP or Key straddles the widescreen overlap region, 
the mode cannot be enabled.

3. Press Clone to display the Clone Setup Menu.

Full
Screen

Clone
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4. Select the desired clone type — Mirror or Offset.

5. If Offset is selected, adjust the offset (in pixels) as desired.

6. If desired, clone the other layer by repeating the procedure from step 1.

7. Press CUT or AUTO TRANS to transition the effect to Program.  

rëáåÖ=pï~é=wJlêÇÉê

Use the following steps to swap the Z-Order (priority) of two layers within the same 
mixer.  The function works with two Keys, two PIPs, or one of each.

1. Ensure that you have two layers visible on Preview, with one layer visually 
overlapping the other.  

2. In the Layer Functions Section, press Swap Z-Order.  The visual priority (on 
Preview) of the two layers changes.   Note that the layers remain at their current 
locations — only the priority changes.

3. Transition the new "look" to program with a CUT or AUTO TRANS.  

rëáåÖ=cêÉÉòÉ

Use the following steps to freeze a layer’s motion on both Program and Preview.  This 
function is useful for PIPs and Keys that use video and animated graphics.

1. In the Layer Control Section, activate the layer that you wish to freeze.  The 
button blinks to indicate it is active.  

2. In the Layer Functions Section, press Freeze to freeze the layer on both 
Preview and Program (if applicable).  The button lights to indicate that a “freeze” 
is associated with the current layer.  

3. With the layer selected, turn off the Freeze button to restore source motion.

Please note:

• If a source is on Program, selecting its layer and pressing Freeze will freeze the 
image on Program.  

• You can also use Freeze if the PIP or Key is only on Preview, and then transition 
the frozen image to Program.

   

Note You can set up and perform a Move in conjunction with a 
cloned image.

Swap
Z-order

Freeze

Note The lit Freeze button indicates the association between the 
selected layer and the “freeze.”  If you select a different layer 
that does not have an associated freeze, the button turns off.  
If you return to the associated layer, the button lights again.
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rëáåÖ=oÉëÉí

The Reset function is context sensitive.  It is used to reset the current effect to a nominal 
default value on Preview.   

Use the following steps to reset a specific PIP or Key parameter:

1. In the Layer Control Section, activate the layer that you wish to reset.  The layer 
button blinks to indicate that it is active.

2. Ensure that the layer is on Preview.  Typically, you cannot reset functions on 
Program.  

3. Ensure that Freeze is off.  Frozen PIPs or Keys cannot be reset. 

4. If required, access the "menu" whose specific function you want to reset (e.g., 
borders, shadows, special effect, size, etc.).    

5. In the Joystick Section, press Reset to reset the current effect.  

rëáåÖ=gçáå=jçÇÉ
The "Join" mode enables you to lock Layer A and Layer B together, such that they move 
as one.  You can program "moves" when the two layers are joined, and the mode is 
particularly effective when using Cut + Fill keys.  The following rules apply:

• The Split mode must be enabled in order to enter the Join mode.

• Any Layer A and Layer B effect can be joined, including PIPs and all types of 
Keys.  You can join two PIPs, two Keys, or one PIP and one Key.

• When the two layers are joined, the Size and Position controls on either layer 
enable you to move both layers as one.  The relationship of the two layers (at the 
time of the joining) is maintained proportionally.

• When the two layers are joined, the effects (e.g., border, shadow, clip) on each 
layer are locked — and cannot be changed until the "join" is cancelled.

• You can only enter and exit the mode when the "join" is on Preview.

Use the following steps to join Layer A and Layer B:

1. In the Layer Control Section, ensure that Split mode is enabled.

2. On Preview, create a Key or PIP on Layer A in the normal manner.

3. Create a Key or PIP on Layer B in the normal manner.

4. Press and hold the Split button, then press either of the two layer buttons.  This 
action enables the "Join" mode, and causes both layer buttons to blink.

5. Use either layer’s Size and Position controls to modify the joined layers, or to 
program a "move."  Note that the two layers move and size as one.   

6. Transition the new "look" to program with a CUT or AUTO TRANS.

7. To exit the mode, transition the effect off Program and back to Preview.

8. Press and hold the Split button, then press either of the two layer buttons.  

Reset

Note In some situations (such as size and position), a parameter 
on Program can be reset — provided that Modify Layers on 
Program is enabled.
ScreenPRO-II Controller  •  User’s Guide 237



6.  Operations
Using Move
rëáåÖ=jçîÉ
The following topics are discussed in this section:

• Programming Moves

• Pending and Triggering Moves

• Move Notes

mêçÖê~ããáåÖ=jçîÉë

The ScreenPRO-II Controller enables you to move a PIP or a Key (or both) smoothly from 
one screen location to another at a predefined rate, while the layer(s) are on-air.  All moves 
are two-keyframe effects, with a starting location and an ending (destination) location.

There are two ways to program a move — on Preview or on Program.

• Program a Move on Preview

• Program a Move on Program

mêçÖê~ã=~=jçîÉ=çå=mêÉîáÉï
This mode enables you to program a move with the layer on Preview only — before it has 
transitioned to Program.  

Use the following steps to program a move on Preview:

1. In the Layer Control Section, select the layer that you want to move (LAYER A 
or LAYER B).  The button blinks to indicate that it is active for modification.  

2. In the Layer Functions Section, select Key or PIP as desired.

3. Size and position the PIP or Key in its “starting” location on Preview.  Adjust all 
border, shadow and source parameters in the normal way.

4. In the Layer Functions Section, press Move Setup.  The button blinks to 
indicate that you are now actively defining the properties of the move.

5. Move the PIP or Key to its “ending” size and location (on or off screen).    

6. To define the rate at which the PIP or Key moves, adjust the Move Rate 
parameter.  The rate can be adjusted in 0.1 second increments.

7. Press Move Setup again to complete the programming.  The button remains lit, 
and the PIP or Key returns to its starting location on Preview.  

8. To set up an additional move on the other layer (provided that you are in Split 
Layer mode), repeat the procedure from step 1.

To pend and trigger the move, refer to the "Pending and Triggering Moves" section on 
page 239.

Move

Move
Setup

Note The lit Move Setup button indicates an association between 
the selected layer and a programmed “move.”  If you select a 
different layer that does not have an associated move, the 
button turns off.  If you return to the “associated” layer, the 
button lights again.
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mêçÖê~ã=~=jçîÉ=çå=mêçÖê~ã
This mode enables you to program a move with the layer on both Program and Preview — 
after the layer has transitioned to Program.    

Use the following steps to program a move on Program:

1. In the Layer Control Section, select the layer (on Program) that you want to 
move (LAYER A or LAYER B).  The button blinks to indicate that it is active for 
modification.  Note that its current position is the move’s "starting" location.  

2. In the Layer Functions Section, press Move Setup.  The button blinks to 
indicate that you are now actively defining the properties of the move.

3. Size and position the PIP or Key to its “ending” location.  Note that on Preview, 
only the raster box moves.

4. Press Move Setup again to complete the programming.  The button remains lit, 
and the raster box returns to its starting location on Preview.  

5. To set up an additional move on the other layer (provided that you are in Split 
Layer mode), repeat the procedure from step 1.

To pend and trigger the move, refer to the "Pending and Triggering Moves" section.

mÉåÇáåÖ=~åÇ=qêáÖÖÉêáåÖ=jçîÉë
For each layer on which you have programmed an associated move, you can “pend” and 
"trigger" the move in one of two ways — on Preview or on Program.

• Pend on Preview

• Pend on Program

mÉåÇ=çå=mêÉîáÉï
This "pend" method enables you to move the PIP or Key automatically on the next 
transition.

Use the following steps to pend a move on Preview:

1. With the move properly programmed, ensure that the layer containing a move is 
selected and blinking.

2. To pend the move, press Move in the Layer Functions Section.  The button 
lights to indicate the pending move.  On Preview, the raster box blinks at the 
"destination" location — not the PIP or Key’s current location.    

3. Perform a CUT or AUTO TRANS.  The transition takes the Preview image to air, 
and the move begins immediately on both Program and Preview.  

4. To move the layer back to keyframe 1, press Move.  The button lights and on 
Preview, the raster box blinks at the "starting" location.  

5. Perform a CUT or AUTO TRANS.  In this "ping-pong" manner, you can continue 
to transit back and forth between keyframes 1 and 2.  
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This "pend" method enables you to trigger the move manually, once the layer is already on 
Program.

Use the following steps to pend a move on Program:

1. With the move properly programmed, ensure that the layer containing a move is 
selected and blinking.

2. Perform a CUT or AUTO TRANS.  The transition takes the Preview layer(s) to 
Program.  

3. To pend the move, press Move in the Layer Functions Section.  The button 
lights to indicate the pending move, and on Preview, the raster box blinks at the 
"destination" location — not the PIP or Key’s current location.    

4. Perform a CUT or AUTO TRANS.  The move begins when the button is pressed.  

5. To move the layer back to keyframe 1, press Move.  The button lights and on 
Preview, the raster box blinks at the "starting" location.  

6. Perform a CUT or AUTO TRANS.  In this "ping-pong" manner, you can continue 
to transit back and forth between keyframes 1 and 2.  

jçîÉ=kçíÉë
Please note the following important points regarding the Move mode:

• Clearing moves — To clear a move (and remove the association between a layer 
and a move), press Move Setup twice.

• On screen, off screen — The ScreenPRO-II Controller enables you to move a 
PIP or Key from an off-screen location to an on-screen location, and vice-versa. 

Remember that Move behaves differently, depending on the selected mode: 

• In Split mode, two PIPs or Keys can be programmed and triggered independently 
(or simultaneously).  You can pend LAYER A, LAYER B, or both — and then 
transition, as desired.

• In Mix Source mode, both PIPs or keys are perfectly co-located on screen.  The 
move you program applies to both layers.  After a move is programmed, the Move 
Setup button lights when either layer A or B is pressed.

~ If Toggle is On, each time you transition, the source inside the PIP or 
Key changes automatically.

~ If Toggle is Off, you must change sources manually (if desired) before 
each transition.

~ "Ping-pong" transitions can be performed.

• In Swap mode, both layers can operate independently but only one PIP or key 
can be on screen at a time, and the system alternates between each layer on 
each transition.  

~ Each layer can have its own programmed move.  

~ The "toggle" mode applies in the normal manner.

~ "Ping-pong" transitions cannot be performed. 
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This section provides instructions for perform a variety of transitions.  The following topics 
are discussed:

• Cut

• Mix

• Wipe

• Manual Transitions

• Transition Notes

`ìí
Cuts can be performed on both single screen and widescreen destinations.  

Use the following steps to perform a Cut:

1. Set up the desired “look” in Preview.  

2. In the Transition Section, press CUT to instantly cut the setup to Program.

jáñ
A Mix (or Dissolve) can be performed on both single screen and widescreen destinations.  

Use the following steps to perform a Mix:

1. Set up the desired “look” in Preview.  

2. Preset the desired transition rate:  

a. Press {HOME} > {EFFECTS} to display the Effects Menu.

b. Adjust the Transition Rate field for the desired rate, in 0.1 second 
increments.

3. In the Transition Section, press MIX.

4. Press AUTO TRANS to dissolve the setup to Program.

táéÉ
All types of wipes can be performed on single screen destinations.  On widescreen 
destinations, you can perform a Wipe Up or Wipe Down.

Use the following steps to perform a Wipe:

1. Set up the desired “look” in Preview.  

2. Preset the desired transition rate, wipe effect and wipe edge:  

a. Press {HOME} > {EFFECTS} to display the Effects Menu.

b. Adjust the Transition Rate field for the desired rate, in 0.1 second 
increments.

c. Adjust the Transition Wipe field for the desired wipe pattern.

CUT

MIX

WIPE
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d. Adjust the Transition Edge field for the desired wipe edge.  

3. In the Transition Section, press WIPE. 

4. Press AUTO TRANS to wipe the setup to Program.

j~åì~ä=qê~åëáíáçåë
Any of the transitions outlined above can be performed manually with the T-Bar.

Use the following steps to perform a manual transition:

1. Set up the desired “look” in Preview.

2. Select WIPE or MIX as desired.  Remember that wipes can only be performed on 
single screen destinations

3. In the Transition Section, move the T-Bar to manually dissolve (or wipe) the 
images on Preview to Program. 

qê~åëáíáçå=kçíÉë
Using the Effects Menu, transitions performed on the ScreenPRO-II Controller are 
destination-based.  Two examples are provided below. 

Select destinations 1 and 3, then press WIPE.  Next, select destination 2 only 
and press MIX.  Finally, select all three destinations and press AUTO TRANS 
to simultaneously perform a wipe on destinations 1 and 3, and a dissolve on 
destination 2.   

If destinations 1, 2 and 3 are lit, and both the WIPE and MIX buttons are lit, 
pressing MIX changes all three destinations to MIX.

Note Key Frame effects are fixed as LINEAR, and cannot be 
changed.

Note In the above example, both the WIPE and MIX buttons would 
be lit when all three destinations are selected.
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This section provides detailed instructions for working with Presets.  The ScreenPRO-II 
Controller’s Preset Section enables you to store and recall entire Controller setups.  Each 
preset button represents one “look” of the overall projected image.  The Controller has 6 
Preset buttons and 6 "page" LEDs, providing a total of 36 Presets that you can store and 
recall — 6 pages of 6 Presets each.

The following topics are discussed:

• A Word About Resources

• Storing Presets

• Recalling Presets

• Deleting Presets

• Using Next and Previous

• Preset Notes

^=tçêÇ=^Äçìí=oÉëçìêÅÉë

Resources, as they apply to Presets, are the assigned layers that comprise the Controller’s 
current “look.”  

• When you store a Preset, you are not only recording the Controller’s entire look, 
but you are also recording the priorities (e.g., the layers of PIPs and Keys) that 
were selected in the Layer Control Section.  

• When you recall a Preset, you are recalling the entire setup, and all previously 
stored priorities — PIPs, Keys, Colors, Sources, Moves, etc.

Two "resource" examples are provided below:

If you store a Preset that contains LAYER A with SPLIT mode on, you can 
recall it to Preview only if LAYER A is not already in use — in the current 
Program setup.  

If you store a Preset that contains LAYER A with SPLIT mode off, because 
there is always an available layer in Mix Mode, you can recall the Preset to 
Preview at any time.  However, note that the system will pick the available 
layer based on resources (e.g., if you stored the Preset in LAYER A, the 
system may recall it to LAYER B if LAYER A is in use).

With these facts in mind, you may wish to store (and organize) your Presets according to 
the use of resources:

• For example, you could store Presets on Page 1 that only use one PIP, and 
presets on Page 2 that use two PIPs.  

• As an alternate method, you may want to plan your presentations such that 
Presets are always recalled to an “empty” Program setup (with only a background 
visible).  This method avoids all resource issues entirely.

4
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Use the following steps to store a preset:

1. Set up the desired “look” on Preview.  Remember that one preset equals a single 
“look” of the Controller, including the current state of all mixers, layers, sources, 
and the DSK.

2. Select the “page” on which you want to store the preset.  In the Preset Section, 
hold down Page, then press the desired Preset button.  The Red LED above the 
button lights to indicate the current page.

3. To store the preset, press Learn + the desired Preset button.  The Touch Screen 
displays a confirmation message, and the overall look of the Controller is now 
saved into that register.  

oÉÅ~ääáåÖ=mêÉëÉíë
Use the following steps to recall a preset:

1. Check the available resources on Program.  If the resources (layers) that you wish 
to recall are already in use on Program, they must first be cleared before the 
“recall” is permitted.

2. Select the “page” from which you want to recall the preset.  In the Preset Section, 
hold down Page, then press the desired Preset button.  The Red LED above the 
button lights to indicate the current page.

3. To recall a Preset, simply press the desired Preset button to recall the stored 
“look” to Preview.

aÉäÉíáåÖ=mêÉëÉíë
Use the following steps to delete a preset:

1. Select the “page” from which you want to delete a preset.  In the Preset Section, 
hold down Page, then press the desired Preset button.  

2. In the Preset Section, hold down Delete, then press the desired Preset button to 
delete that register from memory.   The Touch Screen displays a confirmation 
message.

rëáåÖ=kÉñí=~åÇ=mêÉîáçìë
Use the following steps to utilize the Next function:

1. Check the available resources on Program.  If the resources (layers) that you wish 
to recall are already in use on Program, they must first be cleared before the 
“recall” is permitted.

2. In the Preset Section, press Next to recall the next valid Preset in sequential 
order.  Please note:

~ If Preset 2 is lit, pressing Next recalls Preset 3.

~ If Preset 6 is active on page 2, pressing Next advances to Preset 1 on 
page 3.  

Page

Learn

Delete

Next
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~ If a Preset is undefined, it will be skipped when Next is pressed.

Use the following steps to utilize the Previous function:

1. Information to be provided.

mêÉëÉí=kçíÉë
Please note the following important points regarding Presets:

• Active destinations (both standard and Aux) are stored as part of a Preset.

• Aux source selections are saved and recalled in Presets.

• If different Presets have different Move definitions stored for the same Layer, 
when you recall a Preset to a Layer that already has a PIP on Program, the 
starting location of the recalled Move is ignored.  Instead, the PIP’s "current" 
location will be used as the move’s starting point, and the ending point from the 
recalled Preset will be used.  In this manner, you can effectively recall a series of 
"end" points — all of which use the end point from the previous Preset as their 
new starting point.  

If you recall a Preset with a defined Move to an empty layer, both the starting and 
ending points of the recalled Move will be used. 

Note The Previous feature is currently not implemented.

Previous
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The following topics are discussed in this section:

• Still Frame Capture Overview

• Capturing Still Frames from a Background Input

• Capturing Still Frames from a Layer

• Saving Still Frames in Permanent Memory

• Naming a Saved Still Frame

píáää=cê~ãÉ=`~éíìêÉ=lîÉêîáÉï
The ScreenPRO-II Controller enables you to capture still frames into each ScreenPRO-II’s 
three internal frame stores.  The “sources” of the still frames are each ScreenPRO-II’s BG 
A and BG B inputs, or the scaled inputs (Layer A or B).  

Please note:

• For widescreen destinations, even though you are using the frame stores of 
multiple ScreenPRO-II units, you are conceptually working with only three frame 
stores — each of which captures’s its “slice” of the complete widescreen image.   

• For single screen destinations, you are working with the individual destination’s 
three frame stores in the normal manner.   

Regarding captures:

• All captures of the background (BG A or BG B) must occur on Preview — the 
desired full screen source to capture must be visible on Preview.  You will get an 
error message if you attempt to capture while the source is on Program.  

• All captures of the layers (LAYER A or LAYER B) can occur on either Preview or 
Program.  The system only captures the active layer in its current size and 
position, with no borders, and with black as the background.  

Please note the following important prerequisites to all frame grab procedures:

• Ensure that you are familiar with the Background Input Setup Menu.  In 
Chapter 4, refer to the “Background Input Setup Menu" section on page 170.

• Ensure that you are familiar with the Frame Grab Menu.  In Chapter 4, refer to the 
“Frame Grab Menu" section on page 142 for details.

Note The "Preview" capture ensures that the Program output does 
not glitch when a live image is momentarily frozen and placed 
in temporary memory.
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Use the following steps to capture a still frame from a background input:

1. Ensure that the background input from which you want to capture a still is properly 
set up as a DVI input.  In Chapter 5, refer to the "Background Setup" section on 
page 205 for instructions.

2. Ensure that BG A, BG B or the DSK are not on Program.  If they are, you will get 
a pop-up prompt.  Transition these layers off Program in the normal manner.

3. If you want to capture from BG B, ensure that the DSK is not in use. 

4. In the Layer Control Section, select the background from which you want to 
capture a still.  The button blinks, the source appears on Preview, and the 
selected Background Input Setup Menu appears.

5. Press {HOME} > {FRAME GRAB} to display the Frame Grab Menu.

6. On the Frame Number line, select the temporary frame store into which the still 
will be captured (FG_1, FG_2 or FG_3). 

7. Press {CAPTURE}.  Once pressed, the screen will indicate that the frame is being 
captured.  A pop-up message confirms the procedure.

8. Repeat the procedure from step 4 to capture additional stills from a background 
input.  Remember that you can always overwrite FG_1, FG_2 or FG_3.

Please note:

• The captured still(s) can now be assigned as the input “type” for BG A, BG B, the 
DSK or the LOGO.  In Chapter 5, refer to the following sections for instructions:

~ "Background Setup," page 205.

~ "DSK Setup Procedure," page 211.

~ "LOGO Setup Procedure," page 212.

• Captured stills reside in temporary memory.  If the system is powered down or 
reset, the stills will be lost.  To save stills in permanent memory, refer to the 
"Saving Still Frames in Permanent Memory" section on page 248.  

`~éíìêáåÖ=píáää=cê~ãÉë=Ñêçã=~=i~óÉê
Use the following steps to capture a still frame from a layer.  

1. Ensure that BG A, BG B or the DSK are not on Program.  If they are, you will get 
a pop-up prompt.  Transition these layers off Program in the normal manner.

2. In the Layer Control Section, select the layer from which you want to capture a 
still.  The button blinks indicating that it is "selected."  

3. Select PIP or Key in the normal manner.  The selected PIP or Key Adjustment 
Menu appears.

4. Adjust the PIP or Key’s size and position.  Remember that:

Note Only "saved" still frames can be named.

Note The layer can be on Program or Preview.
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~ The system will capture the "selected" layer in its current size and 
position, with no borders, and with black as the background.

~ If you have two layers on Preview, only the active (selected) layer will be 
captured, regardless of image priority.

5. Press {HOME} > {FRAME GRAB} to display the Frame Grab Menu.

6. On the Frame Number line, select the temporary frame store into which the still 
will be captured (FG_1, FG_2 or FG_3). 

7. Press {CAPTURE}.  Once pressed, the screen will indicate that the frame is being 
captured.  A pop-up message confirms the procedure.

8. Repeat the procedure from step 1 to capture additional stills from a layer.  
Remember that you can always overwrite FG_1, FG_2 or FG_3.

Please note:

• The captured still(s) can now be assigned as the input “type” for BG A, BG B, the 
DSK or the LOGO.  In Chapter 5, refer to the following sections for instructions:

~ "Background Setup," page 205.

~ "DSK Setup Procedure," page 211.

~ "LOGO Setup Procedure," page 212.

• Captured stills reside in temporary memory.  If the system is powered down or 
reset, the stills will be lost.  To save stills in permanent memory, refer to the 
"Saving Still Frames in Permanent Memory" section on page 248.  

p~îáåÖ=píáää=cê~ãÉë=áå=mÉêã~åÉåí=jÉãçêó
Use the following steps to save a captured still into permanent memory.  

1. Capture a still as outlined in the previous two sections.  

~ "Capturing Still Frames from a Background Input" on page 247.

~ "Capturing Still Frames from a Layer" on page 247.  

2. On the Frame Grab Menu, use the Frame Number line to select the frame that 
you wish to save.

3. Press {SAVE} to save the captured frame into the selected storage register 
(FG_1, FG_2 or FG_3).  Once pressed, the screen displays an important warning:

~ Press YES to save the frame.  All front panel controls will be locked for 
up to three minutes.

~ Press NO to cancel the procedure.

4. If required, press {DELETE} to delete the selected frame from permanent storage.  
This button only appears when frames are stored in permanent memory.

Note Only "saved" still frames can be named.

Warning Do not execute the next step during live production.  All 
controls will be locked during the "save" process.  It is 
recommended that you save your stills during pre-production 
as a "setup" procedure.
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Use the following steps to name a saved still frame.  

1. Ensure that the still you wish to name has been saved in permanent memory.  If 
not, refer to the "Saving Still Frames in Permanent Memory" section on 
page 248.   

2. Ensure that the Tally option is physically installed, and that a PS-2 keyboard is 
connected to the rear-panel Keyboard connector.

3. On the Frame Grab Menu, press {NAME} to display the Frame Grab Name 
Menu.

4. On the Saved Location line, select the frame that you wish to name.

5. Using the keyboard, enter the desired name.  As you type, characters will appear 
in the menu’s New Name field.

6. Press Enter (on the PS-2 keyboard) to save the name.  Once saved, the system 
"attaches" the name to the still in permanent memory.

7. Press {BACK} to return to the Frame Grab Menu.
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Use the following steps to perform a downstream key:

1. Ensure that the DSK is properly set up.  In Chapter 5, refer to the "DSK Setup 
Procedure" section on page 211 for instructions.

2. Ensure that BG B is not in use.  

3. In the Layer Control Section, press DSK to display the DSK Adjustment Menu.

4. Press {INPUT SETUP} to display the DSK Input Setup Menu.

5. On the ID line, select the ID of the ScreenPRO-II with which you want to perform 
the DSK. 

6. On the Type line, selects the desired DSK source — None, DVI or a captured still 
frame (FG_1, FG_2 or FG_3).  

7. Press {KEY} to return to the DSK Adjustment Menu.

8. Adjust DSK parameters as desired, including key type, invert, clip, gain, opacity 
and fill source.  Refer to the "Modifying Keys" section on page 233 for details.    

9. Perform a CUT or AUTO TRANS. 

10. Clear the DSK from Program in the normal manner — by clearing its layer from 
Preview and then transitioning.   

DSK

Note In both single and widescreen modes, remember that BG B 
and the DSK are mutually exclusive.  This occurs because 
the BG/DSK Input B is shared between the DSK and BG B 
on all individual ScreenPRO-II units.

Note Not all parameters listed in the "Modifying Keys" section 
apply to a DSK.
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Use the following steps to transition the LOGO to Program:

1. Ensure that the LOGO is properly set up.  In Chapter 5, refer to the "LOGO Setup 
Procedure" section on page 212 for instructions.

2. In the Layer Control Section, press LOGO to display the LOGO Menu.

3. On the Type line, selects the desired LOGO source — Black, or a captured still 
frame (FG_1, FG_2 or FG_3).  

4. Perform a CUT or AUTO TRANS.    

5. Clear the LOGO from Program in the normal manner — by clearing its layer from 
Preview and then transitioning.   

Please note:

• In addition to its use as a full screen downstream graphic (with the highest visual 
layer priority), the LOGO layer can also be used as a convenient “black preview” 
function.  This enables you to fade to black at any time, from any simple or 
complex setup, without affecting the underlying "look."  

• After a transition, the LOGO layer is automatically cleared from Preview.  In this 
way the next transition will always fade up from black to your previous setup.    

LOGO
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This section provides instructions for locking and unlocking the Controller.

Prerequisite:

~ Ensure that you are familiar with the Lockout Code Menu and its 
associated submenu.   In Chapter 4, refer to the “Lockout Code Menu” 
section on page 136.

Use the following steps to lock the Controller:

1. On the Lockout Code Menu, select the type of lockout code you wish to use — 
once the panel is unlocked:  Default or Custom.

2. If Custom is selected, use the Change Lockout Code Menu to enter the desired 
code.  Make a note of the selected code.

3. To lock the Controller, press and hold the PAGE button (in the Presets Section), 
then press the ALL button (in the Destination/Aux Bus).  The message 
"KEYBOARD LOCKED" appears on the menu.  

Use the following steps to unlock the Controller:

1. Press and hold the PAGE button, then press the ALL button.  The Enter Lockout 
Code menu appears.

2. Use the eight numbered buttons on the Source Selection Bus to enter the code.  

~ If the correct code has been entered, the message "Unlocking 
Controller" appears on the display, and the Controller is ready for use.

~ If the incorrect code has been entered, the Controller remains locked.  

Important If you have selected a Custom lockout code, but you have 
forgotten the code, a Master Code is available.  Refer to the 
ScreenPRO-II Controller system’s most current 
"Whatsnew_ScreenPRO-II Controller.txt" document for 
details.  This document is bundled with every software 
download.  Note that the Master Code changes with each 
software version.
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The "Tally" function can be enabled or disabled as required.

Use the following steps to enable or disable tallies:

1. Ensure that your tallies are properly set up.  In Chapter 5, refer to the "Input 
Patching" section on page 198 for instructions.

2. Press {HOME} > SYSTEM to display the System Menu.

3. On the Tally Mode line:

~ Select On to enable all assigned tally relay closures.

~ Select Off to disable all assigned tally relay closures.

Please note:

• Remember that tallies are mapped to inputs.  When Tally Mode is On, if a 
"mapped" tally goes to Program, one of the associated eight tally circuits will be 
turned on. 

• When the "mapped" input is removed from Program, the associated tally will turn 
Off. 

• Tally functionality can be tested.  Press {HOME} > SYSTEM > {DIAG} > {TALLY} 
to initiate the test.

rëáåÖ=_~Åâìé=~åÇ=oÉëíçêÉ
The ScreenPRO-II Controller system enables you to backup and restore the complete 
system setup including all Presets, using a customer supplied flash memory card.  The 
following topics are discussed:

• System Backup

• System Restore

póëíÉã=_~Åâìé
This procedure enables you to back up your entire system configuration.   Please note the 
following important points:

• You can only store one system configuration on a Flash Memory Card.  

• Customer supplied Flash Memory Cards must be equal to or greater than 512MB.

Use the following steps to back up your system:

1. Ensure that you have a (customer supplied) Flash Memory Card available.

2. Insert the Flash Memory Card into the Controller’s rear panel Memory Card slot.

3. From the Home Menu, press MISC to display the Miscellaneous Menu.

4. Press {BACKUP RESTORE} to display the Backup/Restore Menu.  

5. On the Device line, select Ctrlr+SP to perform a complete backup, or select a 
subset as desired.

6. On the Controller Options line, select All, or select a subset as desired. 
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7. Press {CHECK CARD} to check for the presence of a Flash Memory Card.  

8. Press {BACKUP} to perform a backup operation to the Flash Memory Card using 
the selected device(s) and options.  

póëíÉã=oÉëíçêÉ
Please note the following important points regarding the "restore" function:

• When restoring, you must have the same version of software installed in the 
Controller as was used to perform the backup. 

• Conversion between versions can only be done with the Barco Backup and 
Restore utility.  

Use the following steps to restore from the flash memory card:  Please note the 
following important points:

1. Ensure that your flash memory card is properly inserted in the Controller’s 
MEMORY CARD slot on the rear panel.

2. On the Home Menu, press MISC to access the Miscellaneous Menu.

3. Press {BACKUP RESTORE} to display the Backup/Restore Menu.

4. Press {CHECK CARD} to ensure that the Controller recognizes the card.

5. On the Device line, select Ctrlr+SP to perform a complete restore, or select a 
subset as desired.

6. On the Controller Options line, select All, or select a subset as desired. 

7. On the SP to Restore line, select All, or select a subset as desired.

8. Press {RESTORE} to restore the selected system configuration.

At the conclusion of this procedure, your system is completely set up — exactly the way 
that you left it when you performed a complete system “backup.”   

Note The Barco Backup and Restore utility can be found in the 
ScreenPRO-II Controller software bundle — available via 
download from the website.
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This appendix provides detailed technical specifications for the ScreenPRO-II Controller.  
The following topics are provided:

• ScreenPRO-II Input Specifications

• ScreenPRO-II Output Specifications

• User Control

• Widescreen Functions

• Physical and Electrical Specifications

• Communications Specifications

• Pinouts 

• ScreenPRO-II Input and Output Resolutions
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The table below lists input specifications for individual ScreenPRO-II units.

Table A-1. ScreenPRO-II Input Specifications

Parameter Specification

Scaled Channel Inputs Analog inputs (8) — RGBHV / RGBS / RGsB computer video, 
YPbPr video (SD or HD), S-video, or composite video on 15-pin HD 
connector

 SD and HD-SDI Input (2 optional) — Per SMPTE 259M-C (NTSC / 
PAL resolution) SMPTE 292M (HDTV) on BNC connector

Scaler Input Resolutions 480i

Computer resolutions VGA (640 x 480) through UXGA (1600 x 
1200)

HDTV resolutions up to 1920 x 1080 (720p, 1080i, 1080p)

2048 x 1080p (Digital Cinema format)

Plasma display resolutions

Un-scaled Background / 
DSK Channel Inputs

DVI Inputs (2) — Digital DVI per DDWG 1.0 on DVI-I connector

Background / DSK Input 
Resolutions

Computer resolutions: VGA (640 x 480) through UXGA (1600 x 
1200)

HDTV resolutions, progressive up to 1920 x 1080 (1080p)

2048 x 1080p (Digital Cinema format)

Plasma display resolutions
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The table below lists output specifications for individual ScreenPRO-II units.

rëÉê=`çåíêçä=
The table below lists ScreenPRO-II Controller user control specifications.

Table A-2. ScreenPRO-II Output Specifications

Parameter Specification

Analog Outputs RGBHV / RGBS / RGsB (non-interlaced only) on 15-pin HD 
connectors

Preview and two Program monitor / projector outputs

Digital Outputs Digital DVI per DDWG 1.0 on DVI-I connector (Program output)

Output Resolutions Computer resolutions VGA (640 x 480) through UXGA (1600 x 
1200)

HDTV resolutions, progressive up to 1920 x 1080 (1080p)

2048 x 1080p (Digital Cinema format)

Plasma display resolutions

Table A-3. ScreenPRO-II Controller User Control Specifications

Parameter Specification

LCD Touchscreen 3.8”, 320 x 240 pixel resolution

Soft keys 8

Rotary Encoders 2

LED Pushbuttons 58, color coded
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The table below lists ScreenPRO-II Controller widescreen functions.

mÜóëáÅ~ä=~åÇ=bäÉÅíêáÅ~ä=péÉÅáÑáÅ~íáçåë=
The table below lists ScreenPRO-II Controller physical and electrical specifications.

Table A-4. ScreenPRO-II Controller Widescreen Functions

Parameter Specification

Maximum widescreen width 4 screens

Maximum widescreen destinations 1 (1 BlendPRO-II) *

Widescreen operation Same as Encore 1 x ME system

Transitions Transitioning background plus 1 transitioning widescreen 
PIP (same as Encore 1 x ME system)

Clone Mode Same as Encore

Note * Additional BlendPRO-II units connected to the ScreenPRO-
II Controller system will not be recognized.

Table A-5. ScreenPRO-II Controller Physical and Electrical Specifications

Parameter Specification

Power 120-240 VAC - 50/60 Hz., Auto-selecting 1.0A maximum

Console Light XLR connector

Mechanical H: 5.95 inches (15.13 cm)

W: 17.00 inches (43.18 cm) 

D: 10.00 inches (25.40 cm) 

See below for additional dimensions

Weight 17 lbs (13.11 kg) Estimated 

Temperature 0-40 degrees C

Humidity 0-95% non-condensing
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Please note the following additional mechanical specifications:

Figure A-1.  ScreenPRO-II Controller Side View

`çããìåáÅ~íáçåë=péÉÅáÑáÅ~íáçåë=
The table below lists ScreenPRO-II Controller communications specifications.

11.50" (29.21 cm)

12.72" (32.30 cm)

0.25" (0.63 cm)1.22" (3.09 cm)

2.12" 
(5.38 cm)

12°

4.57" 
(11.60 cm)

4.82" 
(12.24 cm)

6.72" 
(17.06 cm)

Table A-6. ScreenPRO-II Controller Communications Specifications

Parameter Specification

Ethernet RJ-45, 10/100 Mbps Autosense

RS-232 Console:  DB-9 Female, DCE, 115k Baud

EXT Comm:  DB-9 Female, DCE, 115k Baud

Flash Memory Card Type 1 compliant

Tally (Optional) DB-25 male, Dry-contact relay closures

1 Amp at 30 VDC

0.5 Amps at 125 VDC
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The following topics are discussed in this section:

• Ethernet Connector

• Serial Connector

• Tally Connector

bíÜÉêåÉí=`çååÉÅíçê
The figure below illustrates the ScreenPRO-II Controller Ethernet connector:

Figure A-2.  Ethernet Connector

The table below lists Ethernet connector pinouts.  

Table A-7. Ethernet Connector Pinouts

Pin Signal Wire Color

1 TX Data + White / Orange

2 TX Data - Orange

3 RX Data + White / Green

4 Blue

5 White / Blue

6 RX Data - Green

7 White / Brown

8 Brown

1 8
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The figure below illustrates the ScreenPRO-II Controller serial connector, which is used for 
both the Ext Comm and Console Port connections.

Figure A-3.  Serial Connector

The table below lists Serial connector pinouts.  

Please note:

• The port is configured as a DCE, 115K Baud, 8 data bits, 1 stop bit, no parity bits.

• The serial port can be connected to a standard PC serial port with a straight 
through DB-9 to DB-9 cable.

Table A-8. Serial Connector Pinouts

Pin RS-232 Signal Description

1 CD Carrier Detect

2 RXD Received Data

3 TXD Transmitted Data

4 DTR Data Terminal Ready

5 GND Signal Ground

6 DSR Data Set Ready

7 RTS Request To Send

8 CTS Clear To Send

9 RI Unused

5 1

9 6
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One 25-pin D connector is provided for issuing tally “relay closure” commands to external 
devices.  Eight tally circuits are provided.  Please note:

• Tally outputs provide dry-contact relay closures between signal pairs or contact 
closures to ground, whenever the corresponding input source is selected for 
display on a Program output.  

• Tally outputs may be used to signal when input devices (cameras) are “live.”  

• Each contact has a rating of 1 Amp at 30 VDC, and 0.5 Amps at 125 VDC.  

• A mating connector is required — see the diagrams below.

Figure A-4.  Tally Connector and Circuit

The table below lists Tally Connector pinouts:  

Table A-9. Tally Connector Pinouts

Pin Signal Pin Signal

1 Tally 1 contact closure 14 Tally 8 contact closure

2 Tally 1 contact closure 15 Tally 2 contact closure

3 Tally 2 grounding closure 16 Tally 2 contact closure

4 Tally 3 contact closure 17 Tally 3 grounding closure

5 Tally 3 contact closure 18 Tally 4 contact closure

6 Tally 4 grounding closure 19 Tally 4 contact closure

7 Tally 5 contact closure 20 Tally 5 grounding closure

8 Tally 5 contact closure 21 Tally 6 contact closure

9 Tally 6 grounding closure 22 Tally 6 contact closure

10 Tally 7 contact closure 23 Tally 7 grounding closure

11 Tally 7 contact closure 24 Tally 8 contact closure

12 Tally 8 grounding closure 25 Tally 8 contact closure

13 Signal ground

1 13

14 25

1 14

13 25
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This section provides a comprehensive list of available input and output resolutions on the 
individual ScreenPRO-II units.  These resolutions can be assigned to the selected input on 
the Input Menu, and as the system’s output format on the Output Menu.  In Chapter 4, 
refer to the “Input Menu Description” and “Output Menu Description” sections for 
details. 

Input and output resolutions are listed below.  Each entry lists Format @Fv (Hz).  

• NTSC (480i) (Input Only)

• 720x480p

• PAL (576i) (Input Only)

• 720x575p

• 640x480 @59.94

• 640x480 @60

• 640x480 @72

• 640x480 @75

• 640x480 @85

• 800x600 @50

• 800x600 @56

• 800x600 @59.94

• 800x600 @60

• 800x600 @72

• 800x600 @75

• 800x600 @85

• 1024x768 @47.95

• 1024x768 @48

• 1024x768 @50

• 1024x768 @59.94

• 1024x768 @60

• 1024x768 @70

• 1024x768 @71.93

• 1024x768 @72

Note Please contact Barco Technical Support if you would like to 
request the addition of a new resolution.

Important ScreenPRO-II Controller does not support interlaced output 
resolutions. All interlaced video formats listed below are 
supported as inputs only, and noted as such in red.
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• 1024x768 @75

• 1024x768 @85

• 1152x864 @75

• 1280x768 @47.95

• 1280x768 @48

• 1280x768 @50

• 1280x768 @59.94

• 1280x768 @75

• 1280x960 @50

• 1280x960 @59.94

• 1280x960 @60

• 1280x960 @85

• 1280x1024 @47.95

• 1280x1024 @48

• 1280x1024 @50

• 1280x1024 @59.94

• 1280x1024 @60

• 1280x1024 @71.93

• 1280x1024 @72

• 1280x1024 @75

• 1280x1024 @85

• 1364x768 @47.95

• 1364x768 @48

• 1364x768 @50

• 1364x768 @59.94

• 1364x768 @75

• 1364x1024 @47.95

• 1364x1024 @48

• 1364x1024 @50

• 1364x1024 @59.94

• 1364x1024 @75

• 1400x1050 @48

• 1400x1050 @50

• 1400x1050 @59.94

• 1400x1050 @60

• 1400x1050 @75

• 1680x1050 @60

• 1600x1200 @47.95

• 1600x1200 @48
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• 1600x1200 @50

• 1600x1200 @59.94

• 1600x1200 @60

• 1280x720p @50

• 1280x720p @59.94

• 1280x720p @60

• 1920x1080p @23.98

• 1920x1080p @24

• 1920x1080p @25

• 1920x1080p @29.97

• 1920x1080p @30

• 1920x1080p @50

• 1920x1080p @59.94

• 1920x1080p @60

• 1920x1080sF @23.98

• 1920x1080sF @24

• 1920x1080i @50 (Input Only)

• 1920x1080i @59.94 (Input Only)

• 1920x1080i @60 (Input Only)

• 2048x1080p @50

• 2048x1080p @59.94

• 2048x1080p @60

• 1920x1200p @60

• Apple 1200p @60

• 875p
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The following topics are discussed in this Appendix:

• Warranty

• Return Material Authorization (RMA)

• Contact Information

t~êê~åíó
All video products are designed and tested to the highest quality standards and are backed 
by a full 3-year parts and labor warranty.  Warranties are effective upon delivery date to 
customer and are non-transferable.  Barco warranties are only valid to the original 
purchaser/owner.  Warranty related repairs include parts and labor, but do not include faults 
resulting from user negligence, special modifications, lightning strikes, abuse (drop/crush), 
and/or other unusual damages.

The customer shall pay shipping charges when unit is returned for repair.  Barco will cover 
shipping charges for return shipments to customers.  

oÉíìêå=j~íÉêá~ä=^ìíÜçêáò~íáçå=Eoj^F
In the unlikely event that a product is required to return for repair, please call the Technical 
Support / Customer Service direct line, and ask to receive a Return Merchandise 
Authorization number (RMA).

• (866) 374-7878

RMA Conditions are listed below:

a. Prior to returning any item, you must receive a Return Merchandise 
Authorization (RMA) number.  

b. All RMA numbers must appear on their return-shipping label.

c. RMA numbers are valid for ten (10) days from issue date. 

d. All shipping and insurance charges on all RMAs must be prepaid by the 
customer 
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Barco Media and Entertainment
11101 Trade Center Drive
Rancho Cordova, California  95670
USA

• Phone: (916) 859-2500 

• Fax: (916) 859-2515

• Websites: 

~ www.folsom.com

~ www.events.barco.com

Sales Contact Information

• Direct:  (916) 859-2505

• Toll Free:  (888) 414-7226

• E-mail:  folsomsales@barco.com

Barco N.V. 
Noordlaan 5
8520 Kuurne
BELGIUM 

• Phone: +32 56.36.82.11 

• Fax: +32 56.35.16.51

• Website: www.events.barco.com

Technical Support / Customer Service Information 

• Tech Line:  (866) 374-7878 — 24 hours per day, 7 days per week

• E-mail: folsomsupport@barco.com
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The following topics are discussed in this Appendix:

• Software Upgrade Overview

• Hardware Requirements

• Software Requirements

• Downloading Software

• Serial Upgrade Method

• Ethernet Upgrade Method
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pçÑíï~êÉ=réÖê~ÇÉ=lîÉêîáÉï
Firmware files for the ScreenPRO-II Controller system are loaded into the hardware at 
power-up.  These files are stored in the unit’s onboard flash memory, which can be 
upgraded using a serial or Ethernet connection to a PC (or laptop).

The desired connection is made through the Console or Ethernet port on the ScreenPRO-
II Controller’s rear panel, in conjunction with the “Flash Loader” utility supplied with each 
upgrade.  The Flash Loader enables you to update the Flash memory with the latest 
software revision.  The utility should be run from a PC’s hard drive (recommended).  

e~êÇï~êÉ=oÉèìáêÉãÉåíë
The following hardware items are required to upgrade the ScreenPRO-II Controller:

• IBM compatible computer with an available COM port or Ethernet port.

If you elect to connect serially, a serial cable conforming to EIA RS-232 specifications (e.g., 
standard modem cable) is required.  The cable should have a DB-9 male connector on one 
end (for connection to the ScreenPRO-II Controller’s Console port), and the appropriate 
connector on the other end for connection to your PC (typically, a DB-9).

pçÑíï~êÉ=oÉèìáêÉãÉåíë
The following list outlines software requirements for upgrading the ScreenPRO-II 
Controller:

• Ensure that your PC (or laptop) uses the Windows® 2000 or XP operating 
systems.

• Software files:

~ Flash File Loader.  (This software enables the PC to send commands to 
the ScreenPRO-II Controller.)

~ ScreenPRO-II Controller software

~ What’s New File   

Software files can be downloaded from either the Folsom FTP site or the Barco Folsom 
website, as described in the following “Downloading Software” section on page 271.

Note All software files listed above (and more) are contained in the 
file that you will download.
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Two different methods can be used to download ScreenPRO-II Controller software and the 
Flash File Loader utility:

• Via FTP Site

• Via Web Site

sá~=cqm=páíÉ
Barco Folsom's FTP site address is:  ftp.folsom.com 

To download from the FTP site:

1. Create a target folder on your PC (e.g., ScreenPRO-II Controller).

2. If you are using an FTP client, logon to our site as follows:

~ User name:  anonymous

~ Password:  your email address

Example:  johndoe@somecompany.com

If you are using a web browser to access our FTP site, point the browser to: 

ftp://ftp.folsom.com

3. Once logged on, navigate to the following directory:

ftp://ftp.folsom.com/Products/Video/ScreenPROII_Controller/ 

4. Transfer the following file to the target folder on your PC:

ScreenProController_Rev#.##.EXE

5. As required, please continue with the “Serial Upgrade Method” section on 
page 272, or the “Ethernet Upgrade Method” section on page 274.

sá~=tÉÄ=páíÉ
Barco Folsom's web site address is:  http://www.folsom.com

To download from the web site:

1. Create a target folder on your PC (e.g., ScreenPRO-II Controller).

2. On the web, navigate to http://video.folsom.com.

3. Click “Downloads” to access the Downloads Page.

4. Using the “Select Video Product” pull-down menu, click ScreenPRO-II 
Controller.

5. In the “Software” section, click the Download button for the latest version of 
system software.

6. When the File Download Dialog appears, click Save to save the file to your 
computer.

7. When the Save As Dialog appears, navigate to the target folder and click Save.

8. As required, please continue with the “Serial Upgrade Method” section on 
page 272, or the “Ethernet Upgrade Method” section on page 274.
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Use the following steps to upgrade ScreenPRO-II Controller software using a serial 
connection to your PC:  

1. With the download complete, navigate to the target folder and double-click the 
EXE to launch the installation shield.  

2. Follow the prompts to install the upgrade package.  At the conclusion of the 
procedure, a new path will be created under Start > Programs > Barco Folsom.  

3. Connect the Console port on the back of the ScreenPRO-II Controller to the COM 
1 port on your PC.  

4. Power-up the ScreenPRO-II Controller.

5. On the PC, click Start > Programs > Barco Folsom > ScreenPRO-II Controller 
Software #.## > Flash Loader to launch the Flash Loader utility.

Figure C-1.  Flash Loader Utility  

6. Click Communication > RS232 Config > Baud, and select 115200.

7. Click Communication > RS232 Config > COM Port, and select the COM port on 
your PC to which ScreenPRO-II Controller is connected.  If no other programs are 
using the port, the “Established communications” message appears at the 
bottom of the Flash Loader.

8. To verify communications between the PC and ScreenPRO-II Controller:

a. In the Flash Loader, click in the black terminal window area.

b. Note the condition of the status lights:  
• DCD and CTS should be red.
• TXD and RXD should be green.  They will flash if Enter is 

pressed.

c. Press Enter a few times to display the system prompt “#” on screen.

d. If the prompt does not appear, continue with step 9 (troubleshooting).

e. If the prompt appears, continue with step 10 (uploading files).

Note If you have not used the COM 1 port on your PC, an error 
message will be shown at the bottom of the Flash Loader.
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9. To troubleshoot the serial connection:

a. If the DCD and CTS status lights are green, re-check the communication 
settings in the loader, and verify that the COM port and Baud Rate 
settings are correct.

b. To verify ScreenPRO-II Controller communication settings, press 
{HOME} > MISC > {CONSL} to display the Console Port Setup Menu.

c. Verify the following settings:
• Baud rate = 115200
• Data Bits = 8
• Parity = None
• Stop Bits = 1

d. Repeat steps 7 and 8 above, then re-check the status lights.  

e. With communication status OK, continue with step 10.

10. To upload files to ScreenPRO-II Controller, click "Open script file to read and 
upload."

11. In the dialog, select "Complete_Load.sld" and click Open.  The ScreenPRO-II 
Controller menu should immediately display the "System in LOADER MODE" 
message.

12. It takes several minutes to load the flash memory.  When complete, the Flash 
Loader utility displays the “Upload Complete” message.  Click OK to continue.

13. Cycle power on the ScreenPRO-II Controller, and exit the Flash Loader utility.

14. On ScreenPRO-II Controller, perform a factory reset.  In Chapter 5, refer to the 
“Return to Factory Default” section on page 189 for instructions.    

15. On the ScreenPRO-II Controller, verify that the new software has been loaded 
correctly.   Press {HOME} > SYSTEM > {SW VER} to display the Software 
Version Menu.

This completes the software upgrade procedure via serial communications.
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Use the following steps to upgrade ScreenPRO-II Controller software using an 
Ethernet connection to your PC:

1. Ensure that your PC (or laptop) uses the Windows® 2000 or XP operating 
systems.

2. Connect the ScreenPRO-II Controller’s Ethernet port to a Hub or Switch.  

3. Connect the Ethernet Hub or Switch to your PC.  Remember that a totally “local” 
network is recommended, without IP connections to the outside world.

4. Power-up the ScreenPRO-II Controller.

5. On the PC, click Start > Programs > Barco Folsom > ScreenPRO-II Controller 
Software #.## > Flash Loader to launch the Flash Loader utility.

Figure C-2.  Flash Loader Utility  

6. Click Communication > Ethernet > Connect to display the Ethernet 
Connection Dialog.  

Figure C-3.  Ethernet Connection Dialog  (sample)  

7. In the dialog, enter ScreenPRO-II Controller’s IP address (192.168.0.2), and enter 
the default port number:  3000. 

Note The default IP address is 192.168.0.2.

Note If the Ethernet menu pick is grayed out, set the COM port to 
None. 
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8. Click the Connect button.  If the connection is successfully, the message 
“Connect via Ethernet successful” appears in the Flash Loader’s Status Bar.  If 
you cannot connect, refer to the “Troubleshooting Ethernet Communication” 
section on page 275.

9. To upload files to the ScreenPRO-II Controller, click "Open script file to read and 
upload."

10. In the dialog, select "Complete_Load.sld" and click Open.  The ScreenPRO-II 
Controller menu should immediately display the "System in LOADER MODE" 
message.

11. It takes several minutes to load the flash memory.  When complete, the Flash 
Loader utility displays the “Upload Complete” message.  Click OK to continue.

12. Cycle power on the ScreenPRO-II Controller, and exit the Flash Loader utility.

13. On ScreenPRO-II Controller, perform a factory reset.  In Chapter 5, refer to the 
“Return to Factory Default” section on page 189 for instructions.    

14. On the ScreenPRO-II Controller, verify that the new software has been loaded 
correctly.   Press {HOME} > SYSTEM > {SW VER} to display the Software 
Version Menu.

qêçìÄäÉëÜççíáåÖ=bíÜÉêåÉí=`çããìåáÅ~íáçå
Use the following steps to determine the IP address of ScreenPRO-II Controller, and 
establish proper communications:

1. Turn on the ScreenPRO-II Controller.  Press {HOME} > SYSTEM > {NETWORK 
SETUP} to display the Network Setup Menu.

2. Make a note of the IP address. 

3. Attempt to ping the ScreenPRO-II Controller as follows:

a. Connect ScreenPRO-II Controller’s Ethernet port to a Hub or Switch.  

b. Connect the Ethernet Hub or Switch to your PC.  A totally “local” network 
is recommended, without IP connections to the outside world.

c. Turn on the PC or laptop.

d. Open a command prompt window on the PC. Click Start > Programs > 
Accessories > Command Prompt.

e. On the command prompt line, type:

ping 192.168.0.2

... followed by Enter. 

f. If the computer is able to successfully communicate with the 
ScreenPRO-II Controller, you will see a series of “replies” from the 
target IP address.  Repeat the upgrade procedure as outlined in the 
“Ethernet Upgrade Method” section on page 274.

Note The default IP address is 192.168.0.2.

Note Use the unit’s actual IP address, as determined in step 2 
above.
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g. If you see a “Request timed out” message, the PC is unable to locate 
and communicate with the ScreenPRO-II Controller.  If this is the case:

• Check your network connections and settings as described 
above, or ...

• Contact your network administrator, or ...
• Contact Technical Support.  In Appendix B, refer to the 

“Contact Information” section on page 268 for details.
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